# Table of contents

1 **General** ................................................................................................. 6  
1.1 Copyright © VIPA GmbH ................................................................. 6  
1.2 About this manual ............................................................................. 7  
1.2.1 Safety information ...................................................................... 8  

2 **Basics** .................................................................................................. 10  
2.1 Safety information for users ............................................................ 10  
2.2 Operating structure of a CPU ....................................................... 10  
2.2.1 General ..................................................................................... 10  
2.2.2 Applications .............................................................................. 11  
2.2.3 Operands .................................................................................. 11  
2.3 CPU 315-4PN12 ............................................................................. 12  
2.4 General data ................................................................................... 14  

3 **Assembly and installation guidelines** .............................................. 17  
3.1 Installation dimensions .................................................................. 17  
3.2 Assembly standard bus .................................................................. 18  
3.3 Cabling ............................................................................................ 19  
3.4 Installation guidelines ..................................................................... 22  

4 **Hardware description** ....................................................................... 25  
4.1 Properties ......................................................................................... 25  
4.2 Structure .......................................................................................... 26  
4.2.1 General ..................................................................................... 26  
4.2.2 Interfaces .................................................................................. 26  
4.2.3 Memory management ............................................................... 28  
4.2.4 Storage media slot ..................................................................... 28  
4.2.5 Battery backup for clock and RAM .......................................... 28  
4.2.6 LEDs ......................................................................................... 29  
4.2.7 Operating mode switch ............................................................ 32  
4.3 Technical data .................................................................................. 32  

5 **Deployment CPU 315-4PN12** ............................................................ 40  
5.1 Assembly .......................................................................................... 40  
5.2 Start-up behaviour .......................................................................... 40  
5.3 Addressing ....................................................................................... 41  
5.3.1 Overview ................................................................................... 41  
5.3.2 Addressing Backplane bus I/O devices ..................................... 41  
5.4 Hardware configuration - CPU ....................................................... 42  
5.5 Hardware configuration - I/O modules .......................................... 43  
5.6 Hardware configuration - Ethernet PG/OP channel ...................... 44  
5.7 Setting standard CPU parameters ................................................. 46  
5.7.1 Parametrization via Siemens CPU ........................................... 46  
5.7.2 Parameters CPU ........................................................................ 46  
5.7.3 Parameters for MPI/DP ............................................................... 49  
5.8 Setting VIPA specific CPU parameters ......................................... 50  
5.8.1 Proceeding ................................................................................. 50  
5.8.2 VIPA specific parameters ......................................................... 51  
5.9 Project transfer ................................................................................ 54  
5.9.1 Transfer via MPI/PROFIBUS .................................................... 54  
5.9.2 Transfer via Ethernet ............................................................... 55
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.2  PROFINET installation guidelines</td>
<td>146</td>
</tr>
<tr>
<td>9.3  PROFINET system limits</td>
<td>147</td>
</tr>
<tr>
<td>9.4  Fast introduction</td>
<td>149</td>
</tr>
<tr>
<td>9.5  Commissioning and Initialization</td>
<td>149</td>
</tr>
<tr>
<td>9.6  Hardware configuration - CPU</td>
<td>150</td>
</tr>
<tr>
<td>9.7  Parameters - PROFINET IO controller</td>
<td>151</td>
</tr>
<tr>
<td>9.7.1 Precondition</td>
<td>151</td>
</tr>
<tr>
<td>9.7.2 PN-IO</td>
<td>152</td>
</tr>
<tr>
<td>9.7.3 Port 1</td>
<td>152</td>
</tr>
<tr>
<td>9.8  Configuration PROFINET IO device</td>
<td>153</td>
</tr>
<tr>
<td>9.9  Configuration PROFINET I Device / Shared Device</td>
<td>154</td>
</tr>
<tr>
<td>9.10 Topology - Configuration</td>
<td>155</td>
</tr>
<tr>
<td>9.11 Device replacement without exchangeable medium/PG</td>
<td>156</td>
</tr>
<tr>
<td>9.11.1 Replace device</td>
<td>157</td>
</tr>
<tr>
<td>9.12 Commissioning and start-up behaviour</td>
<td>157</td>
</tr>
<tr>
<td>9.13 PROFINET diagnostics</td>
<td>159</td>
</tr>
<tr>
<td>9.13.1 Overview</td>
<td>159</td>
</tr>
<tr>
<td>9.13.2 Diagnostics with the configuration and engineering tool</td>
<td>159</td>
</tr>
<tr>
<td>9.13.3 Diagnostics during runtime in the user program</td>
<td>159</td>
</tr>
<tr>
<td>9.13.4 Diagnostics via OB start information</td>
<td>161</td>
</tr>
<tr>
<td>9.13.5 Diagnostics via status LEDs</td>
<td>161</td>
</tr>
</tbody>
</table>
1 General
1.1 Copyright © VIPA GmbH

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable agreements.

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written consent of VIPA and the business management owner of the material.

For permission to reproduce or distribute, please contact: VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH Ohmstraße 4, D-91074 Herzogenaurach, Germany

Tel.: +49 9132 744 -0
Fax.: +49 9132 744-1864
EMail: info@vipa.de
http://www.vipa.com

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information.

This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

CE Conformity Declaration
Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions. Conformity is indicated by the CE marking affixed to the product.

Conformity Information
For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service organization.
1.2 About this manual

Objective and contents
This manual describes the CPU 315-4PN12 of the System 300S from VIPA. It contains a description of the construction, project implementation and usage.

Product | Order no. | as of state: |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>CPU-HW</td>
</tr>
<tr>
<td>CPU 315SN/PN</td>
<td>315-4PN12</td>
<td>02</td>
</tr>
</tbody>
</table>

Target audience
The manual is targeted at users who have a background in automation technology.

Structure of the manual
The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.
Guide to the document

The following guides are available in the manual:
- An overall table of contents at the beginning of the manual
- References with page numbers

Availability

The manual is available in:
- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

Icons/Headings

Important passages in the text are highlighted by following icons and headings:

- **DANGER!** Immediate or likely danger. Personal injury is possible.
- **CAUTION!** Damages to property is likely if these warnings are not heeded.
- **Supplementary information and useful tips.**

1.2.1 Safety information

Applications conforming with specifications

The system is constructed and produced for:
- communication and process control
- industrial applications
- operation within the environmental conditions specified in the technical data
- installation into a cubicle

- **DANGER!** This device is not certified for applications in
  - in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the
- project design department
- installation department
- commissioning
- operation
Caution!

The following conditions must be met before using or commissioning the components described in this manual:

- Hardware modifications to the process control system should only be carried out when the system has been disconnected from power!
- Installation and hardware modifications only by properly trained personnel.
- The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
2 Basics

2.1 Safety information for users

**Handling of electrostatic sensitive modules**

VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges. The following symbol is attached to modules that can be destroyed by electrostatic discharges.

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment. It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception. These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable. Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load. Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

**Shipping of modules**

Modules must be shipped in the original packing material.

**Measurements and alterations on electrostatic sensitive modules**

When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:

- Floating instruments must be discharged before use.
- Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

**CAUTION!**

Personnel and instruments should be grounded when working on electrostatic sensitive modules.

2.2 Operating structure of a CPU

2.2.1 General

The CPU contains a standard processor with internal program memory. In combination with the integrated SPEED7 technology the unit provides a powerful solution for process automation applications within the System 300S family. A CPU supports the following modes of operation:

- cyclic operation
- timer processing
- alarm controlled operation
- priority based processing
Cyclic processing represents the major portion of all the processes that are executed in the CPU. Identical sequences of operations are repeated in a never-ending cycle.

Timer processing

Where a process requires control signals at constant intervals you can initiate certain operations based upon a timer, e.g. not critical monitoring functions at one-second intervals.

Alarm controlled processing

If a process signal requires a quick response you would allocate this signal to an alarm controlled procedure. An alarm can activate a procedure in your program.

Priority based processing

The above processes are handled by the CPU in accordance with their priority. Since a timer or an alarm event requires a quick reaction, the CPU will interrupt the cyclic processing when these high-priority events occur to react to the event. Cyclic processing will resume, once the reaction has been processed. This means that cyclic processing has the lowest priority.

2.2.2 Applications

The program that is present in every CPU is divided as follows:

- System routine
- User application

System routine

The system routine organizes all those functions and procedures of the CPU that are not related to a specific control application.

User application

This consists of all the functions that are required for the processing of a specific control application. The operating modules provide the interfaces to the system routines.

2.2.3 Operands

The following series of operands is available for programming the CPU:

- Process image and periphery
- Bit memory
- Timers and counters
- Data blocks

Process image and periphery

The user application can quickly access the process image of the inputs and outputs PIO/PII. You may manipulate the following types of data:

- individual Bits
- Bytes
- Words
- Double words
You may also gain direct access to peripheral modules via the bus from user application. The following types of data are available:

- Bytes
- Words
- Blocks

**Bit Memory**

The bit memory is an area of memory that is accessible by means of certain operations. Bit memory is intended to store frequently used working data.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words

**Timers and counters**

In your program you may load cells of the timer with a value between 10ms and 9990s. As soon as the user application executes a start-operation, the value of this timer is decremented by the interval that you have specified until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment or decrement these when required.

**Data Blocks**

A data block contains constants or variables in the form of bytes, words or double words. You may always access the current data block by means of operands.

You may access the following types of data:

- individual Bits
- Bytes
- Words
- Double words

### 2.3 CPU 315-4PN12

**Overview**

The CPU 315-4PN12 bases upon the SPEED7 technology. This supports the CPU at programming and communication by means of co-processors that causes a power improvement for highest needs.

- The CPU is programmed in STEP® 7 from Siemens. For this you may use the SIMATIC Manager or TIA Portal from Siemens. Here the instruction set of the S7-400 from Siemens is used.
- Modules and CPUs of the System 300S from VIPA and Siemens may be used at the bus as a mixed configuration.
- The user application is stored in the battery buffered RAM or on an additionally pluggable MMC storage module.
- The CPU is configured as CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6) from Siemens.
Access

Please always use the CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6) from Siemens of the hardware catalog to project this CPU from VIPA. For the project engineering, a thorough knowledge of the Siemens SIMATIC Manager and the hardware configurator from Siemens is required!

Memory management

The CPU has an integrated memory. Information about the capacity (min. capacity ... max capacity) of the memory may be found at the front of the CPU. The memory is divided into the following 3 parts:

- Load memory 2Mbyte
- Code memory (50% of the work memory)
- Data memory (50% of the work memory)

The work memory has 1Mbyte. There is the possibility to extend the work memory to its maximum printed capacity 2Mbyte by means of a MCC memory extension card.

Integrated PROFIBUS DP master

The CPU has an integrated PROFIBUS DP master, which also may be used as PROFIBUS DP slave. The project engineering takes place in the hardware configurator from Siemens via the PROFIBUS sub module.
Integrated PROFINET IO controller
The CPU has an integrated PROFINET IO controller which is to be configured via the PROFINET sub module in the hardware configurator from Siemens.

Integrated Ethernet PG/OP channel
The CPU has an Ethernet interface for PG/OP communication. After assigning IP address parameters with your configuration tool, via the "PLC" functions you may directly access the Ethernet PG/OP channel and program res. remote control your CPU. You may also access the CPU with a visualization software via these connections.

Operation Security
- Wiring by means of spring pressure connections (CageClamps) at the front connector
- Core cross-section 0.08...2.5mm²
- Total isolation of the wiring at module change
- Potential separation of all modules to the backplane bus

Dimensions/ Weight
Dimensions of the basic enclosure:
- 2tier width: (WxHxD) in mm: 80x125x120

Integrated power supply
The CPU comes with an integrated power supply. The power supply is to be supplied with DC 24V. By means of the supply voltage, the internal electronic is supplied as well as the connected modules via backplane bus. The power supply is protected against inverse polarity and overcurrent.

2.4 General data

<table>
<thead>
<tr>
<th>Conformity and approval</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conformity</strong></td>
</tr>
<tr>
<td>2006/95/EG</td>
</tr>
<tr>
<td>2004/108/EG</td>
</tr>
<tr>
<td><strong>Approval</strong></td>
</tr>
<tr>
<td>UL</td>
</tr>
<tr>
<td>others</td>
</tr>
<tr>
<td><strong>RoHS</strong></td>
</tr>
<tr>
<td>2011/65/EU</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Protection of persons and device protection</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of protection</strong></td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td><strong>Electrical isolation</strong></td>
</tr>
<tr>
<td>to the field bus</td>
</tr>
<tr>
<td>to the process level</td>
</tr>
<tr>
<td>Insulation resistance</td>
</tr>
</tbody>
</table>
### Protection of persons and device protection

**Insulation voltage to reference earth**

<table>
<thead>
<tr>
<th>Inputs / outputs</th>
<th>AC / DC 50V, test voltage AC 500V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protective measures</td>
<td>against short circuit</td>
</tr>
</tbody>
</table>

### Environmental conditions to EN 61131-2

#### Climatic

<table>
<thead>
<tr>
<th>Storage / transport</th>
<th>EN 60068-2-14</th>
<th>-25…+70°C</th>
</tr>
</thead>
</table>

#### Operation

<table>
<thead>
<tr>
<th>Horizontal installation</th>
<th>EN 61131-2</th>
<th>0…+60°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical installation</td>
<td>EN 61131-2</td>
<td>0…+60°C</td>
</tr>
</tbody>
</table>

**Air humidity**

EN 60068-2-30  
RH1  
(without condensation, rel. humidity 10…95%)

**Pollution**

EN 61131-2  
Degree of pollution 2

#### Mechanical

<table>
<thead>
<tr>
<th>Oscillation</th>
<th>EN 60068-2-6</th>
<th>1g, 9Hz ... 150Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shock</td>
<td>EN 60068-2-27</td>
<td>15g, 11ms</td>
</tr>
</tbody>
</table>

### Mounting conditions

<table>
<thead>
<tr>
<th>Mounting place</th>
<th>-</th>
<th>In the control cabinet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting position</td>
<td>-</td>
<td>Horizontal and vertical</td>
</tr>
</tbody>
</table>

### EMC

<table>
<thead>
<tr>
<th>Emitted interference</th>
<th>EN 61000-6-4</th>
<th>Class A (Industrial area)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Noise immunity zone B</td>
<td>EN 61000-6-2</td>
<td>Industrial area</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-2</td>
<td>ESD</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-3</td>
<td>HF irradiation (casing)</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-6</td>
<td>HF conducted</td>
</tr>
<tr>
<td></td>
<td>EN 61000-4-4</td>
<td>Burst, degree of severity 3</td>
</tr>
</tbody>
</table>
### General data

<table>
<thead>
<tr>
<th>EMC</th>
<th>Standard</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EN 61000-4-5</td>
<td>Surge, installation class 3 *</td>
</tr>
</tbody>
</table>

*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors for lightning and overvoltage is necessary.
3 Assembly and installation guidelines

3.1 Installation dimensions

Dimensions Basic

2-tier width (WxHxD) in mm: 80 x 125 x 120

Dimensions

Installation dimensions
3.2 Assembly standard bus

**General**

The single modules are directly installed on a profile rail and connected via the backplane bus connector. Before installing the modules you have to clip the backplane bus connector to the module from the backside. The backplane bus connector is delivered together with the peripheral modules.

**Profile rail**

<table>
<thead>
<tr>
<th>Order number</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>390-1AB60</td>
<td>160</td>
<td>140</td>
<td>10</td>
</tr>
<tr>
<td>390-1AE80</td>
<td>482</td>
<td>466</td>
<td>8.3</td>
</tr>
<tr>
<td>390-1AF30</td>
<td>530</td>
<td>500</td>
<td>15</td>
</tr>
<tr>
<td>390-1AJ30</td>
<td>830</td>
<td>800</td>
<td>15</td>
</tr>
<tr>
<td>390-9BC00*</td>
<td>2000</td>
<td></td>
<td>15</td>
</tr>
</tbody>
</table>

*) Unit pack: 10 pieces

**Measures in mm**

**Bus connector**

For the communication between the modules the System 300S uses a backplane bus connector. Backplane bus connectors are included in the delivering of the peripheral modules and are clipped at the module from the backside before installing it to the profile rail.
Assembly possibilities

Please regard the allowed environment temperatures:
- horizontal assembly: from 0 to 60°C
- vertical assembly: from 0 to 40°C
- lying assembly: from 0 to 40°C

Approach

1. Bolt the profile rail with the background (screw size: M6), so that you still have minimum 65mm space above and 40mm below the profile rail.

2. If the background is a grounded metal or device plate, please look for a low-impedance connection between profile rail and background.

3. Connect the profile rail with the protected earth conductor. For this purpose there is a bolt with M6-thread.

4. The minimum cross-section of the cable to the protected earth conductor has to be 10mm².

5. Stick the power supply to the profile rail and pull it to the left side to the grounding bolt of the profile rail.

6. Fix the power supply by screwing.

7. Take a backplane bus connector and click it at the CPU from the backside like shown in the picture.

8. Stick the CPU to the profile rail right from the power supply and pull it to the power supply.

9. Click the CPU downwards and bolt it like shown.

10. Repeat this procedure with the peripheral modules, by clicking a backplane bus connector, stick the module right from the modules you’ve already fixed, click it downwards and connect it with the backplane bus connector of the last module and bolt it.

3.3 Cabling

CAUTION!
- The power supplies must be released before installation and repair tasks, i.e. before handling with the power supply or with the cabling you must disconnect current/voltage (pull plug, at fixed connection switch off the concerning fuse)!
- Installation and modifications only by properly trained personnel!

CageClamp technology (green)

For the cabling of power supply of a CPU, a green plug with Cage-Clamp technology is deployed. The connection clamp is realized as plug that may be clipped off carefully if it is still cabled.
Here wires with a cross-section of 0.08mm\(^2\) to 2.5mm\(^2\) may be connected. You can use flexible wires without end case as well as stiff wires.

1. Test point for 2mm test tip
2. Locking (orange) for screwdriver
3. Round opening for wires

The picture on the left side shows the cabling step by step from top view.

1. For cabling you push the locking vertical to the inside with a suiting screwdriver and hold the screwdriver in this position.
2. Insert the de-isolated wire into the round opening. You may use wires with a cross-section from 0.08mm\(^2\) to 2.5mm\(^2\)
3. By removing the screwdriver the wire is connected safely with the plug connector via a spring.

Front connectors of the in-/output modules

In the following the cabling of the two variants are shown.
1. Open the front flap of your I/O module.
2. Bring the front connector in cabling position.
   For this you plug the front connector on the module until it locks.
   In this position the front connector juts out of the module and
   has no contact yet.
3. De-isolate your wires. If needed, use core end cases.
4. Thread the included cable binder into the front connector.
5. If you want to lead out your cables from the bottom of the
   module, start with the cabling from bottom to top, res. from top
   to bottom, if the cables should be led out at the top.
6. Bolt also the connection screws of not cabled screw clamps.
7. Fix the cable binder for the cable bundle.
8. Push the release key at the front connector on the upper side of
   the module and at the same time push the front connector into
   the module until it locks.
9. Now the front connector is electrically connected with your
   module.
10. Close the front flap.
11. Fill out the labeling strip to mark the single channels and push
    the strip into the front flap.
1. Open the front flap of your I/O module.
2. Bring the front connector in cabling position.
   For this you plug the front connector on the module until it locks.
   In this position the front connector juts out of the module and
   has no contact yet.
3. De-isolate your wires. If needed, use core end cases.
4. If you want to lead out your cables from the bottom of the
   module, start with the cabling from bottom to top, res. from top
   to bottom, if the cables should be led out at the top.
5. Bolt also the connection screws of not cabled screw clamps.

6. Put the included cable binder around the cable bundle and the
   front connector.
7. Fix the cable binder for the cable bundle.

8. Bolt the fixing screw of the front connector.
9. Now the front connector is electrically connected with your
   module.
10. Close the front flap.
11. Fill out the labeling strip to mark the single channels and push
    the strip into the front flap.

3.4 Installation guidelines

General

The installation guidelines contain information about the interference
free deployment of a PLC system. There is the description of the
ways, interference may occur in your PLC, how you can make sure
the electromagnetic compatibility (EMC), and how you manage the
isolation.
**What does EMC mean?**

Electromagnetic compatibility (EMC) means the ability of an electrical device, to function error free in an electromagnetic environment without being interfered respectively without interfering the environment.

The components of VIPA are developed for the deployment in industrial environments and meets high demands on the EMC. Nevertheless you should project an EMC planning before installing the components and take conceivable interference causes into account.

**Possible interference causes**

Electromagnetic interferences may interfere your control via different ways:

- Electromagnetic fields (RF coupling)
- Magnetic fields with power frequency
- Bus system
- Power supply
- Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the distance to the interference cause, interferences to your control occur by means of different coupling mechanisms.

There are:

- galvanic coupling
- capacitive coupling
- inductive coupling
- radiant coupling

**Basic rules for EMC**

In the most times it is enough to take care of some elementary rules to guarantee the EMC. Please regard the following basic rules when installing your PLC.

- Take care of a correct area-wide grounding of the inactive metal parts when installing your components.
  - Install a central connection between the ground and the protected earth conductor system.
  - Connect all inactive metal extensive and impedance-low.
  - Please try not to use aluminium parts. Aluminium is easily oxidizing and is therefore less suitable for grounding.
- When cabling, take care of the correct line routing.
  - Organize your cabling in line groups (high voltage, current supply, signal and data lines).
  - Always lay your high voltage lines and signal respectively data lines in separate channels or bundles.
  - Route the signal and data lines as near as possible beside ground areas (e.g. suspension bars, metal rails, tin cabinet).
- Proof the correct fixing of the lead isolation.
  - Data lines must be laid isolated.
  - Analog lines must be laid isolated. When transmitting signals with small amplitudes the one sided laying of the isolation may be favourable.
  - Lay the line isolation extensively on an isolation/protected earth conductor rail directly after the cabinet entry and fix the isolation with cable clamps.
  - Make sure that the isolation/protected earth conductor rail is connected impedance-low with the cabinet.
  - Use metallic or metallised plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.  
- Consider to wire all inductivities with erase links.  
- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical operating supplies when possible.  
- Please take care for the targeted employment of the grounding actions. The grounding of the PLC serves for protection and functionality activity.  
- Connect installation parts and cabinets with your PLC in star topology with the isolation/protected earth conductor system. So you avoid ground loops.  
- If there are potential differences between installation parts and cabinets, lay sufficiently dimensioned potential compensation lines.

Isolation of conductors

Electrical, magnetically and electromagnetic interference fields are weakened by means of an isolation, one talks of absorption. Via the isolation rail, that is connected conductive with the rack, interference currents are shunt via cable isolation to the ground. Here you have to make sure, that the connection to the protected earth conductor is impedance-low, because otherwise the interference currents may appear as interference cause.

When isolating cables you have to regard the following:

- If possible, use only cables with isolation tangle.  
- The hiding power of the isolation should be higher than 80%.  
- Normally you should always lay the isolation of cables on both sides. Only by means of the both-sided connection of the isolation you achieve high quality interference suppression in the higher frequency area. Only as exception you may also lay the isolation one-sided. Then you only achieve the absorption of the lower frequencies. A one-sided isolation connection may be convenient, if:  
  - the conduction of a potential compensating line is not possible.  
  - analog signals (some mV respectively µA) are transferred.  
  - foil isolations (static isolations) are used.  

- With data lines always use metallic or metallised plugs for serial couplings. Fix the isolation of the data line at the plug rack. Do not lay the isolation on the PIN 1 of the plug bar!  
- At stationary operation it is convenient to strip the insulated cable interruption free and lay it on the isolation/protected earth conductor line.  
- To fix the isolation tangles use cable clamps out of metal. The clamps must clasp the isolation extensively and have well contact.  
- Lay the isolation on an isolation rail directly after the entry of the cable in the cabinet. Lead the isolation further on to your PLC and don’t lay it on there again!

**CAUTION!**

Please regard at installation!  
At potential differences between the grounding points, there may be a compensation current via the isolation connected at both sides.  
Remedy: Potential compensation line
4 Hardware description

4.1 Properties

CPU 315-4PN12

- SPEED7 technology integrated
- 1M byte work memory integrated (512kbyte code, 512kbyte data)
- Memory expandable to max. 2M byte (1M byte code, 1M byte data)
- 2M byte load memory
- PROFIBUS DP master integrated (DP-V0, DP-V1)
- PROFINET IO controller with integrated Ethernet CP
- PROFINET in accordance with conformance class A
- RS485 interface configurable for PROFIBUS DP master respectively PtP communication
- Ethernet PG/OP interface integrated
- MPI interface
- MCC slot for external memory cards (lockable)
- Status LEDs for operating state and diagnostics
- Real-time clock battery buffered
- I/O address range digital/analog 8191 byte
- 512 timer
- 512 counter
- 8192 flag byte

Ordering data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>315SN/PN</td>
<td>315-4PN12</td>
<td>MPI interface, card slot, real time clock, Ethernet interface for PG/OP, PROFIBUS DP master, PROFINET IO controller</td>
</tr>
</tbody>
</table>
4.2 Structure

4.2.1 General

**CPU 315-4PN12**

1. LEDs of the integrated PROFIBUS DP master
2. Storage media slot (lockable)
3. LEDs of the CPU part
4. LEDs of the PROFINET IO controller
5. Operating mode switch CPU
6. Twisted pair interface for Ethernet PG/OP channel
7. MPI interface
8. PROFIBUS DP/PtP interface
9. Twisted Pair interface for PROFINET IO controller
10. Slot for DC 24V power supply

The components 6 - 10 are under the front flap!

4.2.2 Interfaces

The CPU has an integrated power supply.

- The power supply has to be provided with DC 24V. For this serves the double DC 24V slot, that is underneath the flap.
- Via the power supply not only the internal electronic is provided with voltage, but by means of the backplane bus also the connected modules.
- The power supply is protected against polarity inversion and overcurrent.
- The internal electronic is galvanically connected with the supply voltage.
MPI interface X2

9pin SubD jack:
- The MPI interface serves for the connection between programming unit and CPU.
- By means of this the project engineering and programming happens.
- MPI serves for communication between several CPUs or between HMIs and CPU.
- Standard setting is MPI Address 2.

Ethernet PG/OP channel X5

8pin RJ45 jack:
- The RJ45 jack serves the interface to the Ethernet PG/OP channel.
- This interface allows you to program res. remote control your CPU, to access the internal web site or to connect a visualization.
- Configurable connections are not possible.
- For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this.

PROFIBUS/PtP interface with configurable functionality X3

9pin SubD jack:
- The CPU has a PROFIBUS/PtP interface with a fix pinout. After an overall reset the interface is deactivated. By appropriate configuration, the following functions for this interface may be enabled:
  - PROFIBUS DP master operation
    - Configuration via PROFIBUS sub module X1 (MPI/DP) with ‘Operation mode’ master in the hardware configuration.
  - PROFIBUS DP slave operation
    - Configuration via PROFIBUS sub module X1 (MPI/DP) with ‘Operation mode’ slave in the hardware configuration.
  - PtP functionality
    - Using the PtP functionality the RS485 interface is allowed to connect via serial point-to-point connection to different source res. target systems.
    - Here the following protocols are supported: ASCII, STX/ETX, 3964R, USS and Modbus-Master (ASCII, RTU).
    - The activation of the PtP functionality happens by embedding the SPEEDBUS.GSD from VIPA in the hardware catalog. After the installation the CPU may be configured in a PROFIBUS master system and here the interface may be switched to PtP communication.

PROFINET IO controller X8

8pin RJ45 jack:
- PROFINET IO controller to connect PROFINET IO devices
- Ethernet PG/OP channel
- Ethernet Siemens S7 connection
- Ethernet open communication
4.2.3 Memory management

The CPU has an integrated memory. Information about the capacity of the memory may be found at the front of the CPU. The memory is divided into the following 3 parts:

- Load memory 2Mbyte
- Code memory (50% of the work memory)
- Data memory (50% of the work memory)

Work memory 1Mbyte. There is the possibility to extend the work memory to its maximum printed capacity 2Mbyte by means of a MCC memory extension card.

4.2.4 Storage media slot

- As external storage medium for applications and firmware you may use a MMC storage module (Multimedia card).
- The VIPA storage media are pre-formatted with the PC format FAT16 and can be accessed via a card reader.
- After PowerON respectively an overall reset the CPU checks, if there is a storage medium with data valid for the CPU.
- Push the memory card into the slot until it snaps in leaded by a spring mechanism. This ensures contacting.
- By sliding down the sliding mechanism, a just installed memory card can be protected against drop out.
- To remove, slide the sliding mechanism up again and push the storage media against the spring pressure until it is unlocked with a click.

CAUTION!
If the media was already unlocked by the spring mechanism, with shifting the sliding mechanism, a just installed memory card can jump out of the slot!

4.2.5 Battery backup for clock and RAM

A rechargeable battery is installed on every CPU 31xS to safeguard the contents of the RAM when power is removed. This battery is also used to buffer the internal clock. The rechargeable battery is maintained by a charging circuit that receives its power from the internal power supply and that maintain the clock and RAM for a max. period of 30 days.
CAUTION!
Please connect the CPU at least for 24 hours to the power supply, so that the internal accumulator/battery is loaded accordingly.

After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset. The loading procedure is not influenced by the BAT error.

The BAT error can be deleted again, if once during power cycle the time between switching on and off the power supply is at least 30sec. and the battery is fully loaded. Otherwise with a short power cycle the BAT error still exists and an overall reset is executed.

4.2.6 LEDs

LEDs CPU
As soon as the CPU is supplied with 5V, the green PW-LED (Power) is on.

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ST (STOP)</th>
<th>SF (SFAIL)</th>
<th>FC (FRCE)</th>
<th>MC (MMC)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>yellow</td>
<td>red</td>
<td>yellow</td>
<td>yellow</td>
<td></td>
</tr>
</tbody>
</table>

Boot-up after PowerON

- ● BB* ● ● ● ● * Blinking with 10Hz: Firmware is loaded.
- ● ● ● ● ● Initialization: Phase 1
- ● ● ● ● ○ Initialization: Phase 2
- ● ● ● ○ ○ Initialization: Phase 3
- ○ ● ● ○ ○ Initialization: Phase 4

Operation

- ○ ● X X X CPU is in STOP state.
- BB ○ X X X X CPU is in start-up state, the RUN LED blinks during operating OB100 at least for 3s.
- ● ○ ○ X X CPU is in state RUN without error.
- X X ● X X There is a system fault. More information may be found in the diagnostics buffer of the CPU.
- X X X ● X Variables are forced.
- X X X X ● Access to the memory card.
- X BB* ○ ○ ○ * Blinking with 10Hz: Configuration is loaded.

Overall reset

- ○ BB X X X Overall reset is requested.
- ○ BB* X X X * Blinking with 5Hz: Overall reset is executed.
### Hardware description

#### VIPA System 300S

#### Structure > LEDs

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ST (STOP)</th>
<th>SF (SFAIL)</th>
<th>FC (FRCE)</th>
<th>MC (MMC)</th>
<th>Meaning</th>
</tr>
</thead>
</table>

### Factory reset

- ● ● ○ ○ ○ Factory reset is executed.
- ○ ● ● ● ● Factory reset finished without error.

### Firmware update

- ○ ● BB BB ● The alternate blinking indicates that there is new firmware on the memory card.
- ○ ○ BB BB ● The alternate blinking indicates that a firmware update is executed.
- ○ ● ● ● ● Firmware update finished without error.
- ○ BB* BB* BB* BB* * Blinking with 10Hz: Error during Firmware update.

**LEDs Ethernet PG/OP channel L/A, S**

The green L/A-LED (Link/Activity) indicates the physical connection of the Ethernet PG/OP channel to Ethernet. Irregular flashing of the L/A-LED indicates communication of the Ethernet PG/OP channel via Ethernet.

If the green S-LED (Speed) is on, the Ethernet PG/OP has a communication speed of 100MBit/s otherwise 10MBit/s.

### LEDs PROFIBUS/PtP interface X3

Dependent on the mode of operation the LEDs show information about the state of operation of the PROFIBUS part according to the following pattern:

#### Master operation

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ER (ERR)</th>
<th>DE</th>
<th>IF</th>
<th>Meaning</th>
</tr>
</thead>
</table>

#### Master has no project, this means the interface is deactivated respectively PtP is active.

#### Master has bus parameters and is in RUN without slaves.

#### Master is in "clear" state (safety state). The inputs of the slaves may be read. The outputs are disabled.

#### Master is in "operate" state, this means data exchange between master and slaves. The outputs may be accessed.

#### CPU is in RUN, at least 1 slave is missing.

#### CPU is in STOP, at least 1 slave is missing.

#### Initialization error at faulty parameterization.
### LED Status Table

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ER (ERR)</th>
<th>DE</th>
<th>IF</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>●</td>
<td>o</td>
<td>o</td>
<td>●</td>
<td>Waiting state for start command from CPU.</td>
</tr>
</tbody>
</table>

**Slave Operation**

<table>
<thead>
<tr>
<th>RN (RUN)</th>
<th>ER (ERR)</th>
<th>DE</th>
<th>IF</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>red</td>
<td>green</td>
<td>red</td>
<td>Slave has no project respectively PtP is active.</td>
</tr>
<tr>
<td>o</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>Slave is without master.</td>
</tr>
<tr>
<td>BB</td>
<td>o</td>
<td>o</td>
<td>o</td>
<td>Slave exchanges data between master.</td>
</tr>
</tbody>
</table>

**LEDs PROFINET IO Controller X8**

<table>
<thead>
<tr>
<th>MT (Maintenance)</th>
<th>BF (Bus error)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>yellow</td>
<td>red</td>
<td></td>
</tr>
</tbody>
</table>
| X                | ●              | - Bus error, no connection to sub net/switch  
|                  |                | - wrong transfer rate  
|                  |                | - Full-duplex-transmission is not activated |
| X                | BB             | - Failure of a connected IO device  
|                  |                | - At least one IO device is not access-able  
|                  |                | - Faulty configuration |
| ●                | X              | Maintenance event is pending. |
| BB *             | BB *           | * The alternate blinking with 4Hz indicates that a firmware update of the PROFINET IO controller is executed. |
| ●                | ●              | Firmware update of the PROFINET IO controller is finished without error. |
As long as the PROFINET IO controller is not yet configured, for identification you may cause the LED to blink by means of the “Network search of your configuration tool.

**LEDs L/A, S**

The green L/A-LED (Link/Activity) indicates the physical connection of the PROFINET IO controller to Ethernet. Irregular flashing of the L/A-LED indicates communication of the PROFINET IO controller via Ethernet.

If the green S-LED (Speed) is on, the PROFINET IO controller has a communication speed of 100MBit/s otherwise with 10MBit/s.

### 4.2.7 Operating mode switch

**General**

- With the operating mode switch you may switch the CPU between STOP and RUN.
- During the transition from STOP to RUN the operating mode START-UP is driven by the CPU.
- Placing the switch to MRES (Memory Reset), you request an overall reset with following load from MMC, if a project there exists.

### 4.3 Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>315-4PN12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 315SN/PN</td>
</tr>
<tr>
<td>SPEED-Bus</td>
<td>-</td>
</tr>
</tbody>
</table>

**Technical data power supply**

| Power supply (rated value) | DC 24 V |
| Power supply (permitted range) | DC 20.4...28.8 V |
| Reverse polarity protection | ✓ |
| Current consumption (no-load operation) | 270 mA |
| Current consumption (rated value) | 1.1 A |
| Inrush current | 6 A |
| $I^2t$ | 0.28 A²s |
| Max. current drain at backplane bus | 2.5 A |
| Power loss | 8.5 W |

**Load and working memory**

<p>| Load memory, integrated | 2 MB |
| Load memory, maximum | 2 MB |</p>
<table>
<thead>
<tr>
<th><strong>Order no.</strong></th>
<th><strong>315-4PN12</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Work memory, integrated</td>
<td>1 MB</td>
</tr>
<tr>
<td>Work memory, maximal</td>
<td>2 MB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>✓</td>
</tr>
<tr>
<td>Memory card slot</td>
<td>MMC-Card with max. 1 GB</td>
</tr>
</tbody>
</table>

**Hardware configuration**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Racks, max.</td>
<td>4</td>
</tr>
<tr>
<td>Modules per rack, max.</td>
<td>8 in multiple-, 32 in a single-rack configuration</td>
</tr>
<tr>
<td>Number of integrated DP master</td>
<td>1</td>
</tr>
<tr>
<td>Number of DP master via CP</td>
<td>4</td>
</tr>
<tr>
<td>Operable function modules</td>
<td>8</td>
</tr>
<tr>
<td>Operable communication modules PtP</td>
<td>8</td>
</tr>
<tr>
<td>Operable communication modules LAN</td>
<td>8</td>
</tr>
</tbody>
</table>

**Status information, alarms, diagnostics**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Status display</td>
<td>yes</td>
</tr>
<tr>
<td>Interrupts</td>
<td>no</td>
</tr>
<tr>
<td>Process alarm</td>
<td>no</td>
</tr>
<tr>
<td>Diagnostic interrupt</td>
<td>no</td>
</tr>
</tbody>
</table>

**Command processing times**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit instructions, min.</td>
<td>0.01 µs</td>
</tr>
<tr>
<td>Word instruction, min.</td>
<td>0.01 µs</td>
</tr>
<tr>
<td>Double integer arithmetic, min.</td>
<td>0.01 µs</td>
</tr>
<tr>
<td>Floating-point arithmetic, min.</td>
<td>0.06 µs</td>
</tr>
</tbody>
</table>

**Timers/Counters and their retentive characteristics**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of S7 counters</td>
<td>512</td>
</tr>
<tr>
<td>Number of S7 times</td>
<td>512</td>
</tr>
</tbody>
</table>

**Data range and retentive characteristic**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of flags</td>
<td>8192 Byte</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>4095</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>64 KB</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>1024 Byte</td>
</tr>
</tbody>
</table>

**Blocks**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of OBs</td>
<td>24</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>2048</td>
</tr>
<tr>
<td>Number of FCs</td>
<td>2048</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
</tbody>
</table>
### Hardware description

#### Technical data

<table>
<thead>
<tr>
<th>Order no.</th>
<th>315-4PN12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>4</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td></td>
</tr>
<tr>
<td>Real-time clock buffered</td>
<td>✓</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>6 W</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10 s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>✓</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>Master/Slave</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>Slave</td>
</tr>
<tr>
<td><strong>Address areas (I/O)</strong></td>
<td></td>
</tr>
<tr>
<td>Input I/O address area</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Input process image maximal</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Output process image maximal</td>
<td>2048 Byte</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>16384</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>16384</td>
</tr>
<tr>
<td>Digital inputs central</td>
<td>1024</td>
</tr>
<tr>
<td>Digital outputs central</td>
<td>1024</td>
</tr>
<tr>
<td>Integrated digital inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated digital outputs</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>1024</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>1024</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>256</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>256</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
<tr>
<td><strong>Communication functions</strong></td>
<td></td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>8</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>Order no.</td>
<td>315-4PN12</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td></td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>32</td>
</tr>
</tbody>
</table>

**Functionality Sub-D interfaces**

<table>
<thead>
<tr>
<th>Type</th>
<th>X2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>MPI</td>
<td>✓</td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>X3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>MPI</td>
<td></td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Functionality MPI**

<table>
<thead>
<tr>
<th>Number of connections, max.</th>
<th>32</th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Routing</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td></td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>19.2 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>12 Mbit/s</td>
</tr>
</tbody>
</table>

**Functionality PROFIBUS master**

<table>
<thead>
<tr>
<th>PG/OP channel</th>
<th>✓</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Order no.

<table>
<thead>
<tr>
<th>Feature</th>
<th>315-4PN12</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Equidistance support</td>
<td>-</td>
</tr>
<tr>
<td>Isochronous mode</td>
<td>-</td>
</tr>
<tr>
<td>SYNC/FREEZE</td>
<td>-</td>
</tr>
<tr>
<td>Activation/deactivation of DP slaves</td>
<td>✓</td>
</tr>
<tr>
<td>Direct data exchange (slave-to-slave commu-</td>
<td>-</td>
</tr>
<tr>
<td>nication)</td>
<td></td>
</tr>
<tr>
<td>DPV1</td>
<td>✓</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>9.6 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>12 Mbit/s</td>
</tr>
<tr>
<td>Number of DP slaves, max.</td>
<td>124</td>
</tr>
<tr>
<td>Address range inputs, max.</td>
<td>8 KB</td>
</tr>
<tr>
<td>Address range outputs, max.</td>
<td>8 KB</td>
</tr>
<tr>
<td>User data inputs per slave, max.</td>
<td>244 Byte</td>
</tr>
<tr>
<td>User data outputs per slave, max.</td>
<td>244 Byte</td>
</tr>
</tbody>
</table>

### Functionality PROFIBUS slave

<table>
<thead>
<tr>
<th>Feature</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Routing</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Direct data exchange (slave-to-slave communi-</td>
<td>-</td>
</tr>
<tr>
<td>cation)</td>
<td></td>
</tr>
<tr>
<td>DPV1</td>
<td>✓</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>9.6 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>12 Mbit/s</td>
</tr>
<tr>
<td>Automatic detection of transmission speed</td>
<td>-</td>
</tr>
<tr>
<td>Transfer memory inputs, max.</td>
<td>244 Byte</td>
</tr>
<tr>
<td>Transfer memory outputs, max.</td>
<td>244 Byte</td>
</tr>
<tr>
<td>Address areas, max.</td>
<td>32</td>
</tr>
<tr>
<td>User data per address area, max.</td>
<td>32 Byte</td>
</tr>
</tbody>
</table>

### Functionality PROFINET I/O controller

<table>
<thead>
<tr>
<th>Feature</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Realtime Class</td>
<td>-</td>
</tr>
<tr>
<td>Conformance Class</td>
<td>PROFINET IO</td>
</tr>
<tr>
<td>Number of PN IO devices</td>
<td>32</td>
</tr>
<tr>
<td>IRT support</td>
<td>-</td>
</tr>
<tr>
<td>Prioritized start-up</td>
<td>-</td>
</tr>
<tr>
<td><strong>Order no.</strong></td>
<td><strong>315-4PN12</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Number of PN IO lines</td>
<td>1</td>
</tr>
<tr>
<td>Address range inputs, max.</td>
<td>2 KB</td>
</tr>
<tr>
<td>Address range outputs, max.</td>
<td>2 KB</td>
</tr>
<tr>
<td>Transmiting clock</td>
<td>1 ms</td>
</tr>
<tr>
<td>Update time</td>
<td>1 ms .. 512 ms</td>
</tr>
</tbody>
</table>

**Point-to-point communication**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PtP communication</td>
<td>✓</td>
</tr>
<tr>
<td>Interface isolated</td>
<td>✓</td>
</tr>
<tr>
<td>RS232 interface</td>
<td>-</td>
</tr>
<tr>
<td>RS422 interface</td>
<td>-</td>
</tr>
<tr>
<td>RS485 interface</td>
<td>✓</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>150 bit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>115.5 kbit/s</td>
</tr>
<tr>
<td>Cable length, max.</td>
<td>500 m</td>
</tr>
</tbody>
</table>

**Point-to-point protocol**

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII protocol</td>
<td>✓</td>
</tr>
<tr>
<td>STX/ETX protocol</td>
<td>✓</td>
</tr>
<tr>
<td>3964(R) protocol</td>
<td>✓</td>
</tr>
<tr>
<td>RK512 protocol</td>
<td>-</td>
</tr>
<tr>
<td>USS master protocol</td>
<td>✓</td>
</tr>
<tr>
<td>Modbus master protocol</td>
<td>✓</td>
</tr>
<tr>
<td>Modbus slave protocol</td>
<td>-</td>
</tr>
<tr>
<td>Special protocols</td>
<td>-</td>
</tr>
</tbody>
</table>

**Functionality RJ45 interfaces**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>X5</td>
</tr>
<tr>
<td>Type of interface</td>
<td>Ethernet 10/100 MBit</td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>4</td>
</tr>
<tr>
<td>Productive connections</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>X8</td>
</tr>
<tr>
<td>Type of interface</td>
<td>Ethernet 10/100 MBit</td>
</tr>
<tr>
<td>Connector</td>
<td>RJ45</td>
</tr>
</tbody>
</table>
## Order no.

<table>
<thead>
<tr>
<th>Order no.</th>
<th>315-4PN12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>8</td>
</tr>
<tr>
<td>Productive connections</td>
<td>✓</td>
</tr>
</tbody>
</table>

### Ethernet communication CP

| Number of productive connections, max.         | 8         |
| Number of productive connections by Siemens NetPro, max. | 8         |
| S7 connections                                 | BSEND, BRCV, GET, PUT, Connection of active and passive data handling |
| User data per S7 connection, max.             | 32 KB     |
| TCP-connections                                | FETCH PASSIV, WRITE PASSIV, Connection of passive data handling |
| User data per TCP connection, max.            | 64 KB     |
| ISO-connections                                | -         |
| User data per ISO connection, max.            | -         |
| ISO on TCP connections (RFC 1006)             | FETCH PASSIV, WRITE PASSIV, Connection of passive data handling |
| User data per ISO on TCP connection, max.     | 32 KB     |
| UDP-connections                                | -         |
| User data per UDP connection, max.            | -         |
| UDP-multicast-connections                     | -         |
| UDP-broadcast-connections                     | -         |

### Ethernet open communication

| Number of connections, max.                   | 8         |
| User data per ISO on TCP connection, max.    | 8 KB      |
| User data per native TCP connection, max.    | 8 KB      |
| User data per ad hoc TCP connection, max.    | 1460 Byte |
| User data per UDP connection, max.           | 1472 Byte |

### Housing

| Material                                      | PPE       |
| Mounting                                      | Rail System 300 |

### Mechanical data

| Dimensions (WxHxD)                            | 80 mm x 125 mm x 120 mm |
| Weight                                        | 430 g     |

### Environmental conditions

<p>| Operating temperature                         | 0 °C to 60 °C          |
| Storage temperature                           | -25 °C to 70 °C        |</p>
<table>
<thead>
<tr>
<th>Order no.</th>
<th>315-4PN12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certifications</td>
<td></td>
</tr>
<tr>
<td>UL508 certification</td>
<td>in preparation</td>
</tr>
</tbody>
</table>
5 Deployment CPU 315-4PN12

5.1 Assembly

Information about assembly and cabling: § Chapter 3 ‘Assembly and installation guidelines’ on page 17

5.2 Start-up behaviour

<table>
<thead>
<tr>
<th>Turn on power supply</th>
<th>After the power supply has been switched on, the CPU changes to the operating mode the operating mode lever shows.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default boot procedure, as delivered</td>
<td>When the CPU is delivered it has been reset. After a STOP→RUN transition the CPU switches to RUN without program.</td>
</tr>
<tr>
<td>Boot procedure with valid configuration in the CPU</td>
<td>The CPU switches to RUN with the program stored in the battery buffered RAM.</td>
</tr>
</tbody>
</table>
| Boot procedure with empty battery | - The accumulator/battery is automatically loaded via the integrated power supply and guarantees a buffer for max. 30 days. If this time is exceeded, the battery may be totally discharged. This means that the battery buffered RAM is deleted.  
- In this state, the CPU executes an overall reset. If a MMC is plugged, program code and data blocks are transferred from the MMC into the work memory of the CPU. If no MMC is plugged, the CPU transfers permanent stored "protected" blocks into the work memory if available.  
- Depending on the position of the operating mode switch, the CPU switches to RUN, if OB81 exists, res. remains in STOP. This event is stored in the diagnostic buffer as: "Start overall reset automatically (unbuffered PowerON)". |

CAUTION!

After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset. The BAT error can be deleted again, if once during power cycle the time between switching on and off the power supply is at least 30sec. and the battery is fully loaded. Otherwise with a short power cycle the BAT error still exists and an overall reset is executed.
5.3 Addressing

5.3.1 Overview

To provide specific addressing of the installed peripheral modules, certain addresses must be allocated in the CPU. At the start-up of the CPU, this assigns automatically peripheral addresses for digital in-/output modules starting with 0 and ascending depending on the slot location.

If no hardware project engineering is available, the CPU stores at the addressing analog modules to even addresses starting with 256.

5.3.2 Addressing Backplane bus I/O devices

The CPU 315-4PN12 provides an I/O area (address 0 ... 2047) and a process image of the in- and outputs (each address 0 ... 127). The process image stores the signal states of the lower address (0 ... 127) additionally in a separate memory area.

The process image is divided into two parts:
- process image to the inputs (PII)
- process image to the outputs (PIQ)

The process image is updated automatically when a cycle has been completed.

Max. number of pluggable modules

Maximally 8 modules per row may be configured by the CPU 315-4PN12.

For the project engineering of more than 8 modules you may use line interface connections. For this you set in the hardware configurator the module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. Now you may extend your system with up to 3 profile rails by starting each with an IM 361 from Siemens at slot 3. Considering the max total current with the CPU 315-4PN12 from VIPA up to 32 modules may be arranged in a row. Here the installation of the line connections IM 360/361 from Siemens is not required.

Define addresses by hardware configuration

You may access the modules with read res. write accesses to the peripheral bytes or the process image.

To define addresses a hardware configuration may be used. For this, click on the properties of the according module and set the wanted address.
**Automatic addressing**

If you do not like to use a hardware configuration, an automatic addressing comes into force. At the automatic address allocation DIOs occupy depending on the slot location always 4byte and AIOs, FMs, CPs always 16byte at the bus. Depending on the slot location the start address from where on the according module is stored in the address range is calculated with the following formulas:

- **DIOs**: Start address = \(4 \times (\text{slot} - 1)\)
- **AIOs, FMs, CPs**: Start address = \(16 \times (\text{slot} - 1) + 256\)

The following sample shows the functionality of the automatic address allocation:

**Example for automatic address allocation**

5.4 Hardware configuration - CPU

**Precondition**

The configuration of the CPU takes place at the Siemens 'hardware configurator'. The hardware configurator is part of the Siemens SIMATIC Manager. It serves for project engineering. The modules, which may be configured here are listed in the hardware catalog. If necessary you have to update the hardware catalog with 'Options ➔ Update Catalog'.
For project engineering a thorough knowledge of the Siemens SIMATIC Manager and the Siemens hardware configurator is required.

![Image]

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. This may cause conflicts in applications that presume an unmodified ACCU 2.

For more information may be found in the manual "VIPA Operation list SPEED7" at "Differences between SPEED7 and 300V programming".

Proceeding

To be compatible with the Siemens SIMATIC Manager the following steps should be executed:

1. Start the Siemens hardware configurator with a new project.
2. Insert a profile rail from the hardware catalog.
3. Place at ‘Slot’-Number 2 the CPU 315-2 PN/DP (315-2EH13 V2.6).
4. The integrated PROFIBUS DP master (X3) is to be configured and connected via the sub module X1 (MPI/DP). In the operation mode PROFIBUS the CPU may further more be accessed via the MPI interface (X2) with address 2 und 187.5kbit/s.
5. The PROFINET IO controller is to be configured via the sub module ‘X2 PN-IO’.

5.5 Hardware configuration - I/O modules

Hardware configuration of the modules

After the hardware configuration place the System 300 modules in the plugged sequence starting with slot 4.
Parametrization

For parametrization double-click during the project engineering at the slot overview on the module you want to parameterize. In the appearing dialog window you may set the wanted parameters. By using the SFCs 55, 56 and 57 you may alter and transfer parameters for wanted modules during runtime. For this you have to store the module specific parameters in so called "record sets". More detailed information about the structure of the record sets is to find in the according module description.

Bus extension with IM 360 and IM 361

For the project engineering of more than 8 modules you may use line interface connections. For this you set in the hardware configurator the module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. Now you may extend your system with up to 3 profile rails by starting each with an IM 361 from Siemens at slot 3. Considering the max. total current with the VIPA SPEED7 CPUs up to 32 modules may be arranged in a row. Here the installation of the line connections IM 360/361 from Siemens is not required.

5.6 Hardware configuration - Ethernet PG/OP channel

Overview

The CPU 315-4PN12 has an integrated Ethernet PG/OP channel. This channel allows you to program and remote control your CPU. The PG/OP channel also gives you access to the internal web page that contains information about firmware version, connected I/O devices, current cycle times etc. With the first start-up respectively after an overall reset the Ethernet PG/OP channel does not have any IP address. For online access to the CPU via Ethernet PG/OP channel valid IP address parameters have to be assigned to this by means of the Siemens SIMATIC Manager. This is called "initialization".

Assembly and commissioning

1. Install your System 300S with your CPU.
2. Wire the system by connecting cables for voltage supply and signals.
3. Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet
4. Switch on the power supply.

After a short boot time the CP is ready for communication. He possibly has no IP address data and requires an initialization.
"Initialization" via PLC functions

The initialization via PLC functions takes place with the following proceeding:

1. Determine the current Ethernet (MAC) address of your Ethernet PG/OP channel. This always may be found as 1. address under the front flap of the CPU on a sticker on the left side.

2. You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens SIMATIC Manager starting with version V 5.3 & SP3 with the following proceeding:

   1. Start the Siemens SIMATIC Manager and set via ‘Options -> Set PG/PC interface’ the access path to ‘TCP/IP -> Network card ....’.

   2. Open with ‘PLC -> Edit Ethernet Node n’ the dialog window with the same name.

   3. To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The MAC address may be found at the 1. label beneath the front flap of the CPU.

   4. Choose if necessary the known MAC address of the list of found stations.

   5. Either type in the IP configuration like IP address, subnet mask and gateway.

   6. Confirm with [Assign IP configuration].

Assign IP address parameters

Direct after the assignment the Ethernet PG/OP channel may be reached online by these address data. The value remains as long as it is reassigned, it is overwritten by a hardware configuration or an factory reset is executed.

Take IP address parameters in project

1. Open the Siemens hardware configurator und configure the Siemens CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6).

2. Configure the modules at the standard bus.

3. For the Ethernet PG/OP channel you have to configure a Siemens CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7 343-1EX11 0XE0) always below the really plugged modules.
4. Open the property window via double-click on the CP 343-1EX11 and enter for the CP at ‘Properties’ the IP address data, which you have assigned before.

5. Transfer your project.

5.7 Setting standard CPU parameters

5.7.1 Parametrization via Siemens CPU

Since the CPU is to be configured as Siemens CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6) in the Siemens hardware configurator, the standard parameters of the VIPA CPU may be set with "Object properties" of the CPU 315-2PN/DP during hardware configuration. Via a double-click on the CPU 315-2 PN/DP the parameter window of the CPU may be accessed. Using the registers you get access to every standard parameter of the CPU.

5.7.2 Parameters CPU

Supported parameters

The CPU does not evaluate each parameter, which may be set at the hardware configuration. The parameters of the following registers are not currently supported: Synchronous cycle interrupt, Communication and Web.

The following parameters are supported by the CPU at this time:
General
- Short description: The short description of the Siemens CPU 315-2EH13 is CPU 315-2 PN/DP.
- Order No. / Firmware: Order number and firmware are identical to the details in the "hardware catalog" window.
- Name: The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC Manager.
- Plant designation: Here is the possibility to specify a plant designation for the CPU. This plant designation identifies parts of the plant according to their function. Its structure is hierarchical according to IEC 1346-1.
- Location designation: The location designation is part of the resource designation. Here the exact location of your module within a plant may be specified.
- Comment: In this field information about the module may be entered.

Startup
- Startup when expected/actual configuration differs: If the checkbox for 'Startup when expected/actual configuration differ' is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU does not switch to RUN mode and remains in STOP mode. If the checkbox for 'Startup when expected/actual configuration differ' is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.
- Monitoring time for ready message by modules [100ms]: This operation specifies the maximum time for the ready message of every configured module after PowerON. Here connected PROFINET IO devices also considered until they are parameterized. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration. Monitoring time for ready message by modules [100ms]
- Transfer of parameters to modules [100ms]: The maximum time for the transfer of parameters to parameterizable modules. Here connected PROFINET IO devices also considered until they are parameterized. If not every module has been assigned parameters by the time this monitoring time has expired; the actual configuration becomes unequal to the preset configuration.

Cycle/Clock memory
- Update OB1 process image cyclically: This parameter is not relevant.
- Scan cycle monitoring time: Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:
  - Communication processes
  - a series of interrupt events
  - an error in the CPU program
- Minimum scan cycle time: This parameter is not relevant.
- Scan cycle load from Communication: This parameter is not relevant.
- Size of the process image input/output area: Here the size of the process image max. 2048 for the input/output periphery may be fixed.
OB85 call up at I/O access error: The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system. The VIPA CPU is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.

Clock memory: Activate the check box if you want to use clock memory and enter the number of the memory byte.

- The selected memory byte cannot be used for temporary data storage.

### Retentive Memory
- Number of Memory bytes from MB0: Enter the number of retentive memory bytes from memory byte 0 onwards.
- Number of S7 Timers from T0: Enter the number of retentive S7 timers from T0 onwards. Each S7 timer occupies 2 bytes.
- Number of S7 Counters from C0: Enter the number of retentive S7 counter from C0 onwards.
- Areas: This parameter is not supported.

### Interrupts
- Priority: Here the priorities are displayed, according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts).

### Time-of-day interrupts
- Priority: Here the priorities may be specified according to which the time-of-day interrupt is processed. With priority "0" the corresponding OB is deactivated.
- Active: Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.
- Execution: Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for start date and time.
- Start date/time: Enter date and time of the first execution of the time-of-day interrupt.
- Process image partition: This parameter is not supported.

### Cyclic interrupts
- Priority: Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority "0" the corresponding interrupt is deactivated.
- Execution: Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.
- Phase offset: Enter the delay time in ms for current execution for the watchdog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.
- Process image partition: This parameter is not supported.
Diagnostics/Clock
- Report cause of STOP: Activate this parameter, if the CPU should report the cause of STOP to PG respectively OP on transition to STOP.
- Number of messages in the diagnostics buffer: Here the number of diagnostics are displayed, which may be stored in the diagnostics buffer (circular buffer).
- Synchronization type: Here you specify whether clock should synchronize other clocks or not.
  - as slave: The clock is synchronized by another clock.
  - as master: The clock synchronizes other clocks as master.
  - none: There is no synchronization
- Time interval: Time intervals within which the synchronization is to be carried out.
- Correction factor: Lose or gain in the clock time may be compensated within a 24 hour period by means of the correction factor in ms. If the clock is 1s slow after 24 hours, you have to specify a correction factor of "+1000" ms.

Protection
- Level of protection: Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.
  - Protection level 1 (default setting):
    - No password adjustable, no restrictions
  - Protection level 2 with password:
    - Authorized users: read and write access
    - Unauthorized user: read access only
  - Protection level 3:
    - Authorized users: read and write access
    - Unauthorized user: no read and write access

5.7.3 Parameters for MPI/DP
The properties dialog of the MPI interface is opened via a double click to the sub module MPI/DP.

General
- Short description: Here the short description "MPI/DP" for the MPI interface is specified.
- Order no.: Nothing is shown here.
- Name: At Name "MPI/DP" for the MPI interface is shown. If you change the name, the new name appears in the Siemens SIMATIC Manager.
- Type: Please regard only the type "MPI" is supported by the VIPA CPU.
- Interface: Here the MPI address is shown.
- Properties: With this button the properties of the MPI interface may be preset.
- Comment: You can enter the purpose of the MPI interface.

Address
- Diagnostics: A diagnostics address for the MPI interface is to be preset here. In the case of an error the CPU is informed via this address.
- Operating mode, Configuration, Clock: These parameters are not supported.
5.8 Setting VIPA specific CPU parameters

5.8.1 Proceeding

Overview
Except of the VIPA specific CPU parameters the CPU parametrization takes place in the parameter dialog of the CPU from Siemens. With installing of the SPEEDBUS.GSD the VIPA specific parameters may be set during hardware configuration. Here the following parameters may be accessed:

- Function RS485 (PtP, Synchronization between DP master and CPU)
- Token Watch
- Number remanence flag, timer, counter
- Priority OB 28, OB 29, OB 57

Requirements
Since the VIPA specific CPU parameters may be set, the installation of the SPEEDBUS.GSD from VIPA in the hardware catalog is necessary. The CPU may be configured in a PROFIBUS master system and the appropriate parameters may be set after installation.

Installation of the SPEEDBUS.GSD
The GSD (Geräte-Stamm-Datei) is online available in the following language versions. Further language versions are available on inquires.

<table>
<thead>
<tr>
<th>Name</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPEEDBUS.GSD</td>
<td>german (default)</td>
</tr>
<tr>
<td>SPEEDBUS.GSG</td>
<td>german</td>
</tr>
<tr>
<td>SPEEDBUS.GSE</td>
<td>english</td>
</tr>
</tbody>
</table>

The GSD files may be found at www.vipa.com at the "Service" part. The integration of the SPEEDBUS.GSD takes place with the following proceeding:

1. Browse to www.vipa.com
2. Click to 'Service ➔ Download ➔ GSD- and EDS-Files ➔ Profibus'
3. Download the file Cx000023_Vxxx.
4. Extract the file to your work directory. The SPEEDBUS.GSD is stored in the directory VIPA_System_300S.
5. Start the hardware configurator from Siemens.
6. Close every project.
7. Select ‘Options ➔ Install new GSD-file’.
8. Navigate to the directory VIPA_System_300S and select SPEEDBUS.GSD an.
   ➔ The SPEED7 CPUs and modules of the System 300S from VIPA may now be found in the hardware catalog at PROFIBUS-DP / Additional field devices / I/O / VIPA_SPEEDBUS.

Hardware configuration
The embedding of the CPU 315-4PN12 happens by means of a virtual PROFIBUS master system with the following approach:
1. Perform a hardware configuration for the CPU. Chapter 5.4 'Hardware configuration - CPU' on page 42

2. Configure always as last module a Siemens DP master CP 342-5 (342-5DA02 V5.0). Connect and parametrize it at operation mode "DP-Master".

3. Connect the slave system "VIPA_SPEEDbus". After installing the SPEEDBUS.GSD this may be found in the hardware catalog at Profibus-DP / Additional field devices / I/O / VIPA / VIPA_SPEEDBUS.

4. For the slave system set the PROFIBUS address 100.

5. Configure at slot 0 the VIPA CPU 315-4PN12 of the hardware catalog from VIPA_SPEEDbus.

6. By double clicking the placed CPU 315-4PN12 the properties dialog of the CPU may be opened.

The hardware configuration, which is shown here, is only required, if you want to customize the VIPA specific parameters.

5.8.2 VIPA specific parameters

The following parameters may be accessed by means of the properties dialog of the VIPA-CPU.

5.8.2.1 Function RS485 X3

Using this parameter the RS485 interface may be switched to PtP communication (point to point) respectively the synchronization between DP master system and CPU may be set:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivated</td>
<td>Deactivates the RS485 interface.</td>
</tr>
<tr>
<td>PtP</td>
<td>With this operating mode the PROFIBUS DP master is deacti-vated and the RS485 interface acts as an interface for serial point-to-point communication. Here data may be exchanged between two stations by means of protocols.</td>
</tr>
<tr>
<td>PROFIBUS DP async</td>
<td>PROFIBUS DP master operation asynchronous to CPU cycle. The RS485 interface is preset at default to PROFIBUS DP async. Here CPU cycle and cycles of every VIPA PROFIBUS DP master run independently.</td>
</tr>
<tr>
<td>PROFIBUS DP syncIn</td>
<td>The CPU is waiting for DP master input data.</td>
</tr>
</tbody>
</table>
### 5.8.2.1.1 Synchronization between master system and CPU

#### Overview

Normally the cycles of CPU and DP master run independently. The cycle time of the CPU is the time needed for one OB1 cycle and for reading respectively writing the inputs respectively outputs. The cycle time of a DP master depends among others on the number of connected slaves and the baud rate, thus every plugged DP master has its own cycle time. Due to the asynchronism of CPU and DP master the whole system gets relatively high response times. The synchronization behaviour between every VIPA PROFIBUS DP master and the CPU may be configured by means of a hardware configuration as shown above. The different modes for the synchronization are in the following described.

#### PROFIBUS DP SyncInOut

In PROFIBUS DP SyncInOut mode CPU and DP master system are waiting on each other and form thereby a cycle. Here the whole cycle is the sum of the longest DP master cycle and CPU cycle. By this synchronization mode you receive global consistent in-/output data, since within the total cycle the same input and output data are handled successively by CPU and DP master system. If necessary the time of the Watchdog of the bus parameters should be increased at this mode.

#### PROFIBUS DP SyncOut

In this operating mode the cycle time of the VIPA DP master system depends on the CPU cycle time. After CPU start-up the DP master gets synchronized. As soon as their cycle is passed they wait for the next synchronization impulse with output data of the CPU. So the response time of your system can be improved because output data were directly transmitted to the DP master system. If necessary the time of the Watchdog of the bus parameters should be increased at this mode.

<table>
<thead>
<tr>
<th>PROFIBUS DP syncOut</th>
<th>The DP master system is waiting for CPU output data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROFIBUS DP syncInOut</td>
<td>CPU and DP master system are waiting on each other and form thereby a cycle.</td>
</tr>
<tr>
<td>Default: PROFIBUS DP async</td>
<td></td>
</tr>
</tbody>
</table>
In the operating mode PROFIBUS DP SyncIn the CPU cycle is synchronized to the cycle of the VIPA PROFIBUS DP master system. Here the CPU cycle depends on the VIPA DP master with the longest cycle time. If the CPU gets into RUN it is synchronized with each PROFIBUS DP master. As soon as the CPU cycle is passed, it waits for the next synchronization impulse with input data of the DP master system. If necessary the Scan Cycle Monitoring Time of the CPU should be increased.

5.8.2.2 Token Watch

By presetting the PROFIBUS bus parameters within the hardware configuration a token time for the PROFIBUS results. The token time defines the duration until the token reaches the DP master again. Per default this time is supervised. Due to this monitoring disturbances on the bus can affect a reboot of the DP master. Here with the parameter Token Watch the monitoring of the token time can be switched off respectively on. Default: On

5.8.2.3 Number remanence flag

Here the number of flag bytes may be set. With 0 the value Retentive memory > Number of memory bytes starting with MB0 set at the parameters of the Siemens CPU is used. Otherwise the adjusted value (1 ... 8192) is used. Default: 0

5.8.2.4 Priority of OB 28 and OB 29

The priority fixes the order of interrupts of the corresponding interrupt OB. Here the following priorities are supported: 0 (Interrupt-OB is deactivated), 2, 3, 4, 9, 12, 16, 17, 24. Default: 24
5.9 Project transfer

Overview
There are the following possibilities for project transfer into the CPU:
- Transfer via MPI/PROFIBUS
- Transfer via Ethernet
- Transfer via MMC

5.9.1 Transfer via MPI/PROFIBUS

General
For transfer via MPI/PROFIBUS there is the following interface:
- X2: MPI interface
- X3: PROFIBUS interface

Net structure
The structure of a MPI net is electrically identical with the structure of a PROFIBUS net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and PROFIBUS cables. Please consider with the CPU 315-4PN12 that the total extension of the MPI net does not exceed 50m. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI address 2.

MPI programming cable
The MPI programming cables are available at VIPA in different variants. The cables provide a RS232 res. USB plug for the PC and a bus enabled RS485 plug for the CPU. Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

Terminating resistor
A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment. Please make sure that the participants with the activated terminating resistors are always power supplied. Otherwise it may cause interferences on the bus.

Approach transfer via MPI interface

1. Connect your PC to the MPI jack of your CPU via a MPI programming cable.
2. Load your project in the SIMATIC Manager from Siemens.
3. Choose in the menu ‘Options ➤ Set PG/PC interface’.
4. Select in the according list the "PC Adapter (MPI)"; if appropriate you have to add it first, then click on [Properties].

5. Set in the register MPI the transfer parameters of your MPI net and type a valid address.

6. Switch to the register Local connection.

7. Set the COM port of the PCs and the transfer rate 38400Baud for the MPI programming cable from VIPA.

8. Via 'PLC ➔ Load to module' via MPI to the CPU and save it on a MMC via 'PLC ➔ Copy RAM to ROM' if one is plugged.

Proceeding Transfer via PROFIBUS interface

1. Connect your PC to the DP-PB jack X3 of your CPU via a MPI programming cable.

2. Load your project in the Siemens SIMATIC Manager.

3. Choose in the menu 'Options ➔ Set PG/PC interface'.

4. Select in the according list the "PC Adapter (PROFIBUS)"; if appropriate you have to add it first, then click at [Properties].

5. Set in the register PROFIBUS the transfer parameters of your PROFIBUS net and enter a valid PROFIBUS address. The PROFIBUS address must be assigned to the DP master by a project before.

6. Switch to the register Local connection.

7. Set the COM port of the PCs and the transfer rate 38400baud for the MPI programming cable from VIPA.

8. Transfer your project via 'PLC ➔ Load to module' via PROFIBUS to the CPU and save it with 'PLC ➔ Copy RAM to ROM' on a memory card if one is plugged.

Transfer via PROFIBUS is available by DP master, if projected as master and assigned with a PROFIBUS address before.

Within selecting the slave mode you have additionally to select the option "Test, commissioning, routing".

5.9.2 Transfer via Ethernet

For transfer via Ethernet the CPU has the following interface:

- X5: Ethernet PG/OP channel
- X8: PROFINET-IO-Controller

Initialization

So that you may access the Ethernet PG/OP channel you have to assign IP address parameters by means of the "initialization".

☞ Chapter 5.6 ‘Hardware configuration - Ethernet PG/OP channel’ on page 44
Transfer

1. For the transfer, connect, if not already done, the appropriate Ethernet port to your Ethernet.
2. Open your project with the Siemens SIMATIC Manager.
3. Set via ‘Options ➔ Set PG/PC Interface’ the access path to "TCP/IP ➔ Network card .... ".
4. Click to ‘PLC ➔ Download’ Download ➔ the dialog "Select target module" is opened. Select your target module and enter the IP address parameters of the Ethernet PG/OP channel for connection. Provided that no new hardware configuration is transferred to the CPU, the entered Ethernet connection is permanently stored in the project as transfer channel.
5. With [OK] the transfer is started.

System dependent you get a message that the projected system differs from target system. This message may be accepted by [OK].

→ Your project is transferred and may be executed in the CPU after transfer.

5.9.3 Transfer via MMC

The MMC (Memory Card) serves as external transfer and storage medium. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project is stored in the root directory and has one of the following file names:

- S7PROG.WLD
- AUTOLOAD.WLD

With ‘File ➔ Memory Card File ➔ New’ in the Siemens SIMATIC Manager a new wld file may be created. After the creation copy the blocks from the project blocks folder and the System data into the wld file.

Transfer MMC ➔ CPU

The transfer of the application program from the MMC into the CPU takes place depending on the file name after an overall reset or PowerON.

- S7PROG.WLD is read from the MMC after overall reset.
- AUTOLOAD.WLD is read after PowerON from the MMC.

The blinking of the MC LED of the CPU marks the active transfer. Please regard that your user memory serves for enough space, otherwise your user program is not completely loaded and the SF LED gets on.

Transfer CPU ➔ MMC

When the MMC has been installed, the write command stores the content of the battery buffered RAM as S7PROG.WLD on the MMC.

The write command is controlled by means of the block area of the Siemens SIMATIC Manager ‘PLC ➔ Copy RAM to ROM’. During the write process the MC LED of the CPU is blinking. When the LED expires the write process is finished.
If this project is to be loaded automatically from the MMC with PowerON, you have to rename this on the MMC to AUTOLOAD.WLD.

**Transfer control**

After a MMC access, an ID is written into the diagnostic buffer of the CPU. To monitor the diagnosis entries, you select ‘PLC ➔ Module Information’ in the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you reach the diagnosis window.

Information about the event IDs ◾ Chapter 5.19 ‘VIPA specific diagnostic entries’ on page 71.

### 5.10 Access to the internal Web page

**Access to the web page** The Ethernet PG/OP channel provides a web page that you may access via an Internet browser by its IP address. The web page contains information about firmware versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the MMC-Cmd WEBPAGE. ◾ Chapter 5.18 ‘MMC-Cmd - Auto commands’ on page 69

**Requirements**

A PG/OP channel connection should be established between PC with Internet browser and CPU 315-4PN12. This may be tested by Ping to the IP address of the PG/OP channel.

**Web page**

The access takes place via the IP address of the Ethernet PG/OP channel. The web page only serves for information output. The monitored values are not alterable.

---

**CPU with Ethernet-PG/OP**

<table>
<thead>
<tr>
<th>Slot 100</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>VIPA 315-4PN12 V.... Px000152.pkg, SERIALNUMBER 05439</td>
<td>Order no., firmware vers., package, serial no.</td>
</tr>
<tr>
<td>SUPPORTDATA : PRODUCT V3596, HARDWARE V0112, 5679G-V10 , HX000026.100 , Bx000027 V6596, Ax000086 V1200, Ax000127 V1020, fx000007.wld V1180, FlashFileSystem : V102</td>
<td>Information for support</td>
</tr>
<tr>
<td>Memorysizes (Bytes): LoadMem : 1048576, WorkMemCode : 524288, WorkMemData : 524288</td>
<td>Information about memory configuration, load memory, work memory (code/data)</td>
</tr>
<tr>
<td>OnBoardEthernet : MacAddress : 0020D50144C1, IP-Address : 172.20.120.62, SubnetMask : 255.255.255.0, Gateway : 172.20.120.62</td>
<td>Ethernet PG/OP: Addresses</td>
</tr>
<tr>
<td>Cpu state : Run</td>
<td>CPU state</td>
</tr>
</tbody>
</table>
### Slot 100

<table>
<thead>
<tr>
<th>Function RS485 X2/COM1: MPI</th>
<th>Operating mode RS485 (MPI: MPI-operation, PtP: point to point operation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function RS485 X3/COM2: DPM-async</td>
<td></td>
</tr>
<tr>
<td>Cycletime [microseconds] : min=0 cur=770 ave=750 max=878</td>
<td>CPU cycle time: min= minimal cur= current max= maximal</td>
</tr>
<tr>
<td>MCC-Trial-Time: 70:23</td>
<td>Remaining time in hh:mm for deactivation of the expansion memory if MCC is removed.</td>
</tr>
<tr>
<td>ArmLoad [percent] : cur=67, max=70</td>
<td>Information for support</td>
</tr>
<tr>
<td>PowerCycleHxRetries : 29, 0, 0, 0</td>
<td></td>
</tr>
<tr>
<td>AutoCompress activated</td>
<td></td>
</tr>
</tbody>
</table>

### Slot 201

<table>
<thead>
<tr>
<th>VIPA 342-1DA70 V3.3.0 Px000062.pkg</th>
<th>CPU component: DP master</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUPPORTDATA : PRODUCT V3300, BB000218 V5300, AB000068 V4170, ModuleType CB2C0010</td>
<td>Name, firmware-version, package</td>
</tr>
<tr>
<td>Cycletime [microseconds] : min=65535000 cur=0 ave=0 max=0 cnt=0</td>
<td>CPU cycle time: min= minimal cur= current max= maximal</td>
</tr>
</tbody>
</table>

### Slot 206

<table>
<thead>
<tr>
<th>V0.0.1 Px000072.pkg, SUPPORTDATA : Bb000429 V1072, PRODUCT V1072, Hx000075 V1210, ModuleType ACDB0082 Address Input 2046</th>
<th>CPU component: PROFINET IO Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information for support</td>
<td></td>
</tr>
</tbody>
</table>

### Standard Bus

<table>
<thead>
<tr>
<th>Standard Bus</th>
<th>Modules at the standard bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>BaudRate Read Mode1, BaudRate Write Mode1</td>
<td>Information for support</td>
</tr>
<tr>
<td>Line 1: ModuleType 94F9:IM36x</td>
<td>IM interface if exists</td>
</tr>
<tr>
<td>Rack 0 / Slot 4</td>
<td>Rack no. / slot</td>
</tr>
</tbody>
</table>
### 5.11 Operating modes

#### 5.11.1 Overview

The CPU can be in one of 4 operating modes:

- Operating mode STOP
- Operating mode START-UP
- Operating mode RUN
- Operating mode HALT

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

### Operating mode STOP

- The application program is not processed.
- If there has been a processing before, the values of counters, timers, flags and the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RUN-LED off
- STOP-LED on

### Operating mode START-UP

- During the transition from STOP to RUN a call is issued to the start-up organization block OB 100. The processing time for this OB is not monitored. The START-UP OB may issue calls to other blocks.
- All digital outputs are disabled during the START-UP, i.e. outputs are inhibited.
- RUN-LED blinks as soon as the OB 100 is operated and for at least 3s, even if the start-up time is shorter or the CPU gets to STOP due to an error. This indicates the start-up.
- STOP-LED off
When the CPU has completed the START-UP OB, it assumes the operating mode RUN.

**Operating mode RUN**

- The application program in OB 1 is processed in a cycle. Under the control of alarms other program sections can be included in the cycle.
- All timers and counters being started by the program are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RUN-LED on
- STOP-LED off

**Operating mode HOLD**

The CPU offers up to 3 breakpoints to be defined for program diagnosis. Setting and deletion of breakpoints happens in your programming environment. As soon as a breakpoint is reached, you may process your program step by step.

**Precondition**

For the usage of breakpoints, the following preconditions have to be fulfilled:

- Testing in single step mode is possible with STL. If necessary switch the view via ‘View ➔ STL’ to STL.
- The block must be opened online and must not be protected.

**Approach for working with breakpoints**

1. Activate ‘View ➔ Breakpoint Bar’.
2. Set the cursor to the command line where you want to insert a breakpoint.
3. Set the breakpoint with ‘Debug ➔ Set Breakpoint’.
   - The according command line is marked with a circle.
4. To activate the breakpoint click on ‘Debug ➔ Breakpoints Active’.
   - The circle is changed to a filled circle.
5. Bring your CPU into RUN.
   - When the program reaches the breakpoint, your CPU switches to the state HOLD, the breakpoint is marked with an arrow and the register contents are monitored.
6. Now you may execute the program code step by step via ‘Debug ➔ Execute Next Statement’ or run the program until the next breakpoint via ‘Debug ➔ Resume’.
7. Delete (all) breakpoints with the option ‘Debug ➔ Delete All Breakpoints’.

**Behaviour in operating state HOLD**

- The RUN-LED blinks and the STOP-LED is on.
- The execution of the code is stopped. No level is further executed.
- All times are frozen.
- The real-time clock runs is just running.
- The outputs were disabled (BASP is activated).
- Configured CP connections remain exist.
The usage of breakpoints is always possible. Switching to the operating mode test operation is not necessary. With more than 2 breakpoints, a single step execution is not possible.

5.11.2 Function security

The CPUs include security mechanisms like a Watchdog (100ms) and a parameterizable cycle time surveillance (parameterizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state. The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN → STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>Voltage outputs</td>
<td>Voltage outputs issue 0V</td>
</tr>
<tr>
<td></td>
<td>Current outputs</td>
<td>Current outputs 0...20mA issue 0mA</td>
</tr>
<tr>
<td></td>
<td>Current outputs</td>
<td>Current outputs 4...20mA issue 4mA</td>
</tr>
<tr>
<td></td>
<td>If configured also substitute values may be issued.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>decentral outputs</td>
<td>Same behaviour as the central digital/analog outputs.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP → RUN res. PowerON</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIO → Read PII → OB 1.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are once be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>RUN</td>
<td>general</td>
<td>The program execution happens cyclically and can therefore be foreseen: Read PII → OB 1 → Write PIO.</td>
</tr>
</tbody>
</table>

PII: Process image inputs, PIO: Process image outputs

5.12 Overall reset

Overview

During the overall reset the entire user memory is erased. Data located in the memory card is not affected. If you have assigned IP address data to your PROFINET IO controller, these remain until there is a new PowerON.
You have 2 options to initiate an overall reset:

- initiate the overall reset by means of the operating mode switch
- initiate the overall reset by means of the Siemens SIMATIC Manager

You should always issue an overall reset to your CPU before loading an application program into your CPU to ensure that all blocks have been cleared from the CPU.

Precondition

- The operating mode of the CPU is to be switched to STOP. For this switch the operating mode switch of the CPU to “STOP”.
  - The STOP-LED is on.

Overall reset

1. Switch the operating mode switch to MRES position for about 3 seconds.
   - The STOP-LED changes from blinking to permanently on.

2. Place the operating mode switch in the position STOP and switch it to MRES and quickly back to STOP within a period of less than 3 seconds.
   - The STOP-LED blinks (overall reset procedure).

3. The overall reset has been completed when the STOP-LED is on permanently.
   - The STOP-LED is on. The following figure illustrates the above procedure:
Overall reset by means of the Siemens SIMATIC Manager

- Precondition: The operating mode of the CPU is to be switched to STOP. You may place the CPU in STOP by the menu command ‘PLC ➔ Operating mode’.

- Overall reset: You may request the overall reset by means of the menu command ‘PLC ➔ Clean/Reset’. In the dialog window you may place your CPU in STOP state and start the overall reset if this has not been done as yet. The STOP-LED blinks during the overall reset procedure. When the STOP-LED is on permanently the overall reset procedure has been completed.

Automatic reload

If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC.

→ The MC LED is on. When the reload has been completed the LED expires. The operating mode of the CPU will be STOP respectively RUN, depending on the position of the operating mode switch.

Reset to factory setting

The Reset to factory setting deletes completely the internal RAM of the CPU and resets this to delivery state. Please regard that the MPI address is also set back to default 2! ☑ Chapter 5.14 ‘Reset to factory setting’ on page 65

5.13 Firmware update

Overview

- There is the opportunity to execute a firmware update for the CPU and its components via MMC. For this an accordingly prepared MMC must be in the CPU during the startup.

- So a firmware files can be recognized and assigned with startup, a pkg file name is reserved for each updateable component an hardware release, which begins with "px" and differs in a number with six digits. The pkg file name of every updateable component may be found at a label right down the front flap of the module.

- After PowerON and CPU STOP the CPU checks if there is a *.pkg file on the MMC. If this firmware version is different to the existing firmware version, this is indicated by blinking of the LEDs and the firmware may be installed by an update request.
Latest firmware at www.vipa.com

The latest firmware versions are to be found in the service area at www.vipa.com. For example the following files are necessary for the firmware update of the CPU 315-4PN12 and its components with hardware release 1:

- 315-4PN12, Hardware release 1: Px000152.pkg
- PROFIBUS DP-Master: Px000062.pkg
- PROFINET IO controller: Px000072.pkg

**CAUTION!**

When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Display the Firmware version of the SPEED7 system via Web Site

The CPU has an integrated website that monitors information about firmware version of the SPEED7 components. The Ethernet PG/OP channel provides the access to this web site. The CPU has an integrated website that monitors information about firmware version of the SPEED7 components. The Ethernet PG/OP channel provides the access to this web site. ‘PLC ➔ Assign Ethernet Address’. After that you may access the PG/OP channel with a web browser via the IP address of the project engineering. ◄ Chapter 5.10 ‘Access to the internal Web page’ on page 57

Load firmware and transfer it to MMC

- Go to www.vipa.com
- Click on ‘Service ➔ Download ➔ Firmware’.
- Navigate via ‘System 300S ➔ CPU’ to your CPU and download the zip file to your PC.
- Extract the zip file and copy the extracted pkg files to your MMC.

**CAUTION!**

With a firmware update an overall reset is automatically executed. If your program is only available in the load memory of the CPU it is deleted! Save your program before executing a firmware update! After the firmware update you should execute a “Set back to factory settings”. ◄ Chapter 5.14 ‘Reset to factory setting’ on page 65
Transfer firmware from MMC into CPU

1. Switch the operating mode switch of your CPU in position STOP. Turn off the voltage supply. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC shows that at least a more current firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating mode switch downwards to MRES within 10s.

4. During the update process, the LEDs SF and FC are alternately blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, ST, SF, FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FC flash after a short start-up period. Continue with point 3.

   ⇒ If the LEDs do not flash, the firmware update is ready. Now a factory reset should be executed (see next page). After that the CPU is ready for duty.

5.14 Reset to factory setting

Proceeding

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state.

Please note that here also the IP address of the Ethernet PG/OP channel is set to 0.0.0.0 and the MPI address is reset to the address 2!

A reset to factory setting may also be executed by the MMC-Cmd FACTORY_RESET. \(\text{Chapter 5.18 ‘MMC-Cmd - Auto commands’ on page 69}\)

1. Switch the CPU to STOP.

2. Push the operating mode switch down to position MRES for 30s. Here the STOP-LED flashes. After a few seconds the stop LED changes to static light. Now the STOP LED changes between static light and flashing. Starting here count the static light states.
3. After the 6. static light release the operating mode switch and tip it downwards to MRES. Now the RUN LED lights up once. This means that the RAM was deleted completely.

4. For the confirmation of the resetting procedure the LEDs PW, ST, SF, FC and MC get ON. If not, the factory reset has failed and only an overall reset was executed. In this case you can repeat the procedure. A factory reset can only be executed if the stop LED has static light for exactly 6 times.

5. The end of factory reset is shown by static light of the LEDs PW, ST, SF, FC and MC. Switch the power supply off and on.

The proceeding is shown in the following Illustration:

---

5.15 Slot for storage media

**Overview**

At the front of the CPU there is a slot for storage media. As external storage medium for applications and firmware you may use a multi-media card (MMC).

You can cause the CPU to load a project automatically respectively to execute a command file by means of pre-defined file names.

**Accessing the storage medium**

To the following times an access takes place on a storage medium:

- After overall reset
  - The CPU checks if there is a project S7PROG.WLD. If exists the project is automatically loaded.
  - The CPU checks if there is a project PROTECT.WLD with protected blocks. If exists the project is automatically loaded. These blocks are stored in the CPU until the CPU is reset to factory setting or an empty PROTECT.WLD is loaded.

---
After PowerON
- The CPU checks if there is a project AUTOLOAD.WLD. If exists an overall reset is established and the project is automatically loaded.
- The CPU checks if there is a command file with VIPA_CMD.MMC. If exists the command file is loaded and the containing instructions are executed.
- After PowerON and CPU STOP the CPU checks if there is a *.pkg file (firmware file). If exists this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

Once in STOP
- If a storage medium is put, which contains a command file VIPA_CMD.MMC, the command file is loaded and the containing instructions are executed.

5.16 Memory extension with MCC

Overview
There is the possibility to extend the work memory of the CPU. For this, a MCC memory extension card is available from VIPA. The MCC is a specially prepared MMC (MultiMedia Card). By plugging the MCC into the MCC slot and then an overall reset the according memory expansion is released. There may only one memory expansion be activated at one time. On the MCC there is the file memory.key. This file may not be altered or deleted. You may use the MCC also as "normal" MMC for storing your project.

Proceeding
To extend the memory, plug the MCC into the card slot at the CPU labelled with "MCC" and execute an overall reset.

If the memory expansion on the MCC exceeds the maximum extendible memory range of the CPU, the maximum possible memory of the CPU is automatically used. You may determine the recent memory extension via the integrated web page or with the Siemens SIMATIC Manager at Module Information - "Memory".

CAUTION!
Please regard that the MCC must remain plugged when you’ve executed the memory expansion at the CPU. Otherwise the CPU switches to STOP after 72 hours. The MCC cannot be exchanged with a MCC of the same memory configuration.
When the MCC memory configuration has been taken over you may find the diagnostic entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer, the SF LED is on and after 72 hours the CPU switches to STOP. A reboot is only possible after plugging-in the MCC again or after an overall reset.

The remaining time after pulling the MCC is always been shown with the parameter **MCC-Trial-Time** on the web page.

After re-plugging the MCC, the SF LED extinguishes and 0xE400 is entered into the diagnostic buffer. You may reset the memory configuration of your CPU to the initial status at any time by executing an overall reset without MCC.

### 5.17 Extended know-how protection

#### Overview

Besides the "standard" Know-how protection the SPEED7-CPUs from VIPA provide an "extended" know-how protection that serves a secure block protection for accesses of 3. persons.

#### Standard protection

The standard protection from Siemens transfers also protected blocks to the PG but their content is not displayed. But with according manipulation the Know-how protection is not guaranteed.

#### Extended protection

The "extended" know-how protection developed by VIPA offers the opportunity to store blocks permanently in the CPU. At the "extended" protection you transfer the protected blocks into a WLD-file named protect.wld. By plugging the MMC and following overall reset, the blocks in the protect.wld are permanently stored in the CPU. You may protect OBs, FBs and FCs. When back-reading the protected blocks into the PG, exclusively the block header are loaded. The block code that is to be protected remains in the CPU and cannot be read.

Create a new wld-file in your project engineering tool with "File ➔ Memory Card file ➔ New" and rename it to "protect.wld". Transfer the according blocks into the file by dragging them with the mouse from the project to the file window of protect.wld.

Transfer the file protect.wld to a MMC storage module, plug the MMC into the CPU and execute an overall reset with the following approach:

- Create a new wld-file in your project engineering tool with "File ➔ Memory Card file ➔ New" and rename it to "protect.wld".
- Transfer the according blocks into the file by dragging them with the mouse from the project to the file window of protect.wld.
- Transfer the file protect.wld to a MMC storage module, plug the MMC into the CPU and execute an overall reset with the following approach:

---

**Diagram:**

- **PC**
  - Blocks ➔ wld file
- **CPU**
  - Protect blocks with protect.wld
  - Transfer protect.wld to CPU with overall reset
- **OVERALL_RESET**
  - protected Blocks are located in the CPU

---
The overall reset stores the blocks in protect.wld permanently in the CPU protected from accesses of 3. persons.

**Protection behaviour**

Protected blocks are overwritten by a new protect.wld. Using a PG 3. persons may access protected blocks but only the block header is transferred to the PG. The block code that is to be protected remains in the CPU and cannot be read.

**Change respectively delete protected blocks**

Protected blocks in the RAM of the CPU may be substituted at any time by blocks with the same name. This change remains up to next overall reset. Protected blocks may permanently be overwritten only if these are deleted at the protect.wld before. By transferring an empty protect.wld from the MMC you may delete all protected blocks in the CPU.

**Usage of protected blocks**

Due to the fact that reading of a "protected" block from the CPU monitors no symbol labels it is convenient to provide the "block covers" for the end user. For this, create a project out of all protected blocks. Delete all networks in the blocks so that these only contain the variable definitions in the according symbolism.

### 5.18 MMC-Cmd - Auto commands

**Overview**

A *command* file at a MMC is automatically executed under the following conditions:

- CPU is in STOP and MMC is stuck
- After each PowerON

**Command file**

The *command* file is a text file, which consists of a command sequence to be stored as `vipa_cmd.mmc` in the root directory of the MMC. The file has to be started by CMD_START as 1. command, followed by the desired commands (no other text) and must be finished by CMD_END as last command.

Text after the last command CMD_END e.g. comments is permissible, because this is ignored. As soon as the command file is recognized and executed each action is stored at the MMC in the log file `logfile.txt`. In addition for each executed command a diagnostics entry may be found in the diagnostics buffer.
Please regard the command sequence is to be started with `CMD_START` and ended with `CMD_END`.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Diagnostics entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_START</td>
<td>In the first line CMD_START is to be located.</td>
<td>0xE801</td>
</tr>
<tr>
<td></td>
<td>There is a diagnostic entry if CMD_START is missing</td>
<td>0xE8FE</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Waits about 1 second.</td>
<td>0xE803</td>
</tr>
<tr>
<td>WEBPAGE</td>
<td>The current web page of the CPU is stored at the MMC as &quot;webpage.htm&quot;.</td>
<td>0xE804</td>
</tr>
<tr>
<td>LOAD_PROJECT</td>
<td>The function &quot;Overall reset and reload from MMC&quot; is executed. The wld file located after the command is loaded else &quot;s7prog.wld&quot; is loaded.</td>
<td>0xE805</td>
</tr>
<tr>
<td>SAVE_PROJECT</td>
<td>The recent project (blocks and hardware configuration) is stored as &quot;s7prog.wld&quot; at the MMC. If the file just exists it is renamed to &quot;s7prog.old&quot;. If your CPU is password protected so you have to add this as parameter. Otherwise there is no project written. Example: SAVE_PROJECT password</td>
<td>0xE806</td>
</tr>
<tr>
<td>FACTORY_RESET</td>
<td>Executes &quot;factory reset&quot;.</td>
<td>0xE807</td>
</tr>
<tr>
<td>SET_NETWORK</td>
<td>IP parameters for Ethernet PG/OP channel may be set by means of this command. The IP parameters are to be given in the order IP address, subnet mask and gateway in the format x.x.x.x each separated by a comma. Enter the IP address if there is no gateway used.</td>
<td>0xE80E</td>
</tr>
<tr>
<td>CMD_END</td>
<td>In the last line CMD_END is to be located.</td>
<td>0xE802</td>
</tr>
</tbody>
</table>

**Examples**

The structure of a command file is shown in the following. The corresponding diagnostics entry is put in parentheses.

**Example 1**

```plaintext
CMD_START
LOAD_PROJECT proj.wld
WAIT1SECOND
WEBPAGE
DIAGBUF
CMD_END
... arbitrary text ...
```

- Marks the start of the command sequence (0xE801)
- Execute an overall reset and load "proj.wld" (0xE805)
- Wait ca. 1s (0xE803)
- Store web page as "webpage.htm" (0xE804)
- Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
- Marks the end of the command sequence (0xE802)
- Text after the command CMD_END is not evaluated.
Example 2

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMD_START</td>
<td>Marks the start of the command sequence (0xE801)</td>
</tr>
<tr>
<td>LOAD_PROJECT proj2.wld</td>
<td>Execute an overall reset and load &quot;proj2.wld&quot; (0xE805)</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Wait ca. 1s (0xE803)</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Wait ca. 1s (0xE803)</td>
</tr>
<tr>
<td>SET_NETWORK 172.16.129.210,255.255.224.0,172.16.129.210</td>
<td>IP parameter(0xE80E)</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Wait ca. 1s (0xE803)</td>
</tr>
<tr>
<td>WAIT1SECOND</td>
<td>Wait ca. 1s (0xE803)</td>
</tr>
<tr>
<td>WEBPAGE</td>
<td>Store web page as &quot;webpage.htm&quot; (0xE804)</td>
</tr>
<tr>
<td>DIAGBUF</td>
<td>Store diagnostics buffer of the CPU as &quot;diagbuff.txt&quot; (0xE80B)</td>
</tr>
<tr>
<td>CMD_END</td>
<td>Marks the end of the command sequence (0xE802)</td>
</tr>
<tr>
<td>... arbitrary text ...</td>
<td>Text after the command CMD_END is not evaluated.</td>
</tr>
</tbody>
</table>

The parameters IP address, subnet mask and gateway may be received from the system administrator.

Enter the IP address if there is no gateway used.

5.19 VIPA specific diagnostic entries

Entries in the diagnostic buffer

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC Manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored at the memory card by means of the CMD DIAGBUF.

Every register of the module information is supported by the VIPA CPUs. More information may be found at the online help of the Siemens SIMATIC Manager.

Monitoring the diagnostic entries

To monitor the diagnostic entries you choose the option ‘PLC Module Information’ in the Siemens SIMATIC Manager. Via the register “Diagnostic Buffer” you reach the diagnostic window:
The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU. The following page shows an overview of the VIPA specific Event-IDs.

### Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0x115C   | Vendor-specific interrupt (OB 57) at EtherCAT  
OB: OB number (57)  
ZInfo1: Logical address of the slave, which has released the interrupt  
ZInfo2: Interrupt type  
ZInfo3: reserved |
| 0xE003   | Error on accessing the periphery  
ZInfo1: Periphery address  
ZInfo2: Slot |
| 0xE004   | Multiple parametrization of a periphery address  
ZInfo1: Periphery address  
ZInfo2: Slot |
| 0xE005   | Internal error - Please contact the VIPA Hotline! |
| 0xE006   | Internal error - Please contact the VIPA Hotline! |
| 0xE007   | Configured in-/output bytes do not fit into periphery area |
| 0xE008   | Internal error - Please contact the VIPA Hotline! |
| 0xE009   | Error on accessing the standard backplane bus |
| 0xE010   | There is a undefined module at the backplane bus  
ZInfo2: Slot  
ZInfo3: Type ID |
<p>| 0xE011   | Master project engineering at slave CPU not possible or wrong slave configuration |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE012</td>
<td>Error at parametrization</td>
</tr>
<tr>
<td>0xE013</td>
<td>Error at shift register access to standard bus digital modules</td>
</tr>
<tr>
<td>0xE014</td>
<td>Error at Check_Sys</td>
</tr>
</tbody>
</table>
| 0xE015   | Error at access to the master  
ZInfo2: Slot of the master (32=page frame master) |
| 0xE016   | Maximum block size at master transfer exceeded  
ZInfo1: Periphery address  
ZInfo2: Slot |
| 0xE017   | Error at access to integrated slave |
| 0xE018   | Error at mapping of the master periphery |
| 0xE019   | Error at standard back plane bus system recognition |
| 0xE01A   | Error at recognition of the operating mode (8 / 9 bit) |
| 0xE01B   | Error - maximum number of plug-in modules exceeded |
| 0xE020   | Error - interrupt information is not defined |
| 0xE030   | Error of the standard bus |
| 0xE033   | Internal error - Please contact the VIPA Hotline! |
| 0xE0B0   | SPEED7 is not stoppable  
(probably undefined BCD value at timer) |
| 0xE0C0   | Not enough space in work memory for storing code block (block size exceeded) |
| 0xE0CB   | Error at SSL access  
ZInfo1: 4=SSL wrong, 5=SubSSL wrong, 6=Index wrong  
ZInfo2: SSL-ID  
ZInfo3: Index |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xE0CC   | Communication error MPI / Serial  
|          | ZInfo1: Code  
|          | 1: Wrong priority  
|          | 2: Buffer overflow  
|          | 3: Frame format error  
|          | 4: Wrong SSL request (SSL-ID not valid)  
|          | 5: Wrong SSL request (SSL-SubID not valid)  
|          | 6: Wrong SSL request (SSL-Index not valid)  
|          | 7: Wrong value  
|          | 8: Wrong RetVal  
|          | 9: Wrong SAP  
|          | 10: Wrong connection type  
|          | 11: Wrong sequence number  
|          | 12: Faulty block number in the telegram  
|          | 13: Faulty block type in the telegram  
|          | 14: Inactive function  
|          | 15: Wrong size in the telegram  
|          | 20: Error writing to memory card  
|          | 90: Faulty buffer size  
|          | 98: unknown error  
|          | 99: internal error  
| 0xE0CD   | Error at DP-V1 job management  
| 0xE0CE   | Error: Timeout at sending of the i-slave diagnostics  
| 0xE0CF   | Timeout at loading of a new HW configuration (timeout: 39 seconds)  
| 0xE100   | Memory card access error  
| 0xE101   | Memory card error file system  
| 0xE102   | Memory card error FAT  
| 0xE104   | Memory card error at saving  
| 0xE200   | Memory card writing finished (Copy Ram2Rom)  
| 0xE210   | Memory card reading finished (reload after overall reset)  
| 0xE21E   | Memory card reading: Error at reload (after overall reset), file "Protect.wld" too big  
| 0xE21F   | Memory card reading: Error at reload (after overall reset), file read error, out of memory  
| 0xE300   | Internal flash writing finished (Copy Ram2Rom)  
| 0xE310   | Internal flash writing finished (reload after battery failure)  
| 0xE311   | Internal flash fx0000yy.wld file too big, load failure  

VIPA System 300S  
Deployment CPU 315-4PN12  
VIPA specific diagnostic entries
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xE400</td>
<td>Memory card with the option memory expansion was plugged</td>
</tr>
<tr>
<td>0xE401</td>
<td>Memory card with the option memory expansion was removed</td>
</tr>
<tr>
<td>0xE402</td>
<td>The PROFIBUS DP master functionality is disabled. The interface acts further as MPI interface</td>
</tr>
<tr>
<td>0xE403</td>
<td>The PROFIBUS DP slave functionality is disabled. The interface acts further as MPI interface</td>
</tr>
<tr>
<td>0xE500</td>
<td>Memory management: Deleted block without corresponding entry in Block List</td>
</tr>
<tr>
<td></td>
<td>ZInfo2: BlockType</td>
</tr>
<tr>
<td></td>
<td>ZInfo3: BlockNo</td>
</tr>
<tr>
<td>0xE604</td>
<td>Multiple parametrization of a periphery address for Ethernet PG/OP channel</td>
</tr>
<tr>
<td></td>
<td>ZInfo1: Periphery address</td>
</tr>
<tr>
<td></td>
<td>ZInfo3:</td>
</tr>
<tr>
<td></td>
<td>0: Periphery address is input, 1: Periphery address is output</td>
</tr>
<tr>
<td>0xE701</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE703</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE720</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE721</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xE801</td>
<td>CMD - Auto command: CMD_START recognized and successfully executed</td>
</tr>
<tr>
<td>0xE802</td>
<td>CMD - Auto command: CMD_End recognized and successfully executed</td>
</tr>
<tr>
<td>0xE803</td>
<td>CMD - Auto command: WAIT1SECOND recognized and successfully executed</td>
</tr>
<tr>
<td>0xE804</td>
<td>CMD - Auto command: WEBPAGE recognized and successfully executed</td>
</tr>
<tr>
<td>0xE805</td>
<td>CMD - Auto command: LOAD_PROJECT recognized and successfully executed</td>
</tr>
<tr>
<td>0xE806</td>
<td>CMD - Auto command: SAVE_PROJECT recognized and successfully executed</td>
</tr>
<tr>
<td>0xE807</td>
<td>CMD - Auto command: FACTORY_RESET recognized and successfully executed</td>
</tr>
<tr>
<td>0xE80B</td>
<td>CMD - Auto command: DIAGBUF recognized and successfully executed</td>
</tr>
<tr>
<td>0xE80E</td>
<td>CMD - Auto command: SET_NETWORK recognized and successfully executed</td>
</tr>
<tr>
<td>0xE8FB</td>
<td>CMD - Auto command: Error: Initialization of the Ethernet PG/OP channel by means of SET_NETWORK is faulty</td>
</tr>
<tr>
<td>0xE8FC</td>
<td>CMD - Auto command: Error: Some IP parameters missing in SET_NETWORK</td>
</tr>
<tr>
<td>0xE8FE</td>
<td>CMD - Auto command: Error: CMD_START missing</td>
</tr>
<tr>
<td>0xE8FF</td>
<td>CMD - Auto command: Error: Error while reading CMD file (memory card error)</td>
</tr>
<tr>
<td>0xE901</td>
<td>Check sum error</td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>0xEA00</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA01</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
</tr>
<tr>
<td>0xEA02</td>
<td>SBUS: Internal error (internal plugged sub module not recognized)  \ZInfo1: internal slot</td>
</tr>
</tbody>
</table>
| 0xEA03   | SBUS: Communication error CPU - PROFINET I/O controller:  \ZInfo1: Slot  \ZInfo2: Status  
(0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN) |
<p>| 0xEA04   | SBUS: Multiple parametrization of a periphery address  \ZInfo1: Periphery address  \ZInfo2: Slot  \ZInfo3: Data width |
| 0xEA05   | Internal error - Please contact the VIPA Hotline!                                                                                          |
| 0xEA07   | Internal error - Please contact the VIPA Hotline!                                                                                          |
| 0xEA08   | SBUS: Parametrized input data width unequal to plugged input data width  \ZInfo1: Parametrized input data width  \ZInfo2: Slot  \ZInfo3: Input data width of the plugged module |
| 0xEA09   | SBUS: Parametrized output data width unequal to plugged output data width  \ZInfo1: Parametrized output data width  \ZInfo2: Slot  \ZInfo3: Output data width of the plugged module |
| 0xEA10   | SBUS: Input periphery address outside the periphery area  \ZInfo1: Periphery address  \ZInfo2: Slot  \ZInfo3: Data width |
| 0xEA11   | SBUS: Output periphery address outside the periphery area  \ZInfo1: Periphery address  \ZInfo2: Slot  \ZInfo3: Data width |
| 0xEA12   | SBUS: Error at writing record set  \ZInfo1: Slot  \ZInfo2: Record set number  \ZInfo3: Record set length |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEA14   | SBUS: Multiple parametrization of a periphery address (diagnostics address)  
ZInfo1: Periphery address  
ZInfo2: Slot  
ZInfo3: Data width |
| 0xEA15   | Internal error - Please contact the VIPA Hotline! |
| 0xEA18   | SBUS: Error at mapping of the master periphery  
ZInfo2: Slot of the master |
| 0xEA19   | Internal error - Please contact the VIPA Hotline! |
| 0xEA20   | Error - RS485 interface is not pre-set to PROFIBUS DP master bus a PROFIBUS DP master is configured. |
| 0xEA21   | Error - Configuration RS485 interface X2/X3:  
PROFIBUS DP master is configured but missing  
ZInfo2: Interface x |
| 0xEA22   | Error - RS485 interface X2 - Value exceeds the limits  
ZInfo: Configured value of X2 |
| 0xEA23   | Error - RS485 interface X3 - Value exceeds the limits  
ZInfo: Configured value of X3 |
| 0xEA24   | Error - Configuration RS485 interface X2/X3:  
Interface/protocol missing, default settings are used  
ZInfo2: Configured value for X2  
ZInfo3: Configured value for X3 |
| 0xEA30   | Internal error - Please contact the VIPA Hotline! |
| 0xEA40   | Internal error - Please contact the VIPA Hotline! |
| 0xEA41   | Internal error - Please contact the VIPA Hotline! |
| 0xEA50   | Error - PROFINET configuration  
ZInfo1: User slot of the PROFINET I/O controller  
ZInfo2: IO-Device-No.  
ZInfo3: IO-Device slot |
| 0xEA51   | Error - there is no PROFINET IO controller at the configured slot  
ZInfo1: User slot of the PROFINET I/O controller  
ZInfo2: Recognized ID at the configured slot |
| 0xEA53   | Error - PROFINET configuration - There are too many PROFINET IO devices configured  
ZInfo1: Number of configured devices  
ZInfo2: Slot  
ZInfo3: Maximum possible number of devices |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEA54   | Error - PROFINET IO controller reports multiple parametrization of a periphery address  
ZInfo1: Periphery address  
ZInfo2: User slot of the PROFINET I/O controller  
ZInfo3: Data width |
| 0xEA61 ... 0xEA63 | Internal error - Please contact the VIPA Hotline! |
| 0xEA64   | PROFINET/EtherCAT CP  
Configuration error: Zinfo1:  
Bit 0: too many devices  
Bit 1: too many devices per ms  
Bit 2: too many input bytes per ms  
Bit 3: too many output bytes per ms  
Bit 4: too many input bytes per device  
Bit 5: too many output bytes per device  
Bit 6: too many productive connections  
Bit 7: too many input bytes in the process image  
Bit 8: too many output bytes in the process image  
Bit 9: Configuration not available  
Bit 10: Configuration not valid  
Bit 11: Cycle time too small  
Bit 12: Cycle time too big  
Bit 13: Not valid device number  
Bit 14: CPU is configured as I device  
Bit 15: Obtain an IP address in a different way is not supported for the IP address of the controller |
| 0xEA65   | Internal error - Please contact the VIPA Hotline! |
| 0xEA66   | PROFINET IO controller  
Error in communication stack  
PK: Rackslot  
OBNr: StackError.Service  
DatId: StackError.DeviceRef  
ZInfo1: StackError.Error.Code  
ZInfo2: StackError.Error.Detail  
ZInfo3: StackError.Error.AdditionalDetail  
<< 8 + StackError.Error.AreaCode |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
<th>PK: Error type</th>
<th>OBNo: PROFINET IO controller slot</th>
<th>DatId: Device-No.</th>
<th>ZInfo1: Record set number</th>
<th>ZInfo2: Record set handle</th>
<th>ZInfo3: Internal error code for service purposes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xEA67</td>
<td>Error - PROFINET IO controller - reading record set</td>
<td>0: DATA_RECORD_ERROR_LOCAL 1: DATA_RECORD_ERROR_STACK 2: DATA_RECORD_ERROR_REMOTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0xEA68</td>
<td>Error - PROFINET IO controller - writing record set</td>
<td>0: DATA_RECORD_ERROR_LOCAL 1: DATA_RECORD_ERROR_STACK 2: DATA_RECORD_ERROR_REMOTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0xEA69</td>
<td>Internal error - Please contact the VIPA Hotline!</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0xEA6A</td>
<td>PROFINET IO controller</td>
<td>Service error in communication stack</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0xEA6B</td>
<td>PROFINET IO controller</td>
<td>Vendor ID mismatch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event-ID</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 0xEA6C   | PROFINET IO controller  
Device ID mismatch  
PK: Rackslot  
OBNo: PLC Mode  
DatId: 0  
ZInfo1: Device ID  
ZInfo2: -  
ZInfo3: - |
| 0xEA6D   | PROFINET IO controller  
No empty name  
PK: Rackslot  
OBNo: PLC Mode  
DatId: 0  
ZInfo1: Device ID  
ZInfo2: -  
ZInfo3: - |
| 0xEA6E   | PROFINET IO controller  
RPC response missing  
PK: Rackslot  
OBNo: PLC Mode  
DatId: 0  
ZInfo1: Device ID  
ZInfo2: -  
ZInfo3: - |
| 0xEA6F   | PROFINET IO controller  
PN module mismatch  
PK: Rackslot  
OBNo: PLC-Mode  
DatId: 0  
ZInfo1: Device ID  
ZInfo2: -  
ZInfo3: - |
| 0xEA97   | Storage error SBUS service channel  
ZInfo3 = Slot |
<p>| 0xEA98   | Timeout at waiting for reboot of a SBUS module (server) |
| 0xEA99   | Error at file reading via SBUS |</p>
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEAA0   | Emac Error occurred  
OBNo: current PLC mode  
ZInfo1: Diagnostics address of the master / controller  
ZInfo2:  
0: None Rx queue is full  
1: No send buffer available  
2: Send stream was cut off; sending failed  
3: Exhausted retries  
4: No receive buffer available in Emac DMA  
5: Emac DMA transfer aborted  
6: Queue overflow  
7: Unexpected frame received  
ZInfo3: Number of errors, which occurred |
| 0xEAB0   | Link mode not valid  
OBNo: current PLC mode  
ZInfo1: Diagnostics address master / controller  
ZInfo2: Current LinkMode  
0x01: 10Mbit full-duplex  
0x02: 100Mbit half-duplex  
0x03: 100Mbit full-duplex  
0x05: 10Mbit half-duplex  
0xFF: Link mode not defined |
| 0xEB03   | SLIO error on IO mapping |
| 0xEB10   | SLIO error: Bus error  
ZInfo1: Type of error  
0x82: ErrorAlarm |
| 0xEB20   | SLIO error: Interrupt information undefined |
| 0xEB21   | SLIO error on accessing the configuration data |
## Event-ID | Description
--- | ---
0xEC03 | EtherCAT: configuration error
  - ZInfo1: Errorcode
    1: NUMBER_OF_SLAVES_NOT_SUPPORTED
    2: SYSTEM_IO_NR_INVALID
    3: INDEX_FROM_SLOT_ERROR
    4: MASTER_CONFIG_INVALID
    5: MASTER_TYPE_ERROR
    6: SLAVE_DIAG_ADDR_INVALID
    7: SLAVE_ADDR_INVALID
    8: SLAVE_MODULE_IO_CONFIG_INVALID
    9: LOG_ADDR_ALREADY_IN_USE
   10: NULL_PTR_CHECK_ERROR
   11: IO_MAPPING_ERROR
   12: ERROR

0xEC04 | EtherCAT: multiple configuration of a periphery address
  - ZInfo1: Periphery address
  - ZInfo2: Slot

0xEC10 | EtherCAT: restoration bus with its slaves
  - OB start Info (Local data) StartEvent and Eventclass: 0xEC10
  - DatID:
    0xXXYY:
    - XX=0x54 with input address in ZInfo1,
    - XX=0x55 with output address.
    - YY=0x00 Station not available,
    - YY=0x01 Station available (process data)
  - ZInfo1: 0xXXYY (XX=OldState, YY=NewState)
  - ZInfo2: Diagnostics address of the master
  - ZInfo3: Number of stations, which are not in the same state as the master (> 0)

0xEC11 | EtherCAT: restoration bus with missing slaves
  - OB start Info (Local data) StartEvent and Eventclass: 0xEC11
  - DatID:
    0xXXYY:
    - XX=0x54 with input address in ZInfo1,
    - XX=0x55 with output address.
    - YY=0x00 Station not available,
    - YY=0x01 Station available (process data)
  - ZInfo1: 0xXXYY (XX=OldState, YY=NewState)
  - ZInfo2: Diagnostics address of the master
  - ZInfo3: Number of stations, which are not in the same state as the master (> 0)
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xEC12   | EtherCAT: restoration slave  
OB start Info (Local data) StartEvent and Eventclass: 0xEC12  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics of the Station  
ZInfo3: AIStatusCode |
| 0xEC30   | EtherCAT: topology OK  
OB start Info (Local data) StartEvent and Eventclass: 0xEC30  
ZInfo2: Diagnostics address of the master |
| 0xEC50   | EtherCAT: DC not in Sync  
ZInfo1: Diagnostics address of the master |
| 0xED10   | EtherCAT: bus failure  
OB start Info (Local data) StartEvent and Eventclass: 0xED10  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics address of the master  
ZInfo3: Number of stations, which are not in the same state as the master |
| 0xED12   | EtherCAT: failure slave  
OB start Info (Local data) StartEvent and Eventclass: 0xED12  
DatID:  
0xXXYY:  
XX=0x54 with input address in ZInfo1,  
XX=0x55 with output address.  
YY=0x00 Station not available,  
YY=0x01 Station available (process data)  
ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
ZInfo2: Diagnostics of the Station  
ZInfo3: AIStatusCode |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED20  | EtherCAT: bus state change without calling OB86  
  OB start Info (Local data) StartEvent and Eventclass: 0xED20  
  DatID:  
  0xXXYY:  
  XX=0x54 with input address in ZInfo1,  
  XX=0x55 with output address.  
  YY=0x00 Station not available,  
  YY=0x01 Station available (process data)  
  ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
  ZInfo2: Diagnostics address of the master  
  ZInfo3: Number of stations, which are not in the same state as the master |
| 0xED21  | EtherCAT: error in bus state change  
  OB: 0x00  
  PK: 0x00  
  DatID:  
  0xXXYY:  
  XX=0x54 with input address in ZInfo1,  
  XX=0x55 with output address.  
  YY=0x00 Station not available,  
  YY=0x01 Station available (process data)  
  ZInfo1: 0xXXYY (XX = current state, YY = expected state)  
  ZInfo2: Diagnostics address of the master  
  ZInfo3: ErrorCode:  
  0x0008: Busy  
  0x000B: Invalid Parameter  
  0x000E: Invalid State  
  0x0010: Timeout |
| 0xED22  | EtherCAT: bus state change without calling OB86  
  OB start Info (Local data) StartEvent and Eventclass: 0xED22  
  DatID:  
  0xXXYY:  
  XX=0x54 with input address in ZInfo1,  
  XX=0x55 with output address.  
  YY=0x00 Station not available,  
  YY=0x01 Station available (process data)  
  ZInfo1: 0xXXYY (XX=OldState, YY=NewState)  
  ZInfo2: Diagnostics of the Station  
  ZInfo3: AlStatusCode |
<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED30   | EtherCAT: Topology Mismatch  
OB start Info (Local data) StartEvent and Eventclass: 0xED30  
ZInfo2: Diagnostics address of the master |
| 0xED31   | EtherCAT: Interrupt Queue Overflow  
OB start Info (Local data) StartEvent and Eventclass: 0xED31  
ZInfo2: Diagnostics address of the master |
| 0xED40 ... 0xED4F | Internal error - Please contact the VIPA Hotline! |
| 0xED50   | EtherCAT: DC not in Sync  
ZInfo1: Diagnostics address of the master |
| 0xED60   | EtherCAT: Diagnostics buffer CP:  
Slave state change  
PK: 0  
OB: PLC-Mode  
DatID 1/2: 0  
ZInfo1: 0x00YY:  
YY: new EtherCAT state of the slave  
ZInfo 2: EtherCAT station address  
ZInfo3: AlStatusCode (EtherCAT specific error code) |
| 0xED61   | EtherCAT: Diagnostics buffer CP:  
CoE emergency  
PK: EtherCAT station address (low byte)  
OB: EtherCAT station address (high byte)  
DatID 1/2: Error code  
ZInfo1: 0xYYZZ:  
YY: Error register  
ZZ: MEF byte 1  
ZInfo 2: 0xYYZZ:  
YY: MEF byte 2  
ZZ: MEF byte 3  
ZInfo3: 0xYYZZ:  
YY: MEF byte 4  
ZZ: MEF byte 5 |
### Event-ID Description

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xED62   | EtherCAT: Diagnostics buffer CP:  
Error on SDO access during state change  
PK: EtherCAT station address (low byte)  
OB: EtherCAT station address (high byte)  
DatID 1/2: Subindex  
ZInfo1: Index  
ZInfo 2: SDO error code (high word)  
ZInfo3: SDO error code (low word) |
| 0xED70   | EtherCAT: Diagnostics buffer CP:  
Twice HotConnect group found  
PK: 0  
OB: PLC-Mode  
DatID 1/2: 0  
ZInfo1: Diagnostics address of the master  
ZInfo 2: EtherCAT station address  
ZInfo3: 0 |
| 0xEE00   | Additional information at UNDEF_OPCODE |
| 0xEE01   | Internal error - Please contact the VIPA Hotline! |
| 0xEEEE   | CPU was completely overall reset, since after PowerON the start-up could not be finished. |
| 0xEF11 ... 0xEF13 | Internal error - Please contact the VIPA Hotline! |
| 0xEFFF   | Internal error - Please contact the VIPA Hotline! |

PK: C-Source module number | DatID: Line number

---

### 5.20 Control and monitoring of variables with test functions

#### Overview

For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item **Debug** of the Siemens SIMATIC Manager.

The status of the operands and the RLO can be displayed by means of the test function **Debug ➔ Monitor**.

You can modify and/or display the status of variables by means of the test function **PLC ➔ Monitor/Modify Variables**.

#### ‘Debug ➔ Monitor’

This test function displays the current status and the RLO of the different operands while the program is being executed.

It is also possible to enter corrections to the program.
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump commands or by timer and process-related alarms. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation RLO
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a “?”.

The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer.

This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program-execution.

This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

Control of outputs

It is possible to check the wiring and proper operation of output modules.

You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

Control of variables

The following variables may be modified: I, Q, M, T, C and D.

The process image of binary and digital operands is modified independently of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence of the program.
6 Deployment PtP communication

6.1 Fast introduction

General
The CPU has a PROFIBUS/PtP interface with a fix pinout. After an overall reset the interface is deactivated. By appropriate configuration the PtP function (point to point) can be enabled:

- PtP functionality
  - Using the PtP functionality the RS485 interface is allowed to connect via serial point-to-point connection to different source res. target systems.
  - The activation of the PtP functionality happens by embedding the SPEEDBUS.GSD from VIPA in the hardware catalog. After the installation the CPU may be configured in a PROFIBUS master system and here the interface may be switched to PtP communication.

Protocols
The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus are supported.

Parametrization
The parametrization of the serial interface happens during runtime using the FC/SFC 216 (SER_CFG). For this you have to store the parameters in a DB for all protocols except ASCII.

Communication
The FCs/SFCs are controlling the communication. Send takes place via FC/SFC 217 (SER_SND) and receive via FC/SFC 218 (SER_RCV). The repeated call of the FC/SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RetVal that contains, among other things, recent information about the acknowledgement of the partner station. The protocols USS and Modbus allow to evaluate the receipt telegram by calling the FC/SFC 218 SER_RCV after SER_SND. The FCs/SFCs are included in the consignment of the CPU.

Overview FCs/SFCs for serial communication
The following FCs/SFCs are used for the serial communication:

<table>
<thead>
<tr>
<th>FC/SFC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC/SFC 216</td>
<td>SER_CFG</td>
</tr>
<tr>
<td>FC/SFC 217</td>
<td>SER_SND</td>
</tr>
<tr>
<td>FC/SFC 218</td>
<td>SER_RCV</td>
</tr>
</tbody>
</table>
6.2 Principle of the data transfer

Overview

The data transfer is handled during runtime by using FC/SFCs. The principle of data transfer is the same for all protocols and is shortly illustrated in the following:

- Data, which are written into the according data channel by the CPU, is stored in a FIFO send buffer (first in first out) with a size of 2x1024byte and then put out via the interface.
- When the interface receives data, this is stored in a FIFO receive buffer with a size of 2x1024byte and can there be read by the CPU.
- If the data is transferred via a protocol, the embedding of the data to the according protocol happens automatically.
- In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus require the acknowledgement of the partner.
- An additional call of the FC/SFC 217 SER_SND causes a return value in RetVal that includes among others recent information about the acknowledgement of the partner.
- Further on for USS and Modbus after a SER_SND the acknowledgement telegram must be evaluated by a call of the FC/SFC 218 SER_RCV.

RS485 PtP communication

<table>
<thead>
<tr>
<th>Program</th>
<th>Protocol</th>
<th>FIFO Buffer</th>
<th>Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>SER_RCV FC/SFC 218</td>
<td>RECEIVE</td>
<td>IN 1024Byte</td>
<td>RS485</td>
</tr>
<tr>
<td>SER_CFG FC/SFC 216</td>
<td>CFG</td>
<td>1024Byte</td>
<td></td>
</tr>
<tr>
<td>SER_SND FC/SFC 217</td>
<td>SEND</td>
<td>OUT 1024Byte</td>
<td></td>
</tr>
</tbody>
</table>

6.3 Deployment of RS485 interface for PtP

Switch to PtP operation

Per default, the RS485 interface is deactivated. Via hardware configuration the RS485 interfaces may be switched to ptp operation (point to point) via the parameter Function RS485 of the Properties.

Requirements

Since the VIPA specific CPU parameters may be set, the installation of the SPEEDBUS.GSD from VIPA in the hardware catalog is necessary. The CPU may be configured in a PROFINET master system and the appropriate parameters may be set after installation.

Installation of the SPEEDBUS.GSD

The GSD (Geräte-Stamm-Datei) is online available in the following language versions. Further language versions are available on inquires.
The GSD files may be found at www.vipa.com at the "Service" part.
The integration of the SPEEDBUS.GSD takes place with the following proceeding:

1. Browse to www.vipa.com
2. Click to 'Service ➔ Download ➔ GSD- and EDS-Files ➔ Profibus'
3. Download the file Cx000023_Vxxx.
4. Extract the file to your work directory. The SPEEDBUS.GSD is stored in the directory VIPA_System_300S.
5. Start the hardware configurator from Siemens.
6. Close every project.
7. Select 'Options ➔ Install new GSD-file'.
8. Navigate to the directory VIPA_System_300S and select SPEEDBUS.GSD.

The SPEED7 CPUs and modules of the System 300S from VIPA may now be found in the hardware catalog at PROFIBUS-DP / Additional field devices / I/O / VIPA_SPEEDBUS.

The embedding of the CPU 315-4PN12 happens by means of a virtual PROFIBUS master system with the following approach:

1. Perform a hardware configuration for the CPU ➔ Chapter 5.4 'Hardware configuration - CPU' on page 42
2. Configure always as last module a Siemens DP master CP 342-5 (342-5DA02 V5.0). Connect and parameterize it at operation mode "DP-Master".
3. Connect the slave system "VIPA_SPEEDbus". After installing the SPEEDBUS.GSD this may be found in the hardware catalog at PROFIBUS DP / Additional field devices / I/O / VIPA / VIPA_SPEEDBUS.
4. For the slave system set the PROFIBUS address 100.
5. Configure at slot 0 the VIPA CPU 315-4PN12 of the hardware catalog from VIPA_SPEEDbus.
6. By double clicking the placed CPU 315-4PN12 the properties dialog of the CPU may be opened.

As soon as the project is transferred together with the PLC user program to the CPU, the parameters will be taken after start-up.

The hardware configuration, which is shown here, is only required, if you want to customize the VIPA specific parameters.
**Setting PtP parameters**

1. By double clicking the CPU 315-4PN12 placed in the slave system the properties dialog of the CPU may be opened.

2. Switch the Parameter ‘Function RS485 X3’ to ‘PtP’.

**Properties RS485**

- Logical states represented by voltage differences between the two cores of a twisted pair cable
- Serial bus connection in two-wire technology using half duplex mode
- Data communications up to a max. distance of 500m
- Data communication rate up to 115.2kbaud

**PtP interface X3**

**9pin SubD jack**

<table>
<thead>
<tr>
<th>Pin</th>
<th>RS485</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n.c.</td>
</tr>
<tr>
<td>2</td>
<td>M24V</td>
</tr>
<tr>
<td>3</td>
<td>RxD/TxD-P (Line B)</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
</tr>
<tr>
<td>5</td>
<td>M5V</td>
</tr>
<tr>
<td>6</td>
<td>P5V</td>
</tr>
<tr>
<td>7</td>
<td>P24V</td>
</tr>
<tr>
<td>8</td>
<td>RxD/TxD-N (Line A)</td>
</tr>
<tr>
<td>9</td>
<td>n.c.</td>
</tr>
</tbody>
</table>
6.4 Parametrization

6.4.1 FC/SFC 216 - SER_CFG

**Description**

The parametrization happens during runtime deploying the FC/SFC 216 (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS and Modbus in a DB.

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROTOCOL</td>
<td>IN</td>
<td>BYTE</td>
<td>1=ASCII, 2=STX/ETX, 3=3964R</td>
</tr>
<tr>
<td>PARAMETER</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to protocol-parameters</td>
</tr>
<tr>
<td>BAUDRATE</td>
<td>IN</td>
<td>BYTE</td>
<td>Number of baudrate</td>
</tr>
<tr>
<td>CHARLEN</td>
<td>IN</td>
<td>BYTE</td>
<td>0=5bit, 1=6bit, 2=7bit, 3=8bit</td>
</tr>
<tr>
<td>PARITY</td>
<td>IN</td>
<td>BYTE</td>
<td>0=Non, 1=Odd, 2=Even</td>
</tr>
<tr>
<td>STOPBITS</td>
<td>IN</td>
<td>BYTE</td>
<td>1=1bit, 2=1.5bit, 3=2bit</td>
</tr>
<tr>
<td>FLOWCONTROL</td>
<td>IN</td>
<td>BYTE</td>
<td>1 (fix)</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

All time settings for timeouts must be set as hexadecimal value. Find the Hex value by multiply the wanted time in seconds with the baudrate.

Example:
Wanted time 8ms at a baudrate of 19200 baud
Calculation: $19200 \text{bit/s} \times 0.008 \text{s} \approx 154 \text{bit} \rightarrow (9Ah)$
Hex value is 9Ah.

**PROTOCOL**

Here you fix the protocol to be used.
You may choose between:
1: ASCII
2: STX/ETX
3: 3964R
4: USS Master
5: Modbus RTU Master
6: Modbus ASCII Master

**PARAMETER (as DB)**

At ASCII protocol, this parameter is ignored.
At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the communication parameters and has the following structure for the according protocols:

**Data block at STX/ETX**

<table>
<thead>
<tr>
<th>DBB0:</th>
<th>STX1</th>
<th>BYTE</th>
<th>(1. Start-ID in hexadecimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBB1:</td>
<td>STX2</td>
<td>BYTE</td>
<td>(2. Start-ID in hexadecimal)</td>
</tr>
<tr>
<td>DBB2:</td>
<td>ETX1</td>
<td>BYTE</td>
<td>(1. End-ID in hexadecimal)</td>
</tr>
<tr>
<td>DBB3:</td>
<td>ETX2</td>
<td>BYTE</td>
<td>(2. End-ID in hexadecimal)</td>
</tr>
<tr>
<td>DBW4:</td>
<td>TIMEOUT</td>
<td>WORD</td>
<td>(max. delay time between 2 telegrams)</td>
</tr>
</tbody>
</table>

*The start res. end sign should always be a value <20, otherwise the sign is ignored!*
*With not used IDs please always enter FFh!*

**Data block at 3964R**

<table>
<thead>
<tr>
<th>DBB0:</th>
<th>Prio</th>
<th>BYTE</th>
<th>(The priority of both partners must be different)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBB1:</td>
<td>ConnAttmptNr</td>
<td>BYTE</td>
<td>(Number of connection trials)</td>
</tr>
<tr>
<td>DBB2:</td>
<td>SendAttmptNr</td>
<td>BYTE</td>
<td>(Number of telegram retries)</td>
</tr>
<tr>
<td>DBB4:</td>
<td>CharTimeout</td>
<td>WORD</td>
<td>(Char. delay time)</td>
</tr>
<tr>
<td>DBW6:</td>
<td>ConfTimeout</td>
<td>WORD</td>
<td>(Acknowledgement delay time)</td>
</tr>
</tbody>
</table>
### Data block at USS

**DBW0**: Timeout WORD (Delay time)

### Data block at Modbus master

**DBW0**: Timeout WORD (Respond delay time)

### BAUDRATE

**Velocity of data transfer in bit/s (baud)**

<table>
<thead>
<tr>
<th>Value</th>
<th>Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>04h</td>
<td>1200 baud</td>
</tr>
<tr>
<td>05h</td>
<td>1800 baud</td>
</tr>
<tr>
<td>06h</td>
<td>2400 baud</td>
</tr>
<tr>
<td>07h</td>
<td>4800 baud</td>
</tr>
<tr>
<td>08h</td>
<td>7200 baud</td>
</tr>
<tr>
<td>09h</td>
<td>9600 baud</td>
</tr>
<tr>
<td>0Ah</td>
<td>14400 baud</td>
</tr>
<tr>
<td>0Bh</td>
<td>19200 baud</td>
</tr>
<tr>
<td>0Ch</td>
<td>38400 baud</td>
</tr>
<tr>
<td>0Dh</td>
<td>57600 baud</td>
</tr>
<tr>
<td>0Eh</td>
<td>115200 baud</td>
</tr>
</tbody>
</table>

### CHARLEN

**Number of data bits where a character is mapped to.**

<table>
<thead>
<tr>
<th>Value</th>
<th>Number of bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5bit</td>
</tr>
<tr>
<td>1</td>
<td>6bit</td>
</tr>
<tr>
<td>2</td>
<td>7bit</td>
</tr>
<tr>
<td>3</td>
<td>8bit</td>
</tr>
</tbody>
</table>

### PARITY

The parity is -depending on the value- even or odd. For parity control, the information bits are extended with the parity bit, that amends via its value ("0" or "1") the value of all bits to a defined status. If no parity is set, the parity bit is set to "1", but not evaluated.

<table>
<thead>
<tr>
<th>Value</th>
<th>Parity</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>NONE</td>
</tr>
<tr>
<td>1</td>
<td>ODD</td>
</tr>
<tr>
<td>2</td>
<td>EVEN</td>
</tr>
</tbody>
</table>

### STOPBITS

The stop bits are set at the end of each transferred character and mark the end of a character.

<table>
<thead>
<tr>
<th>Value</th>
<th>Stop bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1bit</td>
</tr>
<tr>
<td>2</td>
<td>1.5bit</td>
</tr>
<tr>
<td>3</td>
<td>2bit</td>
</tr>
</tbody>
</table>

### FLOWCONTROL

The parameter FLOWCONTROL is ignored. When sending RTS=1, when receiving RTS=0.

### RETVAL FC/SFC 216 (Return values)

Return values send by the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>809Ah</td>
<td>Interface not found e. g. interface is used by PROFIBUS In the VIPA SLIO CPU and FeatureSet PTP_NO only the ASCII protocol is configurable. If another protocol is selected the FC/SFC216 also leave with this error code.</td>
</tr>
</tbody>
</table>
### Error code Description

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8x24h</td>
<td>Error at FC/SFC-Parameter x, with x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at PROTOCOL</td>
</tr>
<tr>
<td></td>
<td>2: Error at PARAMETER</td>
</tr>
<tr>
<td></td>
<td>3: Error at BAUDRATE</td>
</tr>
<tr>
<td></td>
<td>4: Error at CHARLENGTH</td>
</tr>
<tr>
<td></td>
<td>5: Error at PARITY</td>
</tr>
<tr>
<td></td>
<td>6: Error at STOPBITS</td>
</tr>
<tr>
<td></td>
<td>7: Error at FLOWCONTROL</td>
</tr>
<tr>
<td>809xh</td>
<td>Error in FC/SFC parameter value x, where x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at PROTOCOL</td>
</tr>
<tr>
<td></td>
<td>3: Error at BAUDRATE</td>
</tr>
<tr>
<td></td>
<td>4: Error at CHARLENGTH</td>
</tr>
<tr>
<td></td>
<td>5: Error at PARITY</td>
</tr>
<tr>
<td></td>
<td>6: Error at STOPBITS</td>
</tr>
<tr>
<td></td>
<td>7: Error at FLOWCONTROL</td>
</tr>
<tr>
<td>8092h</td>
<td>Access error in parameter DB (DB too short)</td>
</tr>
<tr>
<td>828xh</td>
<td>Error in parameter x of DB parameter, where x:</td>
</tr>
<tr>
<td></td>
<td>1: Error 1. parameter</td>
</tr>
<tr>
<td></td>
<td>2: Error 2. parameter...</td>
</tr>
</tbody>
</table>

### 6.5 Communication

#### 6.5.1 Overview

The communication happens via the send and receive blocks FC/SFC 217 (SER_SND) and FC/SFC 218 (SER_RCV). The FCs/SFCs are included in the consignment of the CPU.

#### 6.5.2 FC/SFC 217 - SER_SND

**Description**

This block sends data via the serial interface.

The repeated call of the FC/SFC 217 SER_SND delivers a return value for 3964R, USS and Modbus via RETVAL that contains, among other things, recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by calling the FC/SFC 218 SER_RCV after SER_SND.
Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATAPTR</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for sending data</td>
</tr>
<tr>
<td>DATALEN</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of data sent</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

DATAPTR

Here you define a range of the type Pointer for the send buffer where the data to be sent are stored. You have to set type, start and length.

Example:

Data is stored in DB5 starting at 0.0 with a length of 124byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DATALEN

Word where the number of the sent Bytes is stored.

At ASCII if data were sent by means of FC/SFC 217 faster to the serial interface than the interface sends, the length of data to send could differ from the DATALEN due to a buffer overflow. This should be considered by the user program.

With STX/ETX, 3964R, Modbus and USS always the length set in DATAPTR is stored or 0.

RETVAL FC/SFC 217 (Return values)

Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>Send data - ready</td>
</tr>
<tr>
<td>1000h</td>
<td>Nothing sent (data length 0)</td>
</tr>
<tr>
<td>20xxh</td>
<td>Protocol executed error free with xx bit pattern for diagnosis</td>
</tr>
<tr>
<td>7001h</td>
<td>Data is stored in internal buffer - active (busy)</td>
</tr>
<tr>
<td>7002h</td>
<td>Transfer - active</td>
</tr>
<tr>
<td>80xxh</td>
<td>Protocol executed with errors with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
<tr>
<td>90xxh</td>
<td>Protocol not executed with xx bit pattern for diagnosis (no acknowledgement by partner)</td>
</tr>
</tbody>
</table>
| 8x24h      | Error in FC/SFC parameter x, where x:
| 1: Error in DATAPTR |
| 2: Error in DATALEN |
| 8122h      | Error in parameter DATAPTR (e.g. DB too short) |
| 807Fh      | Internal error |
| 809Ah      | interface not found e.g. interface is used by PRO-FIBUS |
| 809Bh      | interface not configured |
### Protocol specific RETVAL values

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
</tbody>
</table>

### STX/ETX

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
<tr>
<td>9004h</td>
<td>Character not allowed</td>
</tr>
</tbody>
</table>

### 3964R

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>80FFh</td>
<td>NAK received - error in communication</td>
</tr>
<tr>
<td>80FEh</td>
<td>Data transfer without acknowledgement of partner or error at acknowledgement</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (0byte)</td>
</tr>
</tbody>
</table>

### USS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready without error</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong start sign in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2byte)</td>
</tr>
</tbody>
</table>
### Modbus RTU/ASCII Master

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000h</td>
<td>Send ready (positive slave respond)</td>
</tr>
<tr>
<td>2001h</td>
<td>Send ready (negative slave respond)</td>
</tr>
<tr>
<td>8080h</td>
<td>Receive buffer overflow (no space for receipt)</td>
</tr>
<tr>
<td>8090h</td>
<td>Acknowledgement delay time exceeded</td>
</tr>
<tr>
<td>80F0h</td>
<td>Wrong checksum in respond</td>
</tr>
<tr>
<td>80FDh</td>
<td>Length of respond too long</td>
</tr>
<tr>
<td>80FEh</td>
<td>Wrong function code in respond</td>
</tr>
<tr>
<td>80FFh</td>
<td>Wrong slave address in respond</td>
</tr>
<tr>
<td>9000h</td>
<td>Buffer overflow (no data send)</td>
</tr>
<tr>
<td>9001h</td>
<td>Data too long (&gt;1024 byte)</td>
</tr>
<tr>
<td>9002h</td>
<td>Data too short (&lt;2 byte)</td>
</tr>
</tbody>
</table>

### Principles of programming

The following text shortly illustrates the structure of programming a send command for the different protocols.

3964R
This block receives data via the serial interface. Using the FC/SFC 218 SER_RCV after SER_SND with the protocols USS and Modbus the acknowledgement telegram can be read.
**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATAPTR</td>
<td>IN</td>
<td>ANY</td>
<td>Pointer to Data Buffer for received data</td>
</tr>
<tr>
<td>DATALEN</td>
<td>OUT</td>
<td>WORD</td>
<td>Length of received data</td>
</tr>
<tr>
<td>ERROR</td>
<td>OUT</td>
<td>WORD</td>
<td>Error Number</td>
</tr>
<tr>
<td>RETVAL</td>
<td>OUT</td>
<td>WORD</td>
<td>Return value (0 = OK)</td>
</tr>
</tbody>
</table>

**DATAPTR**

Here you set a range of the type Pointer for the receive buffer where the reception data is stored. You have to set type, start and length.

Example:
Data is stored in DB5 starting at 0.0 with a length of 124 byte.
DataPtr:=P#DB5.DBX0.0 BYTE 124

**DATALEN**

Word where the number of received Bytes is stored.
At **STX/ETX** and **3964R**, the length of the received user data or 0 is entered.
At **ASCII**, the number of read characters is entered. This value may be different from the read telegram length.

**ERROR**

This word gets an entry in case of an error.
The following error messages may be created depending on the protocol:

**ASCII**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overrun</td>
<td>Overflow, a sign couldn’t be read fast enough from the interface</td>
</tr>
<tr>
<td>1</td>
<td>framing error</td>
<td>Error that shows that a defined bit frame is not coincident, exceeds the allowed length or contains an additional bit sequence (Stop bit error)</td>
</tr>
<tr>
<td>2</td>
<td>parity</td>
<td>Parity error</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full</td>
</tr>
</tbody>
</table>

**STX/ETX**

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
<tr>
<td>1</td>
<td>char</td>
<td>A sign outside the range 20h ... 7Fh has been received.</td>
</tr>
<tr>
<td>3</td>
<td>overflow</td>
<td>Buffer is full.</td>
</tr>
</tbody>
</table>
3964R / Modbus RTU/ASCII Master

<table>
<thead>
<tr>
<th>Bit</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>overflow</td>
<td>The received telegram exceeds the size of the receive buffer.</td>
</tr>
</tbody>
</table>

Return values of the block:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000h</td>
<td>no error</td>
</tr>
<tr>
<td>1000h</td>
<td>Receive buffer too small (data loss)</td>
</tr>
<tr>
<td>8x24h</td>
<td>Error at FC/SFC-Parameter x, with x:</td>
</tr>
<tr>
<td></td>
<td>1: Error at DATAPTR</td>
</tr>
<tr>
<td></td>
<td>2: Error at DATALEN</td>
</tr>
<tr>
<td></td>
<td>3: Error at ERROR</td>
</tr>
<tr>
<td>8122h</td>
<td>Error in parameter DATAPTR (e.g. DB too short)</td>
</tr>
<tr>
<td>809Ah</td>
<td>Serial interface not found res. interface is used by PROFIBUS</td>
</tr>
<tr>
<td>809Bh</td>
<td>Serial interface not configured</td>
</tr>
</tbody>
</table>
The following picture shows the basic structure for programming a receive command. This structure can be used for all protocols.

---

6.6 Protocols and procedures

**Overview**

The CPU supports the following protocols and procedures:

- ASCII communication
- STX/ETX
- 3964R
- USS
- Modbus

**ASCII**

ASCII data communication is one of the simple forms of data exchange. Incoming characters are transferred 1 to 1. At ASCII, with every cycle the read FC/SFC is used to store the data that is in the buffer at request time in a parameterized receive data block. If a telegram is spread over various cycles, the data is overwritten. There is no reception acknowledgement. The communication procedure has to be controlled by the concerning user application. An according Receive_ASCII FB may be found within the VIPA library in the service area of www.vipa.com.

**STX/ETX**

STX/ETX is a simple protocol with start and end ID, where STX stands for Start of Text and ETX for End of Text.
Any data transferred from the periphery must be preceded by a Start followed by the data characters and the end character. Depending on the byte width, the following ASCII characters can be transferred: 5bit: not allowed; 6bit: 20...3Fh, 7bit: 20...7Fh, 8bit: 20...FFh.

The effective data, which includes all the characters between Start and End, are transferred to the CPU when the End has been received.

When data is sent from the CPU to a peripheral device, any user data is handed to the FC/SFC 217 (SER_SND) and is transferred with added Start- and End-ID to the communication partner.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID.

If no End-ID is defined, all read characters are transferred to the CPU after a parameterizable character delay time (Timeout).

As Start-res. End-ID all Hex values from 01h to 1Fh are permissible. Characters above 1Fh are ignored. In the user data, characters below 20h are not allowed and may cause errors. The number of Start- and End-IDs may be different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not used start and end characters you have to enter FFh in the hardware configuration.

*Message structure:*

```
| STX1 | STX2 | Z1 | Z2 | Zn | ETX1 | ETX2 |
```

3964

The 3964R procedure controls the data transfer of a point-to-point link between the CPU and a communication partner. The procedure adds control characters to the message data during data transfer. These control characters may be used by the communication partner to verify the complete and error-free receipt.

The procedure employs the following control characters:

- **STX:** Start of Text
- **DLE:** Data Link Escape
- **ETX:** End of Text
- **BCC:** Block Check Character
- **NAK:** Negative Acknowledge

You may transfer a maximum of 255 byte per message.

*Procedure*

```
Active partner          Passive partner

STX                      Monitor delayed acknowledgment
DLE                      DLE
Message-data              ETX
DLE                      BCC
Monitor delayed acknowledgment
DLE
```
When a DLE is transferred as part of the information it is repeated to distinguish between data characters and DLE control characters that are used to establish and to terminate the connection (DLE duplication). The DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the communication partner. When communication partners issue simultaneous send commands, the station with the lower priority will delay its send command.

**USS**

The USS protocol (Universelle serielle Schnittstelle = universal serial interface) is a serial transfer protocol defined by Siemens for the drive and system components. This allows to build-up a serial bus connection between a superordinated master and several slave systems. The USS protocol enables a time cyclic telegram traffic by presetting a fix telegram length.

The following features characterize the USS protocol:

- Multi point connection
- Master slave access procedure
- Single master system
- Max. 32 participants
- Simple and secure telegram frame

It is essential:

- You may connect 1 master and max. 31 slaves at the bus
- The single slaves are addressed by the master via an address sign in the telegram.
- The communication happens exclusively in half-duplex operation.
- After a send command, the acknowledgement telegram must be read by a call of the FC/SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

### Master slave telegram

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>STW</th>
<th>HSW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
</tr>
</tbody>
</table>

### Slave master telegram

<table>
<thead>
<tr>
<th>STX</th>
<th>LGE</th>
<th>ADR</th>
<th>PKE</th>
<th>IND</th>
<th>PWE</th>
<th>ZSW</th>
<th>HIW</th>
<th>BCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>02h</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
<td>H</td>
<td>L</td>
</tr>
</tbody>
</table>
A request can be directed to a certain slave or be send to all slaves as broadcast message. For the identification of a broadcast message you have to set bit 5 to 1 in the ADR byte. Here the slave addr. (bit 0 ... 4) is ignored. In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via FC/SFC 218 SER_RCV. Only write commands may be sent as broadcast.

**Broadcast with set bit 5 in ADR byte**

<table>
<thead>
<tr>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

Broadcast

**Modbus**

- The Modbus protocol is a communication protocol that fixes a hierarchic structure with one master and several slaves.
- Physically, Modbus works with a serial half-duplex connection. There are no bus conflicts occurring, because the master can only communicate with one slave at a time.
- After a request from the master, this waits for a preset delay time for an answer of the slave. During the delay time, communication with other slaves is not possible.
- After a send command, the acknowledgement telegram must be read by a call of the FC/SFC 218 SER_RCV.
- The request telegrams send by the master and the respond telegrams of a slave have the following structure:

**Telegram structure**

<table>
<thead>
<tr>
<th>Start sign</th>
<th>Slave address</th>
<th>Function Code</th>
<th>Data</th>
<th>Flow control</th>
<th>End sign</th>
</tr>
</thead>
</table>

**Broadcast with slave address = 0**

- A request can be directed to a special slave or at all slaves as broadcast message.
- To mark a broadcast message, the slave address 0 is used.
- In opposite to a "normal" send command, the broadcast does not require a telegram evaluation via FC/SFC 218 SER_RCV.
- Only write commands may be sent as broadcast.
### ASCII, RTU mode

Modbus offers 2 different transfer modes. The mode selection happens during runtime by using the FC/SFC 216 SER_CFG.

- **ASCII mode**: Every byte is transferred in the 2 sign ASCII code. The data are marked with a start and an end sign. This causes a transparent but slow transfer.
- **RTU mode**: Every byte is transferred as one character. This enables a higher data pass through as the ASCII mode. Instead of start and end sign, a time control is used.

### Supported Modbus protocols

The following Modbus Protocols are supported by the RS485 interface:

- Modbus RTU Master
- Modbus ASCII Master

### 6.7 Modbus - Function codes

#### Naming convention

Modbus has some naming conventions:

<table>
<thead>
<tr>
<th>Bit =</th>
<th>IN: &quot;Input Status&quot;</th>
<th>OUT: &quot;Coil Status&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coil</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word =</th>
<th>IN: &quot;Input Register&quot;</th>
<th>OUT: &quot;Holding Register&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Modbus differentiates between bit and word access; bits = "Coils" and words = "Register".
- Bit inputs are referred to as "Input-Status" and bit outputs as "Coil-Status".
- Word inputs are referred to as "Input-Register" and word outputs as "Holding-Register".

#### Range definitions

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x and 4x.

- 0x and 1x gives you access to digital bit areas and 3x and 4x to analog word areas.

For the CPs from VIPA is not differentiating digital and analog data, the following assignment is valid:

- **0x** - Bit area for master output data
  - Access via function code 01h, 05h, 0Fh
- **1x** - Bit area for master input data
  - Access via function code 02h
- **3x** - word area for master input data
  - Access via function code 04h
- **4x** - word area for master output data
  - Access via function code 03h, 06h, 10h
A description of the function codes follows below.

**Overview**

With the following Modbus function codes a Modbus master can access a Modbus slave: With the following Modbus function codes a Modbus master can access a Modbus slave. The description always takes place from the point of view of the master:

<table>
<thead>
<tr>
<th>Code</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01h</td>
<td>Read n bits</td>
<td>Read n bits of master output area 0x</td>
</tr>
<tr>
<td>02h</td>
<td>Read n bits</td>
<td>Read n bits of master input area 1x</td>
</tr>
<tr>
<td>03h</td>
<td>Read n words</td>
<td>Read n words of master output area 4x</td>
</tr>
<tr>
<td>04h</td>
<td>Read n words</td>
<td>Read n words of master input area 3x</td>
</tr>
<tr>
<td>05h</td>
<td>Write 1 bit</td>
<td>Write 1 bit to master output area 0x</td>
</tr>
<tr>
<td>06h</td>
<td>Write 1 word</td>
<td>Write 1 word to master output area 4x</td>
</tr>
<tr>
<td>0Fh</td>
<td>Write n bits</td>
<td>Write n bits to master output area 0x</td>
</tr>
<tr>
<td>10h</td>
<td>Write n words</td>
<td>Write n words to master output area 4x</td>
</tr>
</tbody>
</table>

**Point of View of "Input" and "Output" data**

The description always takes place from the point of view of the master. Here data, which were sent from master to slave, up to their target are designated as "output" data (OUT) and contrary slave data received by the master were designated as "input" data (IN).

**Respond of the slave**

If the slave announces an error, the function code is send back with an "ORed" 80h.
Without an error, the function code is sent back.

Slave answer:  
- Function code OR 80h → Error
- Function code → OK

<table>
<thead>
<tr>
<th>Byte sequence in a word</th>
<th>1 word</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High-byte</td>
</tr>
</tbody>
</table>

Check sum CRC, RTU, LRC  
The shown check sums CRC at RTU and LRC at ASCII mode are automatically added to every telegram. They are not shown in the data block.

Read n bits 01h, 02h  
- Code 01h: Read n bits of master output area 0x
- Code 02h: Read n bits of master input area 1x

Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read bytes</th>
<th>Data 1. byte</th>
<th>Data 2. byte</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td></td>
<td>1word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>max. 250byte</td>
</tr>
</tbody>
</table>

Read n words 03h, 04h  
- 03h: Read n words of master output area 4x
04h: Read n words master input area 3x

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Number of read bytes</th>
<th>Data 1. word</th>
<th>Data 2. word</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td></td>
<td>1word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>max. 125words</td>
</tr>
</tbody>
</table>

**Write 1 bit 05h**

Code 05h: Write 1 bit to master output area 0x
A status change is via "Status bit" with following values:
"Status bit" = 0000h → Bit = 0
"Status bit" = FF00h → Bit = 1

**Command telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address bit</th>
<th>Status bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

**Respond telegram**

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address bit</th>
<th>Status bit</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>
### Write 1 word 06h

Code 06h: Write 1 word to master output area 4x

#### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

#### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address word</th>
<th>Value word</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

### Write n bits 0Fh

Code 0Fh: Write n bits to master output area 0x

Please regard that the number of bits has additionally to be set in byte.

#### Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Number of bytes</th>
<th>Data 1. byte</th>
<th>Data 2. byte</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
<td>1byte</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>max. 250byte</td>
</tr>
</tbody>
</table>

#### Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. bit</th>
<th>Number of bits</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>
Write n words 10h

Code 10h: Write n words to master output area 4x

Command telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. word</th>
<th>Number of words</th>
<th>Number of bytes</th>
<th>Data 1. word</th>
<th>Data 2. word</th>
<th>...</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

max. 125words

Respond telegram

<table>
<thead>
<tr>
<th>Slave address</th>
<th>Function code</th>
<th>Address 1. word</th>
<th>Number of words</th>
<th>Check sum CRC/LRC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1byte</td>
<td>1byte</td>
<td>1word</td>
<td>1word</td>
<td>1word</td>
</tr>
</tbody>
</table>

6.8 Modbus - Example communication

Overview

The example establishes a communication between a master and a slave via Modbus. The following combination options are shown:
- CPU 31xS as Modbus RTU master
- CPU 21xSER-1 as Modbus RTU slave
- Siemens SIMATIC Manager and possibilities for the project transfer
- Modbus cable connection

Approach

1. Assemble a Modbus system consisting of a CPU 31xS as Modbus master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

2. Execute the project engineering of the master! For this you create a PLC user application with the following structure:
   - OB 100: Call SFC 216 (configuration as Modbus RTU master) with timeout setting and error evaluation.
   - OB 1: Call SFC 217 (SER_SND) where the data is send with error evaluation. Here you have to build up the telegram according to the Modbus rules. Call SFC 218 (SER_RECV) where the data is received with error evaluation.
3. Execute the project engineering of the slave! The PLC user application at the slave has the following structure:

- **OB 100:**
  Call SFC 216 (configuration as Modbus RTU slave) with timeout setting and Modbus address in the DB and error evaluation.

- **OB 1:**
  Call SFC 217 (SER_SND) for data transport from the slave CPU to the output buffer. Call SFC 218 (SER_RECV) for the data transport from the input buffer to the CPU. Allow an according error evaluation for both directions.

Structure for the according PLC programs for master and slave:
7 Deployment PROFIBUS communication

7.1 Overview

PROFIBUS DP

- PROFIBUS is an international standard applicable to an open and serial field bus for building, manufacturing and process automation that can be used to create a low (sensor-/actuator level) or medium (process level) performance network of programmable logic controllers.
- PROFIBUS comprises an assortment of compatible versions. The following details refer to PROFIBUS DP.
- PROFIBUS DP is a special protocol intended mainly for automation tasks in a manufacturing environment. DP is very fast, offers Plug’n’Play facilities and provides a cost-effective alternative to parallel cabling between PLC and remote I/O. PROFIBUS DP was designed for high-speed data communication on the sensor-actuator level.
- The data transfer referred to as "Data Exchange" is cyclical. During one bus cycle, the master reads input values from the slaves and writes output information to the slaves.

CPU with DP master

- The PROFIBUS DP master is to be configured in the hardware configurator from Siemens. Therefore the configuration happens by the sub module X1 (MPI/DP) of the Siemens CPU.
- After the transmission of the data to the CPU, the configuration data are internally passed on to the PROFIBUS master part.
- During the start-up the DP master automatically includes his data areas into the address range of the CPU. Project engineering in the CPU is not required.

Deployment of the DP master with CPU

- Via the PROFIBUS DP master PROFIBUS DP slaves may be coupled to the CPU. The DP master communicates with the DP slaves and links up its data areas with the address area of the CPU.
- At every POWER ON res. overall reset the CPU fetches the I/O mapping data from the master. At DP slave failure, the ER-LED is on and the OB 86 is requested. If this is not available, the CPU switches to STOP and BASP is set. As soon as the BASP signal comes from the CPU, the DP master is setting the outputs of the connected periphery to zero. The DP master remains in the operating mode RUN independent from the CPU.

DP slave operation

- For the deployment in a super-ordinated master system you first have to project your slave system as Siemens CPU in slave operation mode with configured in-/output areas. Afterwards you configure your master system. Couple your slave system to your master system by dragging the CPU 31x from the hardware catalog at Configured stations onto the master system, choose your slave system and connect it.

7.2 Fast introduction

Overview

- The PROFIBUS DP master is to be configured in the hardware configurator. Here the configuration happens by means of the sub module X1 (DP) of the Siemens CPU.
Steps of configuration

For the configuration of the PROFIBUS DP master please follow the following approach:

- Hardware configuration - CPU
- Deployment as DP master or Deployment as DP slave
- Transfer of the complete project to CPU

To be compatible to the Siemens SIMATIC Manager, the CPU 315-4PN12 from VIPA is to be configured as CPU 315-2PN/DP (315-2EH13-0AB00 V2.6)

The integrated PROFIBUS DP master (X3) is to be configured and connected via the sub module X1 (DP). The Ethernet PG/OP channel of the 315-4PN12 is always to be configured as 1. module after the really plugged modules at the standard bus as CP343-1 (343-1EX11) from Siemens.

7.3 Hardware configuration - CPU

Precondition

The configuration of the CPU takes place at the Siemens ‘hardware configurator’. The hardware configurator is part of the Siemens SIMATIC Manager. It serves for project engineering. The modules, which may be configured here are listed in the hardware catalog. If necessary you have to update the hardware catalog with ‘Options ➔ Update Catalog’.

For project engineering a thorough knowledge of the Siemens SIMATIC Manager and the Siemens hardware configurator is required.

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. This may cause conflicts in applications that presume an unmodified ACCU 2.

For more information may be found in the manual "VIPA Operation list SPEED7" at "Differences between SPEED7 and 300V programming".

Proceeding

To be compatible with the Siemens SIMATIC Manager the following steps should be executed:

1. ➔ Start the Siemens hardware configurator with a new project.
2. ➔ Insert a profile rail from the hardware catalog.
3. ➔ Place at ‘Slot’-Number 2 the CPU 315-2 PN/DP (315-2EH13 V2.6).
4. The integrated PROFIBUS DP master (X3) is to be configured and connected via the sub module X1 (MPI/DP). In the operation mode PROFIBUS the CPU may further more be accessed via the MPI interface (X2) with address 2 und 187.5kbit/s.

5. The PROFINET IO controller is to be configured via the sub module ‘X2 PN-IO’.

7.4 Deployment as PROFIBUS DP master

Precondition
The hardware configuration described before was established.

Proceeding

1. Open the properties dialog of the DP interface of the CPU by means of a double-click at ‘MPI/DP’.
2. Set Interface type to "PROFIBUS"
3. Connect to PROFIBUS and preset an address (preferably 2) and confirm with [OK].
4. Switch at Operating mode to "DP master" and confirm the dialog with [OK]. A PROFIBUS DP master system is inserted.

A PROFIBUS DP master system is inserted:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU ...</td>
</tr>
<tr>
<td>X1</td>
<td>MPI/DP</td>
</tr>
<tr>
<td>X...</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

Now the project engineering of your PROFIBUS DP master is finished. Please link up now your DP slaves with periphery to your DP master.

1. For the project engineering of PROFIBUS DP slaves you search the concerning PROFIBUS DP slave in the hardware catalog and drag&drop it in the subnet of your master.
2. Assign a valid PROFIBUS address to the DP slave.
3. Link up the modules of your DP slave system in the plugged sequence and add the addresses that should be used by the modules.
4. If needed, parameterize the modules.
5. Save, compile and transfer your project.
7.5 Deployment as PROFIBUS DP slave

Fast introduction

In the following the deployment of the PROFIBUS section as "intelligent" DP slave on master system is described, which exclusively may be configured in the Siemens SIMATIC Manager. The following steps are required:

1. Configure a station with a CPU with operating mode DP slave.
2. Connect to PROFIBUS and configure the in-/output area for the slave section.
3. Save and compile your project.
4. Configure another station with another CPU with operating mode DP master.
5. Connect to PROFIBUS and configure the in-/output ranges for the master section.
6. Save, compile and transfer your project to your CPU.

Project engineering of the slave section

1. Start the Siemens SIMATIC Manager and configure a CPU as described at "Hardware configuration - CPU".
2. Designate the station as "...DP slave".
3. Add your modules according to the real hardware assembly.
4. Open the properties dialog of the DP interface of the CPU by means of a double-click at 'MPI/DP'.
5. Set Interface type to "PROFIBUS".
6. Connect to PROFIBUS and preset an address (e.g. 3) and confirm with [OK].
7. Switch at Operating mode to "DP slave".
8. Via Configuration you define the in-/output address area of the slave CPU, which are to be assigned to the DP slave.
9. Save, compile and transfer your project to your CPU.
Slave section

<table>
<thead>
<tr>
<th>Standard bus</th>
<th>Object properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot</td>
<td>Module</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
| 2 | CPU ...
| X1 | MPI/DP |
| X... | ...
| 3 | ...
| 4 | ...
| 5 | Modules |
| 6 | ...

Operating mode: DP slave
Connect: PROFIBUS
PROFIBUS address: > 1

Project engineering of the master section

- Insert another station and configure a CPU.
- Designate the station as "...DP master".
- Add your modules according to the real hardware assembly.
- Open the properties dialog of the DP interface of the CPU by means of a double-click at 'MPI/DP'.
- Set Interface: type to "PROFIBUS".
- Connect to PROFIBUS and preset an address (e.g. 2) and confirm with [OK].
- Switch at Operating mode to "DP master" and confirm the dialog with [OK].
- Connect your slave system to this master system by dragging the "CPU 31x" from the hardware catalog at Configured stations onto the master system and select your slave system to be coupled.
- Open the Configuration at Object properties of your slave system.
- Via double click to the according configuration line you assign the according input address area on the master CPU to the slave output data and the output address area to the slave input data.
- Save, compile and transfer your project to your CPU.

Master section

<table>
<thead>
<tr>
<th>Standard bus</th>
<th>Object properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot</td>
<td>Module</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
| 2 | CPU ...
| X1 | MPI/DP |
| X... | ...
| 3 | ...
| 4 | ...
| 5 | Modules |
| 6 | ...

DP master system

Hardware catalog: CPU 31x from configured stations

Operating mode: DP master
Connect: PROFIBUS
PROFIBUS address: > 1

Configuration:
Input area slave CPU = Output area master-CPU
Output area slave CPU = Input area Master-CPU
7.6 PROFIBUS installation guidelines

PROFIBUS in general
- A PROFIBUS DP network may only be built up in linear structure.
- PROFIBUS DP consists of minimum one segment with at least one master and one slave.
- A master has always been deployed together with a CPU.
- PROFIBUS supports max. 126 participants.
- Per segment a max. of 32 participants is permitted.
- The max. segment length depends on the transfer rate:
  - 9.6 ... 187.5 bit/s → 1000m
  - 500 kbit/s → 400m
  - 1.5 Mbit/s → 200m
  - 3 ... 12 Mbit/s → 100m
- Max. 10 segments may be built up. The segments are connected via repeaters. Every repeater counts for one participant.
- The bus respectively a segment is to be terminated at both ends.
- All participants are communicating with the same transfer rate. The slaves adjust themselves automatically on the transfer rate.

Transfer medium
- As transfer medium PROFIBUS uses an isolated twisted-pair cable based upon the RS485 interface.
- The RS485 interface is working with voltage differences. Though it is less irritable from influences than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure.
- Max. 32 participants per segment are permitted. Within a segment the members are linear connected. The segments are connected via repeaters. The maximum segment length depends on the transfer rate.
- PROFIBUS DP uses a transfer rate between 9.6 kbit/s and 12 Mbit/s, the slaves are following automatically. All participants are communicating with the same transfer rate.
- The bus structure under RS485 allows an easy connection res. disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or is new in the network.

Bus connection
- The following picture illustrates the terminating resistors of the respective start and end station.
The PROFIBUS line has to be terminated with its ripple resistor. Please make sure to terminate the last participants on the bus at both ends by activating the terminating resistor.

**EasyConn bus connector**

In PROFIBUS all participants are wired parallel. For that purpose, the bus cable must be feed-through. Via the order number 972-0DP10 you may order the bus connector "EasyConn". This is a bus connector with switchable terminating resistor and integrated bus diagnostic.

<table>
<thead>
<tr>
<th>Dimensions in mm</th>
<th>0°</th>
<th>45°</th>
<th>90°</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>64</td>
<td>61</td>
<td>66</td>
</tr>
<tr>
<td>B</td>
<td>34</td>
<td>53</td>
<td>40</td>
</tr>
<tr>
<td>C</td>
<td>15.8</td>
<td>15.8</td>
<td>15.8</td>
</tr>
</tbody>
</table>
To connect this EasyConn plug, please use the standard PROFIBUS cable type A (EN50170). Starting with release 5 you also can use highly flexible bus cable:
Lapp Kabel order no: 2170222, 2170822, 2170322.

With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool that makes the connection of the Easy-Conn much easier.

Dimensions in mm

**Termination with "Easy-Conn"**

The "EasyConn" bus connector is provided with a switch that is used to activate a terminating resistor.

**Wiring**

[1] 1./last bus participant
[2] further participants

**CAUTION!**

The terminating resistor is only effective, if the connector is installed at a bus participant and the bus participant is connected to a power supply.

The tightening torque of the screws to fix the connector to a device must not exceed 0.02Nm!

A complete description of installation and deployment of the terminating resistors is delivered with the connector.
Assembly

1. Loosen the screw.
2. Lift contact-cover.
3. Insert both wires into the ducts provided (watch for the correct line colour as below!)
4. Please take care not to cause a short circuit between screen and data lines!
5. Close the contact cover.
6. Tighten screw (max. tightening torque 0.08Nm).

The green line must be connected to A, the red line to B!

7.7 Commissioning and Start-up behaviour

Start-up on delivery
In delivery the CPU is overall reset. The PROFIBUS part is deactivated and its LEDs are off after Power ON.

Online with bus parameter without slave project
The DP master can be served with bus parameters by means of a hardware configuration. As soon as these are transferred the DP master goes online with his bus parameter. This is shown by the RUN LED. Now the DP master can be contacted via PROFIBUS by means of his PROFIBUS address. In this state the CPU can be accessed via PROFIBUS to get configuration and DP slave project.

Slave configuration
If the master has received valid configuration data, he switches to Data Exchange with the DP Slaves. This is indicated by the DE-LED.

CPU state controls DP master
After PowerON respectively a receipt of a new hardware configuration the configuration data and bus parameter were transferred to the DP master. Dependent on the CPU state the following behaviour is shown by the DP master:

Master behaviour at CPU STOP
- The global control command "Clear" is sent to the slaves by the master. Here the DE-LED is blinking.
- DP slaves with fail safe mode were provided with output telegram length "0".
- DP slaves without fail safe mode were provided with the whole output telegram but with output data = 0.
- The input data of the DP slaves were further cyclically transferred to the input area of the CPU.
The global control command "Operate" is sent to the slaves by the master. Here the DE-LED is on.

Every connected DP slave is cyclically attended with an output telegram containing recent output data.

The input data of the DP slaves were cyclically transferred to the input area of the CPU.
8 Deployment Ethernet communication - productive

8.1 Basics - Industrial Ethernet in automation

Overview

The flow of information in a company presents a vast spectrum of requirements that must be met by the communication systems. Depending on the area of business the bus system or LAN must support a different number of users, different volumes of data must be transferred and the intervals between transfers may vary, etc. It is for this reason that different bus systems are employed depending on the respective task. These may be subdivided into different classes. The following model depicts the relationship between the different bus systems and the hierarchical structures of a company:

- **Operational layer**
  - Plant computer
  - PPS CAD
- **Management layer**
  - Plant-oriented control computer
  - Manufacturing, stock, production data
  - PPS CAD
- **System layer**
  - Machine and control computer
- **Prozess layer**
  - Peripheral systems machines CNC, NC, controllers (PLC), measuring systems
- **Sensor / actuator layer**
  - Peripheral components
  - Sensor, actuator, regulator, multiplexer, operating consoles

**Industrial Ethernet**

Industrial Ethernet is an electrical net based on shielded twisted pair cabling or optical net based on optical fibre. Industrial Ethernet is defined by the international standard IEEE 802.3.

The net access of Industrial Ethernet corresponds to IEEE 802.3 - CSMA/CD (Carrier Sense Multiple Access/Collision Detection) scheme:

- Every station "listens" on the bus cable and receives communication messages that are addressed to it.
- Stations will only initiate a transmission when the line is unoccupied.
- In the event that two participants should start transmitting simultaneously, they will detect this and stop transmitting to restart after a random delay time has expired.
- Using switches there is the possibility for communication without collisions.
8.2 Basics - ISO/OSI reference model

Overview

The ISO/OSI reference model is based on a proposal that was developed by the International Standards Organization (ISO). This represents the first step towards an international standard for the different protocols. It is referred to as the ISO-OSI layer model. OSI is the abbreviation for Open System Interconnection, the communication between open systems. The ISO/OSI reference model does not represent a network architecture as it does not define the services and protocols used by the different layers. The model simply specifies the tasks that the different layers must perform. All current communication systems are based on the ISO/OSI reference model, which is defined by the ISO 7498 standard. The reference model structures communication systems into 7 layers that cover different communication tasks. In this manner the complexity of the communication between different systems is divided amongst different layers to simplify the task.

The following layers have been defined:

- Layer 7 - Application Layer
- Layer 6 - Presentation Layer
- Layer 5 - Session Layer
- Layer 4 - Transport Layer
- Layer 3 - Network Layer
- Layer 2 - Data Link Layer
- Layer 1 - Physical Layer

Depending on the complexity and the requirements of the communication mechanisms a communication system may use a subset of these layers.

Layer 1 - Bit communication layer (physical layer)

The bit communication layer (physical layer) is concerned with the transfer of data bits via the communication channel. This layer is therefore responsible for the mechanical, electrical and the procedural interfaces and the physical communication medium located below the bit communication layer:

- Which voltage represents a logical 0 or a 1?
- The minimum time the voltage is present to be recognized as a bit.
- The pin assignment of the respective interface.

Layer 2 - Security layer (data link layer)

This layer performs error-checking functions for bit strings transferred between two communicating partners. This includes the recognition and correction or flagging of communication errors and flow control functions. The security layer (data link layer) converts raw communication data into a sequence of frames. This is where frame limits are inserted on the transmitting side and where the receiving side detects them. These limits consist of special bit patterns that are inserted at the beginning and at the end of every frame. The security layer often also incorporates flow control and error detection functions. The data security layer is divided into two sub-levels, the LLC and the MAC level. The MAC (Media Access Control) is the lower level and controls how senders are sharing a single transmit channel. The LLC (Logical Link Control) is the upper level that establishes the connection for transferring the data frames from one device into the other.
The network layer is an agency layer. Business of this layer is to control the exchange of binary data between stations that are not directly connected. It is responsible for the logical connections of layer 2 communications. Layer 3 supports the identification of the single network addresses and the establishing and disconnecting of logical communication channels. Additionally, layer 3 manages the prior transfer of data and the error processing of data packets. IP (Internet Protocol) is based on Layer 3.

Layer 4 connects the network structures with the structures of the higher levels by dividing the messages of higher layers into segments and passes them on to the network layer. Hereby, the transport layer converts the transport addresses into network addresses. Common transport protocols are: TCP, SPX, NWLink and NetBEUI.

The session layer is also called the communication control layer. It relieves the communication between service deliverer and the requestor by establishing and holding the connection if the transport system has a short time fail out. At this layer, logical users may communicate via several connections at the same time. If the transport system fails, a new connection is established if needed. Additionally this layer provides methods for control and synchronization tasks.

This layer manages the presentation of the messages, when different network systems are using different representations of data. Layer 6 converts the data into a format that is acceptable for both communication partners. Here compression/decompression and encrypting/decrypting tasks are processed. This layer is also called interpreter. A typical use of this layer is the terminal emulation.

The application layer is the link between the user application and the network. The tasks of the application layer include the network services like file, print, message, database and application services as well as the according rules. This layer is composed from a series of protocols that are permanently expanded following the increasing needs of the user.

A network res. LAN (Local Area Network) provides a link between different stations that enables them to communicate with each other. Network stations consist of PCs, IPCs, TCP/IP adapters, etc. Network stations are separated by a minimum distance and connected by means of a network cable. The combination of network stations and the network cable represent a complete segment. All the segments of a network form the Ethernet (physics of a network).

In the early days of networking the Triaxial- (yellow cable) or thin Ethernet cable (Cheapernet) was used as communication medium. This has been superseded by the twisted-pair network cable due to its immunity to interference. The CPU has a twisted-pair connector. The twisted-pair cable consists of 8 cores that are twisted together in pairs. Due to these twists this system is provides an increased level of immunity to electrical interference. For linking please use twisted pair cable which at least corresponds to the category 5. Where the
 coaxial Ethernet networks are based on a bus topology the twisted-pair network is based on a point-to-point scheme. The network that may be established by means of this cable has a star topology. Every station is connected to the star coupler (hub/switch) by means of a separate cable. The hub/switch provides the interface to the Ethernet.

**Hub (repeater)**

The hub is the central element that is required to implement a twisted-pair Ethernet network. It is the job of the hub to regenerate and to amplify the signals in both directions. At the same time it must have the facility to detect and process segment wide collisions and to relay this information. The hub is not accessible by means of a separate network address since it is not visible to the stations on the network. A hub has provisions to interface to Ethernet or to another hub res. switch.

**Switch**

A switch also is a central element for realizing Ethernet on Twisted Pair. Several stations res. hubs are connected via a switch. Afterwards they are able to communicate with each other via the switch without interfering the network. An intelligent hardware analyses the incoming telegrams of every port of the switch and passes them collision free on to the destination stations of the switch. A switch optimizes the bandwidth in every connected segment of a network. Switches enable exclusive connections between the segments of a network changing at request.

### 8.4 Basics - Protocols

**Overview**

Protocols define a set of instructions or standards that enable computer to establish communication connections and exchange information as error free as possible. A commonly established protocol for the standardization of the complete computer communication is the so called ISO/OSI layer model, a model based upon seven layers with rules for the usage of hardware and software. Chapter 8.2 'Basics - ISO/OSI reference model' on page 125

The following protocols are used:

- Siemens S7 connections
- Open communication
  - TCP native according to RFC 793
  - ISO on TCP according to RFC 1006
  - UDP according to RFC 768

**Siemens S7 connections**

With the Siemens S7 connection large data sets may be transferred between PLC systems based on Siemens STEP®7. Here the stations are connected via Ethernet. Precondition for the Siemens S7 communication is a configured connection table, which contains the defined connections for communication. Here NetPro from Siemens may be used.

Properties:

- A communication connection is specified by a connection ID for each connection partner.
- The acknowledgement of the data transfer is established from the partner station at level 7 of the ISO/OSI reference model.
- At the PLC side FB/SFB VIPA handling blocks are necessary for data transfer for the Siemens S7 connections.
Open communication

In the ‘open communication’ the communication takes place via the user program by means of handling blocks. These blocks are part of the Siemens SIMATIC Manager. You will find these in the ‘Standard Library’ at ‘Communication Blocks’.

- **Connection-oriented protocols:**
  Connection-oriented protocols establish a (logical) connection to the communication partner before data transmission is started. And if necessary they terminate the connection after the data transfer was finished. Connection-oriented protocols are used for data transmission when reliable, guaranteed delivery is of particular importance. In general, many logical connections can exist on one physical line. The following connection-oriented protocols are supported with FBs for open communication via Industrial Ethernet:
  - **TCP native accord. to RFC 793:**
    During data transmission, no information about the length or about the start and end of a message is transmitted. However, the receiver has no means of detecting where one message ends in the data stream and the next one begins. The transfer is stream-oriented. For this reason, it is recommended that the data length of the FBs is identical for the sending and receiving station. If the number of received data does not fit to the preset length you either will get not the whole data, or you will get data of the following job.
  - **ISO on TCP accord. to RFC 1006:**
    During data transmission, information on the length and the end of the message is also transmitted. If you have specified the length of the data to be received greater than the length of the data to be sent, the receive block will copy the received data completely into the receive range.

- **Connection-less protocol:**
  There is thus no establishment and termination of a connection with a remote partner. Connection-less protocols transmit data with no acknowledge and with no reliable guaranteed delivery to the remote partner.
  - **UDP accord. to RFC 768:**
    In this case, when calling the sending block you have to specify the address parameters of the receiver (IP address and port number). During data transmission, information on the length and the end of the message is also transmitted. In order to be able to use the sending and receiving blocks first you have to configure the local communications access point at both sides. With each new call of the sending block, you re-reference the remote partner by specifying its IP address and its port number.
8.5 Basics - IP address and subnet

**IP address structure**
Exclusively IPv4 is supported. At IPv4 the IP address is a 32bit address that must be unique within the network and consists of 4 numbers that are separated by a dot. Every IP address is a combination of a Net-ID and a Host-ID and has the following Structure: 

Structure: xxx.xxx.xxx.xxx

Range: 000.000.000.000 to 255.255.255.255

**Net-ID, Host-ID**
The Network-ID identifies a network res. a network controller that administrates the network. The Host-ID marks the network connections of a participant (host) to this network.

**Subnet mask**
The Host-ID can be further divided into a Subnet-ID and a new Host-ID by using a bit for bit AND assignment with the Subnet mask.
The area of the original Host-ID that is overwritten by 1 of the Subnet mask becomes the Subnet-ID, the rest is the new Host-ID.

<table>
<thead>
<tr>
<th>Subnet mask</th>
<th>binary all &quot;1&quot;</th>
<th>binary all &quot;0&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 address</td>
<td>Net-ID</td>
<td>Host-ID</td>
</tr>
<tr>
<td>Subnet mask and IPv4 address</td>
<td>Net-ID</td>
<td>Subnet-ID</td>
</tr>
</tbody>
</table>

**Address at first start-up**
At the first start-up of the CPU, the Ethernet PG/OP channel and the PROFINET IO controller do not have an IP address.

Information about the assignment of IP address data to the Ethernet PG/OP channel may be found in Chapter 5.6 ‘Hardware configuration - Ethernet PG/OP channel' on page 44.

Information about the assignment of IP address data to the EtherCAT connection may be found in ‘Assign IP address parameters’ on page 150

**Address classes**
For IPv4 addresses there are five address formats (class A to class E) that are all of a length of 4byte = 32bit.

<table>
<thead>
<tr>
<th>Class</th>
<th>Network-ID (bit)</th>
<th>Host-ID (bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class A</td>
<td>0</td>
<td>Network-ID (1+7bit)</td>
</tr>
<tr>
<td>Class B</td>
<td>10</td>
<td>Network-ID (2+14bit)</td>
</tr>
<tr>
<td>Class C</td>
<td>110</td>
<td>Network-ID (3+21bit)</td>
</tr>
<tr>
<td>Class D</td>
<td>1110</td>
<td>Multicast group</td>
</tr>
<tr>
<td>Class E</td>
<td>11110</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The classes A, B and C are used for individual addresses, class D for multicast addresses and class E is reserved for special purposes. The address formats of the 3 classes A, B, C are only differing in the length of Network-ID and Host-ID.
Private IP networks

These addresses can be used as net-ID by several organizations without causing conflicts, for these IP addresses are neither assigned in the Internet nor are routed in the Internet. To build up private IP-Networks within the Internet, RFC1597/1918 reserves the following address areas:

<table>
<thead>
<tr>
<th>Network class</th>
<th>from IP</th>
<th>to IP</th>
<th>Standard subnet mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>10.0.0.0</td>
<td>10.255.255.255</td>
<td>255.0.0.0</td>
</tr>
<tr>
<td>B</td>
<td>172.16.0.0</td>
<td>172.31.255.255</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>C</td>
<td>192.168.0.0</td>
<td>192.168.255.255</td>
<td>255.255.255.0</td>
</tr>
</tbody>
</table>

(The Host-ID is underlined.)

Reserved Host-IDs

Some Host-IDs are reserved for special purposes.

<table>
<thead>
<tr>
<th>Host-ID = &quot;0&quot;</th>
<th>Identifier of this network, reserved!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host-ID = maximum (binary complete &quot;1&quot;)</td>
<td>Broadcast address of this network</td>
</tr>
</tbody>
</table>

*Never choose an IP address with Host-ID=0 or Host-ID=maximum! (e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is reserved and the "172.16.255.255" is occupied as local broadcast address for this network.)*

8.6 Fast introduction

Overview

At the first start-up respectively at an over all reset with an PowerON again, the Ethernet PG/OP channel and PROFINET IO controller do not have any IP address. These may only be reached via its MAC address. IP address parameters may be assigned to the corresponding component by means of the MAC addresses, which may be found on labels beneath the front flap with the sequence 1. address PG/OP channel and beneath address of the PROFINET IO controller. The assignment takes place directly via the hardware configuration of the Siemens SIMATIC Manager.

Steps of configuration

For the configuration of the PROFINET IO controller for productive connections please follow the following approach:

- Assembly and commissioning
- Hardware configuration - CPU
Configure connections
- Siemens S7 connections
  (Configuration via Siemens NetPro, communication via VIPA handling blocks)
- Open communication
  (Configuration and communication happens by standard handling blocks)

Transfer of the complete project to CPU

To be compatible to the Siemens SIMATIC Manager, the CPU 315-4PN12 from VIPA is to be configured as CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6)!

The PROFINET IO controller is to be configured via the CPU sub module X2 (PN-IO).

The Ethernet PG/OP channel of the CPU 315-4PN12 is always to be configured as 1. module after the really plugged modules at the standard bus as CP343-1 (343-1EX11) from Siemens.

8.7 Commissioning and initialization

Assembly and commissioning
1. Install your System 300S with your CPU.
2. Wire the system by connecting cables for voltage supply and signals
3. Connect your PROFINET IO controller with Ethernet.
4. Switch on the power supply.
   ⇒ After a short boot time, the CP is in idle. At the first commissioning res. after an overall reset of the CPU, the PROFINET IO controller and the Ethernet PG/OP channel have no IP address.

Assign IP address parameters
You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens SIMATIC Manager starting with version V 5.3 & SP3 with the following proceeding:
1. Start the Siemens SIMATIC Manager and set via ‘Options => Set PG/PC interface the access path to ‘TCP/IP -> Network card .....’
2. Open with ‘PLC => Edit Ethernet Node n’ the dialog window with the same name.
3. To get the stations and their MAC address, use the [Browse] button or type in the MAC Address. The Mac address may be found at the 2. label beneath the front flap of the CPU.
4. Choose if necessary the known MAC address of the list of found stations. To check this with [Blink] you may cause the MT LED to blink.
5. Either type in the IP configuration like IP address, subnet mask and gateway. Or your station is automatically provided with IP parameters by means of a DHCP server. Depending of the chosen option the DHCP server is to be supplied with MAC address, equipment name or client ID. The client ID is a numerical order of max. 63 characters. The following characters are allowed: "hyphen", 0-9, a-z, A-Z

6. Confirm with [Assign IP configuration].

Directly after the assignment the PROFINET IO controller is online reachable using the set IP address data. Since the IP address data, which were assigned here, are deleted at PowerOFF, you have to take them to a project by means of the hardware configuration.

8.8 Hardware configuration - CPU

Precondition

The configuration of the CPU takes place at the Siemens ‘hardware configurator’. The hardware configurator is part of the Siemens SIMATIC Manager. It serves for project engineering. The modules, which may be configured here are listed in the hardware catalog. If necessary you have to update the hardware catalog with ‘Options ➔ Update Catalog’.

For project engineering a thorough knowledge of the Siemens SIMATIC Manager and the Siemens hardware configurator is required.

Proceeding

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 315-2PN/DP</td>
</tr>
<tr>
<td></td>
<td>X1 MPI/DP</td>
</tr>
<tr>
<td></td>
<td>X2 PN-IO</td>
</tr>
<tr>
<td></td>
<td>X2... Port 1</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

To be compatible with the Siemens SIMATIC Manager the following steps should be executed:

1. Start the Siemens hardware configurator with a new project.
2. Insert a profile rail from the hardware catalog.
3. Place at ‘Slot’-Number 2 the CPU 315-2 PN/DP (315-2EH13 V2.6).
4. The integrated PROFIBUS DP master (X3) is to be configured and connected via the sub module X1 (MPI/DP). In the operation mode PROFIBUS the CPU may further more be accessed via the MPI interface (X2) with address 2 und 187.5kbit/s.
5. The PROFINET IO controller is to be configured via the sub module ‘X2 PN-IO’.

Parametrization of the IP address data for the PROFINET IO controller

Open the property window of the internal PROFINET IO controller via double-click on the component PN-IO:

1. At ‘General’ enter a device name. The device name on the Ethernet subnet must be unique.
2. For the PROFINET IO controller enter the IP address, subnet mask and gateway and select the wanted subnet.
8.9 Configure Siemens S7 connections

Overview
The project engineering of connections i.e. the "link-up" between stations happens in NetPro from Siemens. NetPro is a graphical user interface for the link-up of stations. A communication connection enables the program controlled communication between two participants at the Industrial Ethernet. The communication partners may here be part of the same project or - at multi projects - separated within related part projects. Communication connections to partners outside of a project are configured via the object "In unknown project" or via deputy objects like "Other stations" or Siemens "SIMATIC S5 Station". The communication is controlled by the user program with VIPA handling blocks. To use this blocks, configured communication connections are always necessary in the active station.

Properties communication connection
The following properties are characterizing a communication connection:
- One station always executes an active connection establishment.
- Bi-directional data transfer (Send and receive on one connection)
- Both participant have equal rights, i.e. every participant may initialize the send res. receive process event controlled.
- Except of the UDP connection, at a communication connection the address of the communication partner is set via the project engineering. Here the connection is active established by one station.

<table>
<thead>
<tr>
<th>CP</th>
<th>Ethernet partner</th>
</tr>
</thead>
<tbody>
<tr>
<td>send</td>
<td>receive</td>
</tr>
<tr>
<td>receive</td>
<td>send</td>
</tr>
<tr>
<td></td>
<td>Communication link</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Requirements
- Siemens SIMATIC Manager V 5.5 SP2 or higher and SIMATIC NET are installed.
- With the hardware configuration the CP was assigned with IP address data by the properties of PN-IO.

Every station outside of the recent project must be configured as replacement objects like e.g. Siemens "SIMATIC S5" or "other station" or with the object "In unknown project". When creating a connection you may also choose the partner type "unspecified" and set the required remote parameter directly in the connection dialog.
For the project engineering of connections, a thorough knowledge with NetPro from Siemens is required! The following passage only describes the basic usage of NetPro. More detailed information about NetPro is to be found in the according online manual res. documentation. Start NetPro by clicking on a "net" in the Siemens SIMATIC Manager or on "connections" within the CPU.

The environment of NetPro has the following structure:

1. **Graphic net view:** All stations and networks are displayed in a graphic view. By clicking on the according component you may access and alter the concerning properties.
2. **Net objects:** This area displays all available net objects in a directory view. By dragging a wanted object to the net view you may include further net objects and open them in the hardware configurator.
3. **Connection table:** The connection table lists all connections in a table. This list is only shown when you highlighted a connectable module like e.g. a CPU. You may insert new connections into this table with the according command.

**PLC stations**

You receive the following graphical display for every PLC station and their component. By selecting the single components, the context menu offers you several functions:

1. **Station:** This includes a PLC station with rack, CPU and communication components. Via the context menu you may configure a station added from the net objects and its concerning components in the hardware configurator. After returning to NetPro, the new configured components are shown.
2. **CPU:** A click onto the CPU shows the connection table. The connection table shows all connections that are configured for the CPU.
3. **Internal communication components:** This displays the communication components that are available in your CPU. The PROFINET IO controller is to be configured by the PN-IO component.
4. **Ethernet PG/OP channel:** The internal Ethernet PG/OP channel must always be configured as external CP in the hardware configuration. This CP only serves the PG/OP communication. Configurable connections are not possible.
Link up stations

NetPro offers you the option to link-up the communicating stations. You may link-up the stations via the properties in the hardware configuration or graphically via NetPro. For this you point the mouse on the coloured net mark of the according CP and drag and drop it to the net you want to link. Now the CP is linked up to the wanted net by means of a line.

![Diagram showing the process of linking up stations](image)

Projecting connections

1. For the project engineering of connections, open the connection list by selecting the according CPU. Choose **Insert new connection** in the context menu:
   - **Connection partner (partner station)**
     A dialog window opens where you may choose the connection partner and the **connection type**.
   - **Specified connection partner**
     Each station configured in the Siemens SIMATIC Manager is listed in the table of connection partner. These stations are unique specified by an IP address and a subnet mask.
   - **Unspecified connection partner**
     Here the connection partner may exist in the **current project** or in an unknown project. Connection jobs to an **unknown project** must be defined by an unique connection name, which is to be used in the projects of both stations. Due to this allocation the connection remains **unspecified**.
2. Choose the connection partner and the type of connection and confirm with [OK].

- If activated, a properties dialog for the according connection opens as link to your PLC user program.

3. After every connection was configured by this way, you may save and compile your project and exit NetPro.

**Connection types**

Exclusively Siemens S7 connection may be configured with NetPro.

- All broadcast stations and All multicast stations are not supported by this CPU.

**Siemens S7 connection**

- For data transfer with Siemens S7 connections the FB/SFB VIPA handling blocks are necessary; the deployment is described in the manual "Operation list" of your CPU.
- At Siemens S7 connections the communication connections are specified by a connection ID for each communication partner.
- A connection is specified by the local and partner connection end point.
- At Siemens S7 connections the TSAPs must be congruent cross-wise. The following parameters define a connection end point:
The following parameters define a connection end point:

<table>
<thead>
<tr>
<th>Station A</th>
<th>Station B</th>
</tr>
</thead>
<tbody>
<tr>
<td>remote TSAP</td>
<td>Siemens</td>
</tr>
<tr>
<td>local TSAP</td>
<td>S7 connection</td>
</tr>
<tr>
<td>ID A</td>
<td>ID B</td>
</tr>
</tbody>
</table>

Combination options with deployment of the FB/SFB VIPA handling blocks

<table>
<thead>
<tr>
<th>Connection partner</th>
<th>Connection establishing</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>specified in NetPro</td>
<td>active/passive</td>
<td>specified</td>
</tr>
<tr>
<td>(in the current project)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>unspecified in NetPro</td>
<td>active</td>
<td>specified</td>
</tr>
<tr>
<td>(in the current project)</td>
<td>passive</td>
<td>unspecified</td>
</tr>
<tr>
<td>unspecified in NetPro</td>
<td>active/passive</td>
<td>specified (connection name in an other project)</td>
</tr>
<tr>
<td>(in the unknown project)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In the following every relevant parameter of a Siemens S7 connection is described:

- **Local connection end point:**
  Here you may define how the connection is to be established.
  Since the Siemens SIMATIC Manager can identify the communication options by means of the end points, some options are already preset and may not be changed.
  
  - **Establish an active connection:**
    An established connection is precondition for data transfer. By activating the option Establish an active connection the local station establishes the connection. Please regard not every station is able to establish a connection. Here the job is to be made by the partner station.
  
  - **One-way:**
    If activated only one-way communication blocks like PUT and GET may be used for communication in the user program. Here the partner station acts as server, which neither may send active nor receive active

- **Block parameters**
  
  - **Local ID:**
    The ID is the link to your PLC program. The ID must be identical to the ID of the call interface of the FB/SFB VIPA handling block.
  
  - **[Default]:**
    As soon as you click at [Default], the ID is reset to system generated ID.

- **Connection path:**
  In this part of the dialog window the connection path between the local and the partner station may be set. Depending on the linking of the modules the possible interfaces for communication are listed in a selection field.
  
  - **[Address details]:**
    With this button a dialog window is opened, which shows address information about the local and partner station. The parameters may also be changed.
  
  - **TSAP:**
    With Siemens S7 connections a TSAP is automatically generated of the connection resource (one-way/two-way) and state of place (rack/slot respectively system internal ID at PC stations).
  
  - **Connection resource:**
    The connection resource is part of the TSAP of the local station respectively of the partner. Not every connection resource may be used for every connection type. Depending on the connection partner and the connection type the range of values is limited respectively the connection resource is fix specified.
Siemens S7 connection - Communication functions

With the SPEED7 CPUs of VIPA there are two possibilities for the deployment of the communication functions:

- **Siemens S7-300 communication functions:**
  By integration of the function blocks FB 8 ... FB 15 from VIPA you may access the Siemens S7-300 communication functions.

- **Siemens S7-400 communication functions:**
  For the Siemens S7-400 communication functions the SFB 8 ... SFB 15 are to be used, which were integrated to the operating system of the CPU. Here copy the interface description of the SFBs from the standard library at system function block to the directory container, generate an instance data block for each call and call the SFB with the associated instance data block.

### Function blocks

<table>
<thead>
<tr>
<th>FB/SFB</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB/SFB 12</td>
<td>BSEND</td>
<td>Sending data in blocks: FB/SFB 12 BSEND sends data to a remote partner FB/SFB of the type BRCV (FB/SFB 13). The data area to be transmitted is segmented. Each segment is sent individually to the partner. The last segment is acknowledged by the partner as it is received, independently of the calling up of the corresponding FB/SFB/FB BRCV. With this type of data transfer, more data can be transported between the communications partners than is possible with all other communication FBs/SFBs for configured S7 connections, namely 65534 bytes.</td>
</tr>
<tr>
<td>FB/SFB 13</td>
<td>BRCV</td>
<td>Receiving data in blocks: The FB/SFB 13 BRCV can receive data from a remote partner FB/SFB of the type BSEND (FB/SFB 12). The parameter R_ID of both FB/SFBs must be identical. After each received data segment an acknowledgement is sent to the partner FB/SFB and the LEN parameter is updated.</td>
</tr>
<tr>
<td>FB/SFB 14</td>
<td>GET</td>
<td>Remote CPU read: The FB/SFB 14 GET can be used to read data from a remote CPU. The respective CPU must be in RUN mode or in STOP mode.</td>
</tr>
<tr>
<td>FB/SFB 15</td>
<td>PUT</td>
<td>Remote CPU write: The FB/SFB 15 PUT can be used to write data to a remote CPU. The respective CPU may be in RUN mode or in STOP mode.</td>
</tr>
</tbody>
</table>

8.10 Configure Open Communication

**Connection-oriented protocols**

- Connection-oriented protocols establish a (logical) connection to the communication partner before data transmission is started.
- And if necessary they terminate the connection after the data transfer was finished.
- Connection-oriented protocols are used for data transmission when reliable, guaranteed delivery is of particular importance.
- In general, many logical connections can exist on one physical line.
The following connection-oriented protocols are supported with FBs for open communication via Industrial Ethernet:

- **TCP/IP native according to RFC 793 (connection types 01h and 11h):**
  During data transmission, no information about the length or about the start and end of a message is transmitted. However, the receiver has no means of detecting where one message ends in the data stream and the next one begins. The transfer is stream-oriented. For this reason, it is recommended that the data length of the FBs is identical for the sending and receiving station. If the number of received data does not fit to the preset length you either will get not the whole data, or you will get data of the following job. The receive block copies as many bytes into the receive area as you have specified as length. After this, it will set NDR to TRUE and write RCVD_LEN with the value of LEN. With each additional call, you will thus receive another block of sent data.

- **ISO on TCP according to RFC 1006:**
  During data transmission, information on the length and the end of the message is also transmitted. If you have specified the length of the data to be received greater than the length of the data to be sent, the receive block will copy the received data completely into the receive range. After this, it will set NDR to TRUE and write RCVD_LEN with the length of the sent data. If you have specified the length of the data to be received less than the length of the sent data, the receive block will not copy any data into the receive range but instead will supply the following error information: ERROR = 1, STATUS = 8088h.

- **Connection-less protocol**
  - There is thus no establishment and termination of a connection with a remote partner.
  - Connection-less protocols transmit data with no acknowledge and with no reliable guaranteed delivery to the remote partner.

The following connection-oriented protocol is supported with FBs for open communication via Industrial Ethernet:

- **UDP according to RFC 768 (with connection type 13h):**
  In this case, when calling the sending block you have to specify the address parameters of the receiver (IP address and port number). During data transmission, information on the length and the end of the message is also transmitted. In order to be able to use the sending and receiving blocks first you have to configure the local communications access point at both sides. With each new call of the sending block, you re-reference the remote partner by specifying its IP address and its port number. If you have specified the length of the data to be received greater than the length of the data to be sent, the receive block will copy the received data completely into the receive range. After this, it will set NDR to TRUE and write RCVD_LEN with the length of the sent data. If you have specified the length of the data to be received less than the length of the sent data, the receive block will not copy any data into the receive range but instead will supply the following error information: ERROR = 1, STATUS = 8088h.
Handling blocks

Those in the following listed UTDs and FBs serve for "open communication" with other Ethernet capable communication partners via your user program. These blocks are part of the Siemens SIMATIC Manager. You will find these in the "Standard Library" at "Communication Blocks". Please consider when using the blocks for open communication that the partner station does not have to be configured with these blocks. This can be configured with AG_SEND / AG_RECEIVE or IP_CONFIG.

### UDTs

<table>
<thead>
<tr>
<th>FB</th>
<th>Label</th>
<th>Connection-oriented protocols: TCP native as per RFC 793, ISO on TCP as per RFC 1006</th>
<th>Connectionless protocol: UDP as per RFC 768</th>
</tr>
</thead>
<tbody>
<tr>
<td>UDT 65</td>
<td>TCON_PAR</td>
<td>Data structure for assigning connection parameters</td>
<td>Data structure for assigning parameters for the local communications access point</td>
</tr>
<tr>
<td>UDT 66</td>
<td>TCON_ADR</td>
<td></td>
<td>Data structure for assigning addressing parameters for the remote partner</td>
</tr>
</tbody>
</table>

### FBs

<table>
<thead>
<tr>
<th>FB</th>
<th>Label</th>
<th>Connection-oriented protocols: TCP native as per RFC 793, ISO on TCP as per RFC 1006</th>
<th>Connectionless protocol: UDP as per RFC 768</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB 63</td>
<td>TSEND</td>
<td>Sending data</td>
<td></td>
</tr>
<tr>
<td>FB 64</td>
<td>TRCV</td>
<td>Receiving data</td>
<td></td>
</tr>
<tr>
<td>FB 65</td>
<td>TCON</td>
<td>Establishing a connection</td>
<td>Configuring the local communications access point</td>
</tr>
<tr>
<td>FB 66</td>
<td>TDISCON</td>
<td>Terminating a connection</td>
<td>Closing the local communications access point</td>
</tr>
<tr>
<td>FB 67</td>
<td>TUSEND</td>
<td>Sending data</td>
<td></td>
</tr>
<tr>
<td>FB 68</td>
<td>TURCV</td>
<td>Receiving data</td>
<td></td>
</tr>
</tbody>
</table>

8.11 NCM diagnostic - Help for error diagnostic

The VIPA PROFINET IO controller supports the Siemens NCM diagnostic tool. The NCM diagnostic tool is part of the Siemens SIMATIC Manager. This tool delivers information about the operating state of the communication functions of the online CPs dynamically.

The following diagnostic functions are available:

- Check operating state at Ethernet
- Read the diagnostic buffer of the PROFINET IO controller
- Diagnostic of connections
Please always enter for the PROFINET IO controller as destination parameter 0 as module rack and 125 as slot. The following pages contain a short description of the NCM diagnostic. More details about the function range and for the deployment of the Siemens NCM diagnostic tool is to be found in the according online help res. the manual from Siemens.

Start NCM diagnostic

The diagnostic tool is started by ‘Windows-START menu ➤ SIMATIC ➤ ... NCM S7 ➤ Diagnostic’.

Structure

The working surface of the diagnostic tool has the following structure:

- The ‘navigation area’ at the left side contains the hierarchical listed diagnostic objects. Depending on CP type and configured connections there is an adjusted object structure in the navigation area.
- The ‘information area’ at the right side always shows the result of the navigation function you chose in the navigation area.

No diagnostic without connection

A diagnostic always requires an online connection to the CP you want to control. For this click at the symbol bar.

The following dialog window appears:
Set the following parameters at destination station:

- **Attachment...**: Ind. Ethernet TCP/IP
- **Node addr.**: Enter the IP address of the CP
- **Rack/slot**: For the VIPA PROFINET IO controller please enter 0 for module rack and 125 as slot. Set your PG/PC interface to "TCP/IP -> Network card .... ". Via [OK] you start the online diagnostic.

**Read diagnostic buffer**

The PROFINET IO controller has a diagnostic buffer. This has the architecture of a ring memory and may store up to 100 diagnostic messages. The NCM diagnostic allows you to monitor and evaluate the diagnostic messages via the diagnostic object Diagnostic buffer. Via a double click on a diagnostic message the NCM diagnostic shows further information.

**Approach for diagnostic**

You execute a diagnostic by clicking on a diagnostic object in the navigation area. More functions are available via the menu and the symbol bar.

For the aimed diagnostic deployment the following approach is convenient:

1. **Start diagnostic.**
2. **Open the dialog for the online connection with enter connection parameters and establish the online connection with [OK].**
3. **Identify the PROFINET IO controller and check the recent state of the PROFINET IO controller via module status.**
4. **Check the connections for particularities like:**
   - Connection status
   - Receive status
   - Send status
5. **Control and evaluate the diagnostic buffer of the PROFINET IO controller via ‘diagnostic buffer’.**
6. **As needed, alter project engineering res. programming and restart diagnostic.**
9 Deployment Ethernet communication - PROFINET

9.1 Basics PROFINET

General

- PROFINET is an open Industrial Ethernet Standard from PROFIBUS & PROFINET International (PI) for automation. PROFINET is standardized in the IEC 61158.
- PROFINET uses TCP/IP and IT standards and supplements the PROFIBUS technology for applications, where fast data communication with industrial IT functions is demanded.

There are 2 PROFINET function classes:

- PROFINET IO
- PROFINET CBA

These may be realized in 3 performance steps:

- TCP/IP communication
- RT communication
- IRT communication

PROFINET IO

- With PROFINET IO an I/O data sight to the distributed periphery is described. PROFINET IO describes the whole data transfer between IO controller and IO device. PROFINET is configured like PROFIBUS.
- PROFINET IO always contains the real time concept.
- Contrary to the master-slave procedure of PROFIBUS, PROFINET uses the provider-consumer model. This supports the communication relations (AR = Application Relation) between equal participants in the Ethernet. Here the provider sends its data without a request of the communication partner. Apart from the user data exchange also functions for parametrization and diagnostics are supported.

PROFINET CBA

PROFINET CBA means Component Based Automation. This component model describes the communication between autonomously working stations. It makes a simple modularization of complex plants possible, by distributed intelligence by means of graphic configuration for communication of intelligent modules.

TCP/IP Communication

This is the open communication via Ethernet TCP/IP without any demand on real-time.

RT Communication

RT means Real-Time. The RT communication represents the basics for data transfer at PROFINET IO. Here RT data are handled with higher priority.

IRT Communication

IRT means Isochronous Real-Time. With the IRT communication the bus cycle begins clock-exactly i.e. with a maximum permissible tolerance and is again synchronized. Thereby the time-controlled and synchronous transfer of data is guaranteed. Here sync telegrams of a sync master in the network serve for.
PROFINET of IEC 61158 has the following properties:
- Full-duplex transfer with 100MBit/s via copper respectively fibre optics.
- Switched Ethernet
- Auto negotiation (negotiates the transfer parameters)
- Auto crossover (transmission and receipt lines are crossed automatically if necessary)
- Wireless communication via Bluetooth respectively WLAN
- UDP/IP is used as overlaid protocol. UDP means User Datagram Protocol and contains the unprotected connectionless broadcast communication within IP.

PROFINET devices
Like PROFIBUS DP also with PROFINET IO the following devices are classified according to their tasks:
- IO controller
- IO device
- IO supervisor

IO controller
The IO controller is equivalent to the master of PROFIBUS. This is the PLC with PROFINET connection, in which the PLC program runs.

IO device
The IO device is a distributed I/O field device, which is connected to PROFINET. The IO device is equal to the slave of PROFIBUS.

IO supervisor
The IO supervisor is an engineering station as e.g. programming unit, PC or HMI interface for commissioning and diagnostics.

AR
AR (Application Relation) corresponds to a connection to an IO controller or IO supervisor.

GSDML file
From VIPA there is a GSDML files for your IO device available. This file may either be found on the supplied storage media or at the download area of www.vipa.com. Please install the GSDML file in your configuration tool. Details on the installation of the GSDML file are available from the manual supplied with your configuration tool. For configuration in your configuration tool every module may be found in the GSDML file as XML data.

Addressing
In contrast to the PROFIBUS address in PROFINET each device may be identified with its PROFINET interface:
- IP address or MAC address
- Device name

Transfer medium
PROFINET is compatible to Ethernet in accordance with the IEEE standards. The connection of the PROFINET IO field devices is exclusively established via switches as network components. This is made either as star via multi-port switches or as line by means of switches, integrated to the field devices.
9.2 PROFINET installation guidelines

Generals to data security

- The topic of data security and access protection have become increasingly important in the industrial environment. The increased networking of entire industrial systems to the network levels within the company together with the functions of remote maintenance have all served to increase vulnerability.
- Threats can arise from internal manipulation like technical errors, operator and program errors respectively from external manipulation like software viruses and worms, trojans and password phishing.

Precautions

The most important precautions to prevent manipulation and loss of data security in the industrial environment are:

- Encrypting the data traffic by means of certificates.
- Filtering and inspection of the traffic by means of VPN - "Virtual Private Networks".
- Identification of the nodes by "Authentication" via save channels.
- Segmenting in protected automation cells, so that only devices in the same group can exchange data.

Guidelines for information security

- With the "VDI/VDE 2182 sheet 1", Information Security in the Industrial Automation - General procedural model, VDI guidelines, the VDI/VDE society for measuring and automation engineering has published a guide for implementing a security architecture in the industrial environment. The guideline can be found at www.vdi.de
- PROFIBUS & PROFINET International (PI) can support you in setting up security standards by means of the "PROFINET Security Guideline". More concerning this can be found at the corresponding web site e.g. www.profibus.com

Industrial Ethernet

- Due to the open standard of PROFINET standard Ethernet components may be used. For industrial environment and due to the high transfer rate of 100MBit/s you PROFINET system should consist of Industrial Ethernet components.
- All the devices interconnected by switches are located in one and the same network. All the devices in a network can communicate directly with each other.
- A network is physically limited by a router. If devices need to communicate beyond the limits of a network, you have to configure the router so that it allows this communication to take place.

Topology

Linear

- With the linear structure all the communication devices are connected via a linear bus topology. Here the linear bus topology is realized with switches that are already integrated into the PROFINET device.
- If a communication member fails, communication across the failed member is no longer possible.
If you connect communication devices to a switch with more than 2 PROFINET ports, you automatically create a star network topology.

If an individual PROFINET device fails, this does not automatically lead to failure of the entire network, in contrast to other structures. It is only if a switch fails that part of the communication network will fail as well.

**Ring**

In order to increase the availability of a network the both open ends of a linear bus topology may be connected by a switch. By configuring the switch as redundancy manager on a break in the network it ensures that the data is redirected over an intact network connection.

**Tree**

If you interconnect several star structures, you obtain a tree network topology.

### Example network

![Example network diagram](image)

### 9.3 PROFINET system limits

**Devices per ms**

\[
D = \sum_{i}^{n} \frac{I}{A}
\]

- **D**: Devices per ms
- **n**: Number of devices
- **I**: Refresh time device

The PROFINET IO controller has the following system limits:

<table>
<thead>
<tr>
<th>Devices per ms</th>
<th>Max. Number of devices</th>
<th>Max. Number of configurable connections</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>32</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>64</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>96</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>128</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>128</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>128</td>
<td>16</td>
</tr>
</tbody>
</table>
The PROFINET IO controller has the following system limits:

<table>
<thead>
<tr>
<th>Devices per ms</th>
<th>Max. Number of devices</th>
<th>Max. Number of configurable connections</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>128</td>
<td>20</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>24</td>
</tr>
</tbody>
</table>

**Output bytes per ms**

\[ O = \sum_{i}^{n} \frac{B}{A} \]

- \( O \): Output bytes per ms
- \( n \): Number of devices
- \( B \): Number output bytes per device
- \( A \): Refresh time per device

The PROFINET IO controller has the following system limits:

- Max. Number output bytes per ms: 800
- Max. Number output bytes per device: 256

**Input bytes per ms**

\[ I = \sum_{i}^{n} \frac{C}{A} \]

- \( I \): Input bytes per ms
- \( n \): Number of devices
- \( C \): Number input bytes per device
- \( A \): Refresh time per device

The PROFINET IO controller has the following system limits:

- Max. Number input bytes per ms: 800
- Max. Number input bytes per device: 256

**Exceeding the max. number of bytes**

With the following conditions there is the possibility to increase the number of bytes up to 512 input and 512 output bytes per device, with it your project still runs.

- There are max. 13 PROFINET IO devices configured.
- For each PROFINET IO device, depending on the time of refresh time per device, the following conditions must be met:
  - 1ms: There are no IO blocks > 256 bytes allowed.
  - 2ms: for each 1 IO block > 256 byte is allowed.
  - 4ms: for each 2 IO blocks > 256 byte are allowed.
  - 8ms: for each 3 IO blocks > 256 byte are allowed.
  - 16ms and greater: for each 6 IO blocks > 256 byte are allowed.
9.4 Fast introduction

Overview

**Range of functions**

Please regard that the PROFINET IO controller supports only the PROFINET functions, which are described in this manual, even if the Siemens CPU, which is used for configuration, offers further functions! To use some described PROFINET functions, it is necessary to deploy another Siemens CPU for configuration. Here, however, is pointed to explicitly.

At the first commissioning respectively after an overall reset with PowerON again of the CPU, the Ethernet PG/OP channel and the PROFINET IO controller have no IP address. These are only reachable by its MAC address. IP address parameters may be assigned to the corresponding component by means of the MAC addresses, which may be found on labels beneath the front flap with the sequence 1. address PG/OP channel and beneath address of the PROFINET IO controller. The assignment takes place directly via the hardware configuration of the Siemens SIMATIC manager.

Steps of configuration

The configuration of the PROFINET IO controller for PROFINET communication should be done by the following procedure:

1. Commissioning and Initialization (assignment IP address data)
2. Hardware configuration - CPU
3. Configuration PROFINET IO controller
4. Configuration PROFINET IO device
5. Transfer of the entire project to the CPU

To be compatible with the Siemens SIMATIC Manager the CPU 315-4PN12 from VIPA is to be configured as CPU 315-2 PN/DP (315-2EH13-0AB00 V2.6)!

The Ethernet PG/OP channel of the CPU 315-4PN12 is to be configured as 1. module as CP343-1 (343-1EX11) from Siemens after the really plugged modules at the standard bus.

9.5 Commissioning and Initialization

Assembly and commissioning

1. Install your System 300S with your CPU.
2. Wire the system by connecting cables for voltage supply and signals
3. Connect your PROFINET IO controller with Ethernet.
4. Switch on the power supply.
   ⇒ After a short boot time, the CP is in idle.

At the first commissioning respectively after an overall reset of the CPU, the PROFINET IO controller and the Ethernet PG/OP channel have no IP address.
This function is supported only if the PROFINET IO controller is not yet configured. You get valid IP address parameters from your system administrator. The assignment of the IP address data happens online in the Siemens SIMATIC Manager starting with version V 5.3 & SP3 with the following proceeding:

1. Start the Siemens SIMATIC Manager.
2. Switch to "TCP/IP -> Network card .... " using ‘Options è Set PG/PC interface è ’.
3. Open the dialog for initialization of a station with ‘PLC è Edit Ethernet node’.
4. To get the stations and their MAC address, use the [Browse] button or type in the MAC address. The Mac address may be found at the front of the CPU.
5. Choose if necessary the known MAC address of the list of found stations. To check this with [Blink] you may cause the MT LED to blink.
6. Either type in the IP configuration like IP address, subnet mask and gateway. Or your station is automatically provided with IP parameters by means of a DHCP server. Depending of the chosen option the DHCP server is to be supplied with MAC address, equipment name or client ID. The client ID is a numerical order of max. 63 characters. The following characters are allowed: Hyphen "," , 0-9, a-z, A-Z
7. Confirm with [Assign IP configuration].

Directly after the assignment the PROFINET IO controller is online reachable using the set IP address data.

Since the IP address data, which were assigned here, are deleted at PowerOFF, you have to take their to a project by means of the hardware configuration, which is described next.

Initialization of the Ethernet PG/OP channel

9.6 Hardware configuration - CPU

Precondition

The configuration of the CPU takes place at the Siemens ‘hardware configurator’. The hardware configurator is part of the Siemens SIMATIC Manager. It serves for project engineering. The modules, which may be configured here are listed in the hardware catalog. If necessary you have to update the hardware catalog with ‘Options è Update Catalog’.

For project engineering a thorough knowledge of the Siemens SIMATIC Manager and the Siemens hardware configurator is required.
Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic operation (+, -, *, /, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. This may cause conflicts in applications that presume an unmodified ACCU 2.

For more information may be found in the manual "VIPA Operation list SPEED7" at "Differences between SPEED7 and 300V programming".

Proceeding

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU 315-2PN/DP</td>
</tr>
<tr>
<td>X1</td>
<td>MPI/DP</td>
</tr>
<tr>
<td>X2</td>
<td>PN-IO</td>
</tr>
<tr>
<td>X2...</td>
<td>Port 1</td>
</tr>
</tbody>
</table>

To be compatible with the Siemens SIMATIC Manager the following steps should be executed:

1. Start the Siemens hardware configurator with a new project.
2. Insert a profile rail from the hardware catalog.
3. Place at ‘Slot’-Number 2 the CPU 315-2 PN/DP (315-2EH13 V2.6).
4. The integrated PROFIBUS DP master (X3) is to be configured and connected via the sub module X1 (MPI/DP). In the operation mode PROFIBUS the CPU may further more be accessed via the MPI interface (X2) with address 2 und 187.5kbit/s.
5. The PROFINET IO controller is to be configured via the sub module ‘X2 PN-IO’.

9.7 Parameters - PROFINET IO controller

9.7.1 Precondition

To parametrize the PROFINET IO controller of the CPU, the following conditions must be fulfilled:

- The PROFINET IO controller is online reachable, this means an initialization was established.
- The hardware configuration described before was established and the PROFINET IO controller is networked.

Proceeding

Open the properties dialog of the PROFINET IO controller by a double-click at PN-IO.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CPU ...</td>
</tr>
<tr>
<td>X...</td>
<td>PN-IO</td>
</tr>
</tbody>
</table>

The PROFINET interface of the PROFINET IO controller is parametrized with PN-IO, the port with Port 1. In the following these parameters for PN-IO and Port 1 are described.
9.7.2 PN-IO

General

**Short description**
Designation of the IO controller. The IO controller from VIPA always has the short description "PN-IO".

**Device name**
The device name on the Ethernet subnet must be unique. For an integrated PROFINET interface the device name is derived from the short description.

**Comment**
Here the purpose may be entered for which the IO controller is being used.

**Properties**
With properties you can enter the IP address, subnet mask and gateway for the PROFINET interface and select the subnet to be connected.

**Addresses**
The CPU reports errors of the IO controller via the interface address, as soon as e.g. an error during synchronization of the IO controller occurs. With the PROFINET IO system address the CPU reports e.g. failure/return of the PROFINET IO system. This address is also used to identify the IO system to which the device belongs, if an IO device fails.

**PROFINET**
With the operation field "OB82 / I/O fault task..." you can cause the CPU to call the OB 82 at an error event of the PROFINET interface. An entry to the diagnostics buffer is always done.

The other parameters in this tab are not relevant for the use of the VIPA PROFINET CPU.

**Synchronization**
This tab shows the synchronization properties of the IO controller. Here nothing can be changed.

**Time-of-day synchronization**
Here you can configure time-of-day master for time-of-day synchronization in the network. NTP (Network Time Protocol) is used to implement a TCP/IP protocol for time-of-day synchronization in networks. In the NTP mode the module sends out time-of-day queries at regular intervals to all configured NTP servers. Based on the response from the servers, the most reliable and most exact time-of-day is determined and used to synchronize the time-of-day of the module. Configure with [Add] a NTP server and enter the update interval. The time-of-day of the module is synchronized once within this interval.

9.7.3 Port 1

**General**
Shown is the short name "Port...". In the field Name another designation may be selected, which is also shown in the configuration table. At comment you may describe your entry near more. The comment also appears in the configuration table.
Addresses  Via the port address the diagnostics information of the IO controller may be accessed.

Topology  These parameters serve for the handling of the ports and should not be changed.

Options  These parameters serve for the handling of the ports and should not be changed.

9.8 Configuration PROFINET IO device

Install GSDML

- The modules, which may be configured here are listed in the hardware catalog.
- For the deployment of the PROFINET IO devices from VIPA you have to include the modules into the hardware catalog by means of the GSDML file from VIPA.
- After the installation of the GSDML file the PROFINET IO devices from VIPA may be found in the hardware catalog at ‘PROFINET IO ➞ Additional field devices ➞ I/O ➞ VIPA ...’

Configure IO devices

Now the project engineering of the PROFINET IO controller is finished. Please link up now your IO devices with periphery to your IO controller.

1. For the project engineering of PROFINET IO device you search the concerning PROFINET IO device in the hardware catalog at PROFINET-I0 and drag&drop it in the subnet of your IO controller.

2. Assign a name to the IO device. The configured name must match the name of the device. Information about setting the device name can be found in the manual of the IO device.

3. Enter a valid IP address. The IP address is normally assigned automatically by the hardware configurator. If this is not desired, you can assign the IP address manually.

4. Link up the modules of your IO device in the plugged sequence and add the addresses that should be used by the modules.

5. If needed, parametrize the modules.

6. Save, compile and transfer your project.
9.9 Configuration PROFINET I Device / Shared Device

**General**
- *I-Device* (Intelligent device) offers PROFINET I/O communication of a CPU with I/O periphery as "intelligent device" to a higher-lever CPU. Here the communication happens by means of an I/O area, which was defined in the I-Device, before.
- Thus the higher-lever CPU can communicate with the I/O area VIPA specific settings are necessary in the I-Device.
- In addition an I/O area for the communication is to be defined in the I-Device and the hardware configuration is to be imported as GSD file in the higher-lever VIPA CPU.
- With *Shared-Device* different IO controllers can independently access one IO device by means of Shared-Devices. Here during configuration of an IO device the corresponding I/O component can be assigned to a specified controller. For example, standard CPU and fail-safe CPU use the same peripheral system.

**VIPA specific setting for I-Devices**
After you have defined the I/O area for data transfer of the I-Device the following VIPA specific functions are to be activated in the properties of the corresponding I-Device:
- *I-Device ➔ I-Device mode*: ‘Parameter assignment for the PN interface and its ports on the higher-lever IO controller’
- *General ➔ Interface: [Properties]*: ‘Use different method to obtain IP address’

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>IO Device</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>...</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Modules</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
<th>Order number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IM ...</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>PN-IO</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Port 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Port 2</td>
<td></td>
</tr>
</tbody>
</table>

**Properties PN-IO**
- General
- ... Interface
- Properties

**Properties Ethernet Interface PN-IO**
- General
- Use different method to obtain...
Create an I-Device GSD file and install it at your hardware catalog with ‘Options ➔ Create GSD file for I-Device’. Open the hardware configuration of your higher-lever VIPA CPU and connect your I-Device from ‘Preconfigured Stations’.

**IO controller which supports I- and Shared-Devices**

The PROFINET CPU from VIPA can not be configured as I-Device but it supports I- and Shared-Devices. For this to configure the PROFINET CPU from VIPA you have to use the Siemens CPU 315-2 PN/DP (6ES7 315-2EH14-0AB0) from the hardware catalog. For this the Siemens SIMATIC Manager V 5.5, SP2 and up is to be used.

**Setting for Shared-Devices**

Besides the configuration, by means of the Siemens CPU 315-2 PN/DP (6ES7 315-2EH14-0AB0), no further VIPA specific adjustments are required for Shared-Devices.

### 9.10 Topology - Configuration

**Overview**

By configuring the topology you specify for the PROFINET IO controller the physical connections between the stations in your PROFINET IO system. These "neighbourhood relations" are used among others at "Device replacement without exchangeable medium". Here by comparison of target and current topology, the IO device without a name is detected and automatically integrated to the user data traffic. By configuring the topology you have the following options:

- You can evaluate topological errors in your application program
- You have greater flexibility in planning and expansion of a plant

**Support Topology editor is limited**

*Please consider that the support for the topology editor of the Siemens SIMATIC Manager is limited. Here you have only the possibility to configure the target topology offline. An online matching is currently not possible. An interconnection of the ports is also possible by means of the port properties!*

**Interconnection by means of the Port properties**

1. Click in the hardware configurator at the according PROFINET port and open the properties dialog via ‘Context menu ➔ Object properties’ and select the register ‘Topology’
   - The properties dialog to interconnect the ports is opened.
2. Here you have the following parameters:

- **Port interconnection**
  - Local port: Name of the local port
  - Medium: Specifying the line type (copper, fibre optic cable). Currently, this parameter is not evaluated.
  - Cable name: Specifying a cable name

- **Partners**
  - Partner port: Name of the port to which the selected port is interconnected.
  - Alternating partner ports: By specifying at ‘Partner port’ "Any partner", you can configure alternating partner ports for the I/O devices. Currently, this parameter is not evaluated.

- **Cable data**
  - Cable length: Depending on the port medium you can set in the select list the cable length, if the medium between two stations does not change. Here the signal delay time is automatically calculated. Currently, this parameter is not evaluated.
  - Signal delay time: If the medium between two stations changes, a signal delay time can be defined here. Currently, this parameter is not evaluated.

3. Close the properties dialog with [OK] again.

9.11 Device replacement without exchangeable medium/PG

> Please consider that for this function the Siemens CPU 315-2 PN/DP (6ES7 315-2EH14-0AB0, V3.2) is to be used of the hardware catalog. For this the Siemens SIMATIC Manager V 5.5, SP2 and up is to be used.

**Overview**

IO devices, which support the PROFINET function *Device replacement without exchangeable medium/PG* get their device name from the controller with the exchange. These can be replaced without installing an "exchangeable medium" (memory card) with the stored device name respectively without assigning a device name by a PG. To assign the device name the IO controller uses the configured **Topology** and the "neighbourhood relationship", which is determined by the IO devices.

Thus the *Device replacement without exchangeable medium/PG* is possible, the following requirements must be met:

- The **Topology** of your PROFINET IO system with the corresponding IO devices must be configured.
- The IO controller and the respective adjacent to the unit to be replaced IO device must support the functionality *Device replacement without exchangeable medium/PG*.
- In the IO controller in the ‘Properties’ the option **Support device replacement without exchangeable medium** must be enabled.
- The replaced device must be reset to delivery state, before.
**Configuring the function**

The configuration of the function *Device replacement without exchangeable medium/PG* in your PROFINET IO system happens with the following approach:

1. Double-click at the PROFINET interface of the IO controller of the CPU.
   - The properties dialog of this PROFINET interface is opened
2. Enable in the register ‘General’ the option ‘Support device replacement without exchangeable medium’.
3. Apply the settings with [OK].
4. Safe and translate the hardware configuration.
6. Transfer your project to the CPU.

**9.11.1 Replace device**

**Prepare the replace device**

For the replacement the "replace device" must be in "delivery state".
If you have not received a new "replace device" from VIPA, you have to prepare this with the following approach:

1. For this connect your "replace device" local at your PG.
2. Start the Siemens SIMATIC Manager and execute ‘PLC Edit Ethernet node’
3. Click at ‘Nodes accessible online’ at [Browse].
4. Select the according IO device, which you identify as your "replace device".
5. Click at ‘Reset to factory settings’ at [Reset].
   - Your IO device is now reset and has then "delivery state".

**Replace device**

For the replacement the "replace device" must be in "delivery state".

1. Disconnect if not already done your device to be exchanged from power.
2. Replace this by your "replace device".
3. Connect the "replaced device" to power and turn it ON.
   - Here by comparison of target and current topology, the "replaced device" is automatically detected by the IO controller and automatically integrated to the user data traffic.

**9.12 Commissioning and start-up behaviour**

**Start-up on delivery**

In the delivery state the CPU is overall reset. The PROFINET part is deactivated and its LEDs are off after PowerON.
Online with bus parameters without project

- For the communication between IO controller and IO device the ways for the communication are to be defined before. For the clear specification of the communication ways, these are established during the start-up by the IO controller, based on the project data. Here the configuration takes place by a hardware configuration.
- As soon as the project data were transmitted, the IO controller switches to system start-up.
- In this state the IO controller may be accessed and its CPU may be configured via Ethernet by the IO controller by means of the IP address.

IO device configuration

- The PROFINET IO controller is configured by a hardware configuration. After the transmission of the project into the IO controller with connected IO devices, the IO controller has the whole information for the addressing of and the data exchange with the IO devices.
- During the system start-up of the IO controller the IO devices are supplied with their configured IP address by means of the DCP protocol. After PowerON due to the project data the system start-up of the IO controller is initialized and it runs off independently.
- During the system start-up the IO controller establishes a clear communication relation (CR) and an application relation (AR) to an IO-Device. Here the cyclic IO data, the acyclic R/W services and the expected modules/sub modules are specified.
- If the IO controller has received valid project engineering data, a system start-up with the IO devices is initialized and this is indicated by flashing BF LED. The BF LED is on with configured PROFINET IO device and bus cable is missing.
- If at least one IO device is not in cyclic data exchange during start-up, the BF LED blinks.
- If all IO devices are in cyclic data exchange, the BF LED gets off. This state does not depend on the state of the operating mode switch of the CPU. After a successful system start-up the system is ready for communication.

CPU state influences the IO process data

After PowerON respectively a receipt of a new hardware configuration the configuration data are automatically transferred to the IO controller. Dependent on the CPU state the following behaviour is shown by the IO controller:

- Behaviour at CPU STOP
  - In the STOP state of the CPU an output telegram is further cyclically sent but this is designated as "not valid" and the output data are set to 0.
  - The IO controller further receives the input data of the IO devices and transfers them cyclically to the input area of the CPU.

- Behaviour at CPU RUN
  - The IO controller cyclically reads the output data from the CPU and transfers these as telegram to the connected IO devices.
  - The IO controller receives the input data of the IO devices and transfers them cyclically to the input area of the CPU.
9.13 PROFINET diagnostics

9.13.1 Overview

There are the following possibilities to get diagnostics information from your system:

- Diagnostics with the configuration and engineering tool
- Diagnostics during runtime in the user program (OB 1, SFB 52)
- Diagnostics via OB start information
- Diagnostics via status LEDs

9.13.2 Diagnostics with the configuration and engineering tool

If you are connected from your configuration respectively engineering tool via Ethernet with the PROFINET IO controller, online diagnostics information may be accessed. E.g. with 'Station ➤ Open online' you get information about the state of your system. Here missing respectively faulty components are shown by symbols. In the following figure e.g. there is shown that the configured device 3 is missing and device 4 reports an error.

9.13.3 Diagnostics during runtime in the user program

With SFB 52 RDREC (read record) you can access diagnostics data from your user program e.g. in OB1. The SFB 52 RDREC operates asynchronously, that is, processing covers multiple SFB calls.

More information about the usage of the SFB 52 may be found in the online help of your programming tool or in the manual "SPEED7 Operation list" from VIPA.
For the cyclic access to the diagnostics data of the system SLIO module 050-1BA00 the following example may be used in the OB 1:

```
AN M10.3 'If the reading terminated (BUSY=0) and
AN M10.1 'there is no job triggered (REQ=0) then
S M10.1 'start transfer of record (REQ:=1)
L W#16#4000 'Number of record set (0x4000)
T MW12
CALL SFB 52, DB52 'Call SFB 52 with Instance DB
  REQ :=M10.1     'Trigger flag
  ID :=DW#16#0018 'Smaller addr. of mixed module
  INDEX :=MW12
  MLEN :=14       'Length record set 0x4000
                   'with 1 entry
  VALID :=M10.2   'Validity of the record set
  BUSY :=M10.3    'Flag job just running
  ERROR :=M10.4   'Error bit during read access
  STATUS :=MD14   'Error codes
  LEN :=MW16      'Length of the read record set
  RECORD :=P#M 100.0 Byte 40
                   'Target (MB100, 40byte)
U M10.1
R M10.1           'Reset REQ
```

**Diagnostics data**

The system SLIO module 050-1BA00 serves for 20 byte diagnostics data. The diagnostics data of the system SLIO module 050-1BA00 have the following structure:

<table>
<thead>
<tr>
<th>Name</th>
<th>Bytes</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERR_A</td>
<td>1</td>
<td>Diagnostics</td>
<td>00h</td>
</tr>
<tr>
<td>MODTYP</td>
<td>1</td>
<td>Module information</td>
<td>18h</td>
</tr>
<tr>
<td>ERR_C</td>
<td>1</td>
<td>reserved</td>
<td>00h</td>
</tr>
<tr>
<td>ERR_D</td>
<td>1</td>
<td>Diagnostics</td>
<td>00h</td>
</tr>
<tr>
<td>CHTYP</td>
<td>1</td>
<td>Channel type</td>
<td>76h</td>
</tr>
<tr>
<td>NUMBIT</td>
<td>1</td>
<td>Number diagnostics bits per channel</td>
<td>08h</td>
</tr>
<tr>
<td>NUMCH</td>
<td>1</td>
<td>Number channels of the module</td>
<td>01h</td>
</tr>
<tr>
<td>CHERR</td>
<td>1</td>
<td>Channel error</td>
<td>00h</td>
</tr>
<tr>
<td>CH0ERR</td>
<td>1</td>
<td>Channel-specific error</td>
<td>00h</td>
</tr>
<tr>
<td>CH1ERR…CH7ERR</td>
<td>7</td>
<td>reserved</td>
<td>00h</td>
</tr>
<tr>
<td>DIAG_US</td>
<td>4</td>
<td>µs ticker</td>
<td>00h</td>
</tr>
</tbody>
</table>

More information about the diagnostics data may be found in the system SLIO manual HB300_FM_050-1BA00.
9.13.4 Diagnostics via OB start information

- On an error the faulty system generates a diagnostics message for the CPU. Then the CPU calls the according diagnostics OB. Here the CPU operating system transfers start information to the local data of the OB.
- By evaluating the start information of the according OB you can get information about cause and location of the error.
- During runtime you can access the start information with the system function SFC 6 RD_SINFO.
- Please consider that you can even read the start information in the OB himself, because the data are temporary data.
- Depending on the type of error, the following OBs are called in a diagnostics event:
  - OB 82 on an error of an module at the IO device (Diagnostics interrupt)
  - OB 83 on inserting respectively removing a module on a IO device
  - OB 86 on failure respectively return of a IO device

More information about the OBs and their start information may be found in the online help of your programming tool and in the manual "SPEED7 operation list" from VIPA.

9.13.5 Diagnostics via status LEDs

### LEDs PROFINET IO controller X8

<table>
<thead>
<tr>
<th>MT (Maintenance)</th>
<th>BF (Bus error)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>yellow</td>
<td>red</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>●</td>
<td>Bus error, no connection to subnet/switch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>wrong transfer rate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Full-duplex-transmission is not activated</td>
</tr>
<tr>
<td>X</td>
<td>BB</td>
<td>Failure of a connected IO device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At least one IO device is not accessible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Faulty configuration</td>
</tr>
<tr>
<td>●</td>
<td>X</td>
<td>Maintenance event is pending.</td>
</tr>
<tr>
<td>BB *</td>
<td>BB *</td>
<td>The alternate blinking with 4Hz indicates that a firmware update of the PROFINET IO controller is executed.</td>
</tr>
<tr>
<td>●</td>
<td>●</td>
<td>Firmware update of the PROFINET IO controller is finished without error.</td>
</tr>
</tbody>
</table>
As long as the PROFINET IO controller is not yet configured, for identification you may cause the LED to blink by means of the "Network search of your configuration tool.

<table>
<thead>
<tr>
<th>MT (Maintenance)</th>
<th>BF (Bus error)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BB</td>
<td>X</td>
<td>As long as the PROFINET IO controller is not yet configured, for identification you may cause the LED to blink by means of the &quot;Network search of your configuration tool.</td>
</tr>
</tbody>
</table>

LEDs L/A, S

The green L/A-LED (Link/Activity) indicates the physical connection of the PROFINET IO controller to Ethernet. Irregular flashing of the L/A-LED indicates communication of the PROFINET IO controller via Ethernet.

If the green S-LED (Speed) is on, the PROFINET IO controller has a communication speed of 100MBit/s otherwise with 10MBit/s.